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WARNING: In order to allow this equipment to operate in proximity to industrial, scientific, and Medical (ISM) equipment, the external radiation from 
ISM equipment may have to be limited or special migration measures taken.

FCC Information

 

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void 
the user’s authority to operate this equipment. 

 

Class B Declaration of Conformity

 

This equipment has been tested and found to comply with the limits for a class B digital device, pursuant to Part 15 of the FCC rules. These limits are designed 
to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy 
and if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. 

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with non-approved equipment or unshielded 
cables is likely to result in interference to radio and TV reception. The user is cautioned that changes and modifications made to the equipment without the 
approval of manufacturer could void the user’s authority to operate this equipment.
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das Inverkehrbringen dieses Geraetes angezeigt und die Berechtigung zur Ueberpruefung der Serie auf Einhaltung der Bestimmungen eingeraumt.
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RFI Compliance Notice

 

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal 
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user 
who is responsible for compliance of his particular installation.



 

Dieses Geraet wurde einzeln sowohl als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funk-entstoerbestimmungen 
geprueft. Es ist jedoch moeglich, dass die Funk-enstoerbestimmungen unter unguenstigen Umstaenden bei anderen Geraetekombinationen nicht eingehalten 
werden. Fuer die Einhaltung der Funk-entstoerbestimmungen seigner gesamten Anlage, in der dieses Geraet betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.

Einhaltung mit betreffenden Bestimmungen kommt darauf an, dass geschirmte Ausfuhrungen gebraucht werden. Fuer die beschaffung richtiger Ausfuhrungen ist 
der Betreiber verantwortlich.

 

Software License Agreement

 

Before using the Software, please carefully read the following terms and conditions. BY USING THIS SOFTWARE, YOU SIGNIFY THAT YOU HAVE 
ACCEPTED THE TERMS OF THIS AGREEMENT.  If you cannot or do not accept these terms, you may return the entire package within ten (10) days to 
the Distributor or Dealer from which you obtained them for a full refund.

Electronics for Imaging, Inc. grants to you a non-exclusive, non-transferable license to use the software and accompanying documentation (“Software”) included 
with the Fiery X2 you have purchased, including without limitation the PostScript

 

®

 

 software provided by Adobe Systems Incorporated.

You may:

a. use the Software solely for your own customary business purposes and solely with Fiery X2;

b. use the digitally-encoded machine-readable outline and bitmap programs (“Font Programs”) provided with Fiery X2 in a special encrypted format (“Coded Font 
Programs”) to reproduce and display designs, styles, weights, and versions of letters, numerals, characters and symbols (“Typefaces”) solely for your own customary 
business purposes on the display window of the Fiery X2 or monitor used with Fiery X2;

c. use the trademarks used by Electronics for Imaging to identify the Coded Font Programs and Typefaces reproduced therefrom (“Trademarks”); and

d. assign your rights under this Agreement to a transferee of all of your right, title and interest in and to Fiery X2 provided the transferee agrees to be bound by all 
of the terms and conditions of this Agreement.

You may not:

a. make use of the Software, directly or indirectly, to print bitmap images with print resolutions of 600 dots per inch or greater, or to generate fonts or typefaces 
for use other than with Fiery X2;

b. make or have made, or permit to be made, any copies of the Software, Coded Font Programs, accompanying documentation or portions thereof, except as 
necessary for use with the Fiery X2 unit purchased by you; provided, however, that under no circumstances may you make or have made, or permit to be made, 
any copies of that certain portion of the Software which has been included on the Fiery X2 hard disk drive. You may not copy the documentation; 

c. attempt to alter, disassemble, decrypt or reverse engineer the Software, Coded Font Programs or accompanying documentation.

d. rent or lease the Software.

 

Proprietary Rights

 

You acknowledge that the Software, Coded Font Programs, Typefaces, Trademarks and accompanying documentation are proprietary to Electronics for Imaging 
and its suppliers and that title and other intellectual property rights therein remain with Electronics for Imaging and its suppliers. Except as stated above, this 
Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), or any other rights, franchises or 
licenses in respect of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation. You may not adapt or use any trademark or 
trade name which is likely to be similar to or confusing with that of Electronics for Imaging or any of its suppliers or take any other action which impairs or reduces 
the trademark rights of Electronics for Imaging or its suppliers. The trademarks may only be used to identify printed output produced by the Coded Font Programs. 
At the reasonable request of Electronics for Imaging, you must supply samples of any Typeface identified with a trademark.

 

Confidentiality

 

You agree to hold the Software and Coded Font Programs in confidence, disclosing the Software and Coded Font Programs only to authorized users having a need 
to use the Software and Coded Font Programs as permitted by this Agreement and to take all reasonable precautions to prevent disclosure to other parties.

 

Remedies

 

Unauthorized use, copying or disclosure of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation will result in automatic 
termination of this license and will make available to Electronics for Imaging other legal remedies.



 

Limited Warranty And Disclaimer

 

Electronics for Imaging warrants that, for a period of ninety (90) days from the date of delivery to you, the Software under normal use will perform without 
significant errors that make it unusable. Electronics for Imaging’s entire liability and your exclusive remedy under this warranty (which is subject to you returning 
Fiery X2 to Electronics for Imaging or an authorized dealer) will be, at Electronics for Imaging’s option, to use reasonable commercial efforts to attempt to correct 
or work around errors, to replace the Software with functionally equivalent software, or to refund the purchase price and terminate this Agreement. Some states 
do not allow limitations on duration of implied warranty, so the above limitation may not apply to you.

Except for the above express limited warranty, Electronics for Imaging makes and you receive no warranties or conditions on the Products, express, implied, or 
statutory, and Electronics for Imaging specifically disclaims any implied warranty or condition of merchantability or fitness for a particular purpose.

For warranty service, please contact your authorized service/support center.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, ELECTRONICS FOR IMAGING MAKES AND YOU RECEIVE NO WARRANTIES 
OR CONDITIONS ON THE SOFTWARE OR CODED FONT PROGRAMS, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION 
OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND ELECTRONICS FOR IMAGING SPECIFICALLY DISCLAIMS ANY IMPLIED 
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Electronics for Imaging does not warrant that 
the operation of the software will be uninterrupted or error free or that the Software will meet your specific requirements.

 

Limitation Of Liability

 

IN NO EVENT WILL ELECTRONICS FOR IMAGING OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES, INCLUDING LOSS OF DATA, LOST 
PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES ARISING FROM THE USE OF 
THE SOFTWARE, CODED FONT PROGRAMS OR ACCOMPANYING DOCUMENTATION, HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY. THIS LIMITATION WILL APPLY EVEN IF ELECTRONICS FOR IMAGING OR ANY AUTHORIZED DEALER HAS BEEN ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE UNIT REFLECTS THIS ALLOCATION OF RISK. 
BECAUSE SOME STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR 
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

 

Export Controls

 

You agree that you will not export or re-export the Software or Coded Font Programs in any form without the appropriate United States and foreign government 
licenses. Your failure to comply with this provision is a material breach of this Agreement.

 

Government Use

 

Use, duplication or disclosure of the Software by the United States Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-7013 or in subparagraphs (c) (1) and (2) of the Commercial Computer Software—Restricted 
Right Clause at 48 CFR 52.227-19, as applicable.

 

Third Party Beneficiary

 

You are hereby notified that Adobe Systems Incorporated, a California corporation located at 345 Park Avenue, San Jose, CA  95110-2704 (“Adobe”) is a third-
party beneficiary to this Agreement to the extent that this Agreement contains provisions which relate to your use of the Fonts, the Coded Font Programs, the 
Typefaces and the Trademarks licensed hereby.  Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to Electronics 
for Imaging.

 

General

 

This Agreement will be governed by the laws of the State of California.

This Agreement is the entire agreement held between us and supersedes any other communications or advertising with respect to the Software, Coded Font 
Programs and accompanying documentation.

If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions concerning this Agreement, please write to Electronics for Imaging, Inc., Attn: Licensing Dept. or see Electronics for Imaging’s web site 
at www.efi.com.

Electronics for Imaging, Inc.
2855 Campus Drive
San Mateo, CA 94403
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xiii About the documentation

 

The Fiery X2 Color Server enables you to use your color copier as a networked printer. 
You can use the Fiery X2 to print final documents or to proof jobs you will later print 
on an offset press. You send a print job to the Fiery X2 as you would to any other 
printer—you select it from the Printers dialog box on Windows computers, or in the 
Chooser on Mac OS computers—and then print from within any application.

Users with the necessary access privileges can monitor and manage jobs sent to the 
Fiery X2 and perform color calibration of the color server. Additionally, with Fiery X2 
user software, you can also download files and fonts to the Fiery X2 and scan images 
from the copier into Adobe Photoshop.

 

About the documentation

 

This manual is part of a set of Fiery X2 documentation that includes the following 
manuals for users and system administrators:

• The 

 

Administrator Guide

 

 explains basic configuration and administration of the 
Fiery X2 for the supported platforms and network environments. It also includes 
guidelines for setting up UNIX, Windows NT, and Novell

 

 

 

NetWare servers to 
provide Adobe

 

 

 

PostScript printing services to clients.

•

 

Getting Started 

 

describes how to install software to enable users to print to the 
Fiery X2. Specifically, it describes installation of PostScript

 

™

 

 printer drivers, printer 
description files, and other user software provided on the User Software CD. It also 
explains how to connect each user to the network.

• The 

 

User Guide

 

 describes the printing features of the Fiery X2 for users who send 
jobs via remote workstations on the network or via a direct parallel port connection. 
It also explains how to use the Fiery WebTools and Fiery X2 client utilities to 
manage jobs and maintain color quality, and provides troubleshooting information 
for problems that may arise.

•

 

Release Notes

 

 provide last-minute product information and workarounds for some of 
the problems you may encounter.

Preface



 

xiv Preface

 

About this manual

 

This manual covers the following topics:

• Using the Fiery X2 Control Panel

• Printing from Windows computers

• Printing from Mac OS computers

• Printing from UNIX workstations

• Scanning images from the copier using Photoshop and the Fiery Scan plug-in

• Downloading files and fonts using Fiery Downloader

 

™

 

• Tracking and managing jobs and accessing information using Fiery WebTools

 

™

 

 and 
Fiery client utilities

• Calibrating the Fiery X2

• Creating custom simulation and calibration targets

• Specifying and overriding job settings, a list of the printer fonts installed on the 
Fiery X2, and troubleshooting information

 

Terminology and conventions

 

The Fiery X2 supports Empress (5750), Regal (5790), and Regal II (5799) digital 
copier printers. The term “copier” is used to refer to all supported copiers.

Specific terms are explained as they are introduced. However, the following general 
terms are used throughout:

•

 

PostScript (PS)

 

—A computer language designed as a page description language. The 
Fiery X2 uses this language for imaging the page and for communication with 
applications and with the print engine.

•

 

Job

 

—A file consisting of PostScript commands and comments that describe the 
graphics, sampled images, and text that should appear on each page of a document, 
and the printer options that should be used in printing, such as media or color 
rendering style.

•

 

Spool

 

—Write to a disk. Usually used here to refer to a PostScript print job being 
saved to the Fiery X2 hard disk in preparation for processing and printing.



 

xv How the Fiery X2 works

 

•

 

RIP

 

—Acronym for raster image processing, which changes text and graphics 
commands into descriptions of each mark on a page. In common use as a noun, a 
“raster image processor” (RIP) is the computer processor that performs this function.

•

 

Print

 

—The process of rendering, or imaging, a page or a job on a printer.

These concepts can explain how the Fiery X2 Color Server and the copier work 
together as a powerful printing system. The Fiery X2 PostScript RIP changes text 
and graphics commands in PostScript into color specifications for each dot of toner 
deposited on a page by the copier.

 

How the Fiery X2 works

 

The Fiery X2 receives files from computers on the network, processes (RIPs) those 
files, and then sends them to the copier’s print engine for printing. Even with the 
Fiery X2 installed, you can still use the copier to make copies. 

When printing from an application, your Windows or Mac OS computer 
communicates with the Fiery X2 by means of a PostScript printer driver and a 
PostScript printer description file (PPD). 

 

About PostScript printer drivers and PPDs

 

A PostScript printer driver is an application that manages printing communication 
between your application software and the printer. It interprets the instructions 
generated by the application software, merges those instructions with printer-specific 
PPD options you specify (see below), and translates all that information into 
PostScript, a language the printer understands. In other words, the printer driver writes 
a PostScript file based on your original file and the options you set from the Print 
dialog box.

A PPD file contains information about a particular device’s features and capabilities 
(for example, what paper sizes and media types are supported). The PostScript printer 
driver reads the information in the PPD file and presents that information to you in 
the form of options you can choose from the Print dialog box. The PPD for the 
Fiery X2 includes information about the features of both the copier and the Fiery X2 
Color Server. 

For information on the PPD options for your Fiery X2, see Appendix A, “Print 
Options.”
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Supported paper sizes

 

The Fiery X2 supports printing at 400 dpi (dots per inch) on the following paper sizes:

• Postcard (4" 

 

x

 

 6")

• 8" 

 

x

 

 10", 8" 

 

x

 

 10"-R

• Letter,

 

 

 

Letter-R (8.5" 

 

x

 

 11")

• Legal 13 (8.5" 

 

x

 

 13")

• Legal (8.5" 

 

x

 

 14")

• 9" 

 

x 

 

11", 9" 

 

x 

 

11"-R

• 9" 

 

x 

 

12"

• Tabloid (11" 

 

x

 

 17")

• 12" 

 

x

 

 18"

• A6 (105 mm 

 

x

 

 148 mm)

• B5, B5-R (182 mm 

 

x

 

 257 mm)

• A4, A4-R (210 mm 

 

x

 

 297 mm)

• Docupac (241 mm 

 

x

 

 297 mm)

• B4 (257 mm 

 

x

 

 364 mm)

• A3 (297 mm 

 

x

 

 420 mm)

 

N

 

OTE

 

:

 

Postcard, 8" 

 

x

 

 10"-R, 9" 

 

x 

 

11", 9" 

 

x 

 

11"-R, 12" 

 

x

 

 18", A6, and B5-R paper sizes 
are supported on the 5750 color copier only; the Docupac paper size is supported on 
5790 and 5799 color copiers only.

 

Fiery X2 job environments

 

The Fiery X2 supports several levels of control of printing, job management, and 
setup, and offers you the flexibility to choose the configuration that corresponds to the 
requirements of your site. If desired, the administrator can implement various controls 
that limit user access to certain Fiery X2 functions, including Fiery X2 configuration 
(Setup), calibration, job overrides, and font management.



 

xvii Fiery X2 job environments

 

The spectrum of control that an administrator can implement is described fully in the 

 

Administrator Guide

 

.

 

Permissions

 

Support for various types of job environments is achieved by a combination of 
Fiery X2 Setup options. By default, anyone can access Setup, but the administrator can 
limit access to Setup by specifying an Administrator password for the Fiery X2 (see the 

 

Administrator Guide

 

).

Also by default, anyone can log in to Fiery WebSpooler or Fiery Spooler and control 
job flow, but an administrator can restrict access to these functions by specifying an 
Operator password.

The three security levels from greatest to least control are:

•

 

Administrator

 

—confers control of Setup and is the highest level of control. The 
person who has access to Setup can control the printing and job management 
environment by choosing which print connections are enabled, and by electing to 
set passwords. The Administrator can also set a common web link for all users who 
log in to the Fiery X2 using their web browser. 

•

 

Operator

 

—includes control of print jobs that arrive at the server and the ability to 
perform calibration.

•

 

Guest

 

—allows users to view the status of active jobs and the list of stored jobs. They 
cannot make changes to jobs. A password is not needed to log in as Guest and view 
jobs from the Fiery WebSpooler or Fiery Spooler windows.

This manual describes the features of the Fiery WebTools and Fiery client utilities and 
all privileges, whether those privileges are available to everyone or are exclusive to only 
certain people. It also includes descriptions of administrator functions, sometimes 
referring you to other manuals for more information.



 

xviii Preface

 

Before you begin

 

Before using the Fiery X2, follow these steps:

 

1. Confirm that the system administrator has completed Setup as described in the 

 

Administrator Guide

 

.

2. Find out what printer defaults the administrator specified in Setup. 

 

These default settings can affect the results of your print jobs. Check with your 
administrator or operator for information on these default settings.

 

3. Confirm that the user software is installed correctly on your workstation, as described 
in 

 

Getting Started

 

.

4. Consult Appendix A for information on print options that affect color output.

5. Find out how your workstation is configured for printing on the network.

 

You may have access to both the Print queue and the Hold queue. If you send a job to 
the Print queue, the job spools to the Fiery X2 and proceeds to RIP and print 
according to your job settings—unless someone intervenes with Fiery WebSpooler or 
Fiery Spooler. 

If you send a job to the Hold queue, the job spools to the Fiery X2 and is held until 
someone intervenes with Fiery WebSpooler or Fiery Spooler sends them to their next 
stage of processing.

You may also have access to the Direct connection, which sends jobs straight to the 
server without spooling and is used to download printer fonts to the Fiery X2 disk.

 

6. Find out whether the Fiery X2 is set up to use Fiery WebTools and what your access 
privileges are.

 

The administrator may or may not have enabled access to the server via the Internet 
(or an intranet). If access is enabled, a password may be required to perform job 
management with Fiery WebSpooler or Fiery Spooler. 
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1-1 Introduction to the Control Panel

 

You can use the Fiery X2 Control Panel to view status information, print special pages, 
and set up printing. 

 

Introduction to the Control Panel

 

The Control Panel, shown below on the front of the Fiery X2, comprises the following 
parts:

Chapter 1:
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Activity light 

Menu button

Display window

Up/down button

Line selection buttons
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Activity light

 

The activity light indicates current Fiery X2 activity. If the light is:

 

Buttons

 

Solid red An error has occurred causing the Fiery X2 to be disabled.

Flashing red There is an error causing printing to be disabled, but the 
Fiery X2 is capable of processing.

Solid green The Fiery X2 is idle.

Flashing green The Fiery X2 is processing or printing a job, or 
communicating with a remote computer.

No light The Fiery X2 is off or starting up.

Line selection 
buttons

There are four line selection buttons on the right side of the 
Control Panel. Use these buttons to select the command 
displayed on the corresponding line of the display window. 
When a button is active, a special character (

 

>

 

) appears in the 
display window next to the button.

Up/down 
button

Use this button to scroll to different screens in multi-screen 
lists, to select Setup options from a list of available options, 
and to scroll alphanumeric characters. 

Menu button Press this button to view other screens. Under normal 
operation, the Control Panel displays the Info, RIP, or Print 
Status screen with information about the status of the 
Fiery X2. If you press the Menu button, the Functions menu 
is displayed and you can perform additional operations (see 
page 1-5). If a job is processing or printing, press the Menu 
button to cycle among the active screens.
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Display window
The display window provides information about the status of the Fiery X2, displays 
menu information, and enables you to view and edit information in the Setup menus. 

The last line of the display window displays text that tells you what screen you are 
looking at and highlights one of the icons to indicate what the Fiery X2 is doing. Only 
the icons for the screens that are currently available appear. The menu button cycles 
among the active screens as follows:

Alert Status If there is a problem with processing a job or printing functions, an error message 
appears on the Control Panel. For information on error messages, see 
Appendix C, “Troubleshooting.” 

Print Status When the Fiery X2 is printing or scanning a job, the Print Status screen appears. 
This screen displays the following:

Cancel Job—Press the top line selection button to cancel the job currently 
printing. 

User name—The name of the user who sent the job currently processing.

Pages/Total—The number of copies of the current job printed and the total 
number of copies of the job requested.

RIP Status When the Fiery X2 is processing a job, the RIP Status screen appears. This screen 
displays the following:

Cancel Job—Press the top line selection button to cancel the job currently 
processing. The Fiery X2 cancels the job before printing begins.

Document name—The name of the document currently processing.

User name—The name of the user who sent the job currently processing.

Kilobytes—The size (in kilobytes) of the job processed so far. 
NOTE: This number is always displayed in kilobytes, even if the amount goes over 
1000KB; for example, 10MB is displayed as 10000KB.
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Info Status When the Fiery X2 is not processing or printing a job, it displays information 
about the current server and software. It displays the following information:

Server Name—The Fiery X2 name.

Status—The current status of the Fiery X2. The Fiery X2 status can be: Idle, 
Initializing, Busy, Processing, or Printing.

Megabytes—The space (in megabytes) available on the Fiery X2 hard disk, for 
example, 756MB.

Version—The system software version running on the Fiery X2.

Functions You can press the Menu button to display the Functions menu. Use the up/down 
button to scroll through the list. Press the line selection button to the right of a 
command to select that command. See page 1-5 for more information.

Network The network icon appears at the bottom left of any of the other screens when a 
job is being sent to the Fiery X2, either over the network or through the parallel 
port. The network icon also appears, together with a flashing green activity light, 
when a remote utility is running.
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Functions menu
Print Pages Print special pages from the Fiery X2. You can print the following pages from the 

submenu that appears:

Test Page—A Test Page enables you to confirm that the Fiery X2 is properly 
connected to the copier, and provides color and grayscale samples to troubleshoot 
problems with the copier or the Fiery X2. The following settings are among those 
listed on the Test Page: Server Name, Printer Model, color settings, calibration 
information, date and time the Test Page was printed.

Configuration—Prints the Configuration page, which gives the current server and 
device configuration. This page lists general information about the hardware and 
software configuration of the Fiery X2, the current options for all Setup settings, 
information about the current calibration, and the Ethernet and Token Ring 
addresses of the Fiery X2. 

Job Log—Prints a log of the last 55 jobs. For information on the fields in the Job 
Log and on printing it in other forms, see Chapter 7, "Tracking and Managing 
Print Jobs."

Control Panel Map—Prints the Control Panel Map, which is an overview of the 
screens you can access from the Control Panel. For information about using these 
screens to set up the Fiery X2, see the Administrator Guide.

Color Charts—Prints samples of the RGB, CMY, and PANTONE colors available 
from the Fiery X2. 

Font List—Prints a list of all fonts currently on the Fiery X2 hard disk.

Suspend Printing Suspend communication between the Fiery X2 and the copier. You must suspend 
printing if you want to interrupt the current Fiery X2 job so that you can use the 
copier to make copies. Jobs continue to process on the Fiery X2. After you make 
the copies, select Resume Printing to continue printing jobs from the Fiery X2 and 
networked users.

NOTE: Do not select Suspend Printing while printing duplex or sort jobs.

Resume Printing Resume communication between the copier and the Fiery X2 after you have 
finished making copies. 

Run Diagnostics This function is provided for service representatives only. Contact your authorized 
service/support technician for information about running diagnostics.

Reboot Server Shut down all Fiery X2 activity in the correct manner and then restart. You should 
use this option instead of the power switch on the back of the Fiery X2.
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Starting and shutting down the Fiery X2
Generally, you can leave the Fiery X2 running all the time. This section describes how 
to shut down and restart the Fiery X2 when necessary.

Starting the Fiery X2
To start the Fiery X2, move the power switch on the back of the Fiery X2 to the On 
position. If the copier is also powered off, power it on before powering on the 
Fiery X2.

Diagnostic messages appear on the Fiery X2 Control Panel. If any diagnostics fail, 
more information and instructions appear. Contact your service representative if the 
Fiery X2 encounters problems while running the diagnostics.

When the diagnostics are finished, the following message is displayed:

For software update or setup, press any key.

If you want to change Setup option settings, press any button; if you do not press a 
button, the Fiery X2 continues starting up and displays the message Idle when it is 
ready to receive data.

NOTE: If an Administrator password has been set, you are required to enter it to access 
Setup. 

Power switch



11-7 Starting and shutting down the Fiery X2

If you press a button, the following options appear. For information about the Setup 
menus and options, see the Administrator Guide.

Restarting the Fiery X2
You should use the procedure described below to restart the Fiery X2 rather than using 
the power switch on the back of the Fiery X2.

TO RESTART THE FIERY X2:

1. Make sure that the Fiery X2 is not receiving, processing, or printing a job. 

The status message on the Control Panel should read Idle.

NOTE: If a job from the Print queue is processing, it will continue processing and print 
after the Fiery X2 is restarted; if a job sent to the Direct connection is processing, it 
will not finish processing or printing.

2. Press the Menu button to display the Functions menu.

3. Use the up/down button to scroll to the last screen and choose Reboot Server.

Choose: To do this:

Exit Setup Exit the Setup menus; the Fiery X2 reboots.

Server Setup Enter the Server Setup menus. 

Network Setup Enter the Network Setup menus.

Printer Setup Enter the Printer Setup menus.

PS Setup Enter the PostScript Setup menu.

Color Setup Enter the Color Setup menu.

Job Log Setup Enter the Job Log Setup menu.

Calibration Calibrate the Fiery X2 using AutoCal. For more information, 
see “Calibrating with AutoCal from the Control Panel” on 
page 8-6 and the Administrator Guide.

Change Password Change the Administrator password.

Clear Server Clear all jobs in all server queues as well as the Job Log. 
Check with your administrator or operator before choosing 
Clear Server.
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Shutting down the Fiery X2
You may need to shut down the Fiery X2 for service. When you do so, fonts that have 
been downloaded to the hard disk drive are not deleted. Print jobs in the Hold and 
Printed queues and jobs that have been processed but not printed are not deleted and 
are available for printing when you restart the Fiery X2.

TO SHUT DOWN THE FIERY X2:

1. Make sure that the Fiery X2 is not receiving, processing, or printing a job.

Make sure that the status message on the Control Panel is Idle. If a job has just finished 
processing or printing, wait at least five seconds after the Control Panel status message 
switches to Idle before proceeding to step 2.

NOTE: If a job from the Print queue is processing, it will continue processing and print 
after the Fiery X2 is restarted; if a job to the Direct connection is processing, it will not 
finish processing or printing.

2. Power off the Fiery X2 by moving the power switch on the back to the Off position.

NOTE: After powering off the Fiery X2, make sure to also power off the copier. Leaving 
the copier powered on while the Fiery X2 is powered off can lead to excessive drain on 
the Fiery X2 motherboard battery.

Safety warnings
The Fiery X2 display window is a liquid crystal display (LCD) that is made of glass and 
can break. Do not subject it to strong shocks.

If the display window breaks and the liquid crystal material leaks out, do not inhale, 
ingest, or touch it. If the material gets on your skin or clothing, wash it off with soap 
and water immediately.

Cleaning the Fiery X2
Clean the Fiery X2 with a soft cloth moistened with isopropyl alcohol or ethyl alcohol. 
Never use water or ketone as these may permanently alter the display.
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This chapter describes how to print to the Fiery X2 from Windows 95, Windows 3.1x, 
and Windows NT 4.0.

You can print from a networked Windows computer, or from a Windows computer 
connected to the parallel port on the Fiery X2. If you plan to print files at another 
location, you should follow the procedures described in “Saving files to print at a 
remote location” on page 2-12.

Another way to print from a Windows computer is to download PostScript, 
Encapsulated PostScript (EPS), or Portable Document Format (PDF) files using Fiery 
Downloader.

NOTE: For information on setting up the Windows environment for printing with 
Windows servers connected to the Fiery X2, see the Administrator Guide. For 
information on how to connect to the Fiery X2 over the network, install printer 
drivers, and install the Fiery utilities, see Getting Started.

Printing from applications
Once you have installed the Fiery X2 printer driver and set it to the proper port as 
described in Getting Started, you can print directly from most Windows applications. 
Simply choose the Print command from within your application.

Setting options and printing from Windows 95
To print from Windows 95, use the Adobe PostScript printer driver for Windows 95. 
The driver is included with the Fiery X2 user software, and uses all features of the 
Fiery X2.

Once you have installed the Adobe PostScript printer driver and Fiery X2 PostScript 
Printer Description file (PPD), you can specify print settings. You can also change 
settings for a particular job when you print it to the Fiery X2. Before printing, make 
sure that the correct print options are set.

Chapter 2:
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To print from Windows 95 applications over a network, you must be connected to a 
print server. This can be a Novell NetWare server, an NT server, or a UNIX server. For 
information about connecting a server to the Fiery X2, see the Administrator Guide. 
Alternatively, you can print from Windows 95 without connecting to a print server via 
SMB printing. For information about setting up SMB printing, see Getting Started.

TO SET PRINT OPTIONS AND PRINT WITH THE ADOBEPS PRINTER DRIVER 
FROM WINDOWS 95:

1. Double-click the My Computer icon.

2. Double-click the Printers icon.

3. Select the icon for the Fiery X2 and choose Properties from the File menu.

4. Click the Paper tab.

5. Specify the appropriate settings for the print job.
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In the Paper size area, specify the page size for the job.

From the Paper source menu, choose the paper tray for the job. For example, you can 
specify that the job should be printed on pages from the Bypass tray. The Paper source 
selection is valid for the current job only.

NOTE: If paper loaded in the selected tray is a different size, orientation, and/or media 
type than that of the job you are sending, the Fiery X2 displays an error message and 
the job will not print. You should then load the correct paper in the selected tray or 
cancel the job.

6. To select a specific media type, click More Options.

7. From the Paper type menu, choose the type of media to use for the job and click OK.
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8. Click the Fiery Options tab.

9. Go to the Job, Color1, Color2, Color3, and Finishing tabs, and specify the appropriate 
settings for the print job.

These print options are specific to the Fiery X2. They override settings in Fiery X2 
Printer Setup; the settings can also be changed in the Override Print Settings dialog 
box with the Fiery WebSpooler or Fiery Spooler. For information about these options 
and overrides, see Appendix A, “Print Options.”

If you choose Printer’s default, the Fiery X2 prints with the default setting specified 
during Setup.

10. If you want to make the new settings the default settings, click Apply.

11. Click OK.
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12. From your application, choose Print.

13. Enter text messages in the Notes 1 and Notes 2 areas. 

Enter user and job identification information for accounting purposes, or whatever 
information is required at your site. These notes will appear in the Job Log.

14. Click OK.

NOTE: The Fiery X2 does not support printing the Cover Page from the AdobePS 
printer driver.

Saving and loading print option settings

Print option settings can be saved to a settings file on your hard disk. Saving a settings 
file enables you to easily load specifically configured settings for a particular job. 

TO SAVE PRINT OPTION SETTINGS:

1. After configuring the options from the Job, Color1, Color2, Color3, and Finishing tabs, 
click Save Settings.

2. Name the settings file and browse to a location on your hard disk where you want to 
save the file.

3. Click OK.

The settings file is saved to the location you specified.
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TO LOAD PRINT OPTION SETTINGS:

1. From the Fiery Options tab, click Load Settings.

2. Browse to the settings file.

3. Select the settings file from the list and click OK.

The options from the Job, Color1, Color2, Color3, and Finishing tabs are 
automatically configured with the saved settings.

Setting options and printing from Windows 3.1x
To print from Windows 3.1x, use the Adobe PostScript printer driver for Windows 
3.1x. The driver is included with the Fiery X2 user software, and uses all features of the 
Fiery X2.

Once you have installed the Adobe PostScript printer driver and Fiery X2 PostScript 
Printer Description file (PPD), you can specify print settings. You can also change 
settings for a particular job when you print it to the Fiery X2. Before printing, make 
sure that the correct print options are set.

TO SET PRINT OPTIONS AND PRINT WITH THE ADOBEPS PRINTER DRIVER 
FROM WINDOWS 3.1X:

1. In the Main window, double-click the Control Panel icon.

2. Double-click the Printers icon.

3. In the Printers dialog box, select the Fiery X2 in the Installed Printers box and click 
the Setup button.

4. Click the Paper tab.
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5. Specify the appropriate settings for the print job.

From the Paper Source menu, choose the paper tray for the job. For example, you can 
specify that the job should be printed on pages in the Bypass tray. The Paper Source 
selection is valid for the current job only.

In the Paper Size menu, specify the page size for the job.

NOTE: If paper loaded in the selected tray is a different size, orientation, and/or media 
type than that of the job you are sending, the Fiery X2 displays an error message and 
the job will not print. You should then load the correct paper in the selected tray or 
cancel the job.
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6. Click the Features tab.

7. Specify the appropriate settings for the job and click OK.

These print options are specific to the Fiery X2 (you may need to scroll to see all the 
pop-up menus). They override settings in Fiery X2 Printer Setup; the settings can also 
be changed in the Override Print Settings dialog box with the Fiery WebSpooler or 
Fiery Spooler. For information about these options and overrides, see Appendix A, 
“Print Options.”

If you choose Printer’s default, the Fiery X2 prints with either the default value for the 
server, or the information entered during Setup.

8. Choose Print in your application. 
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9. If necessary, enter your name in the User area. 

Once you enter your name in the User area, it appears automatically in this dialog box 
when you print subsequent jobs.

NOTE: This entry cannot be changed without deleting and reinstalling the printer.

10. Enter text messages in the Notes 1 and Notes 2 areas.

Enter user and job identification information for accounting purposes, or whatever 
information is required at your site. These notes will appear in the Job Log.

11. Click OK.

NOTE: The Fiery X2 does not support printing the Cover Page from the AdobePS 
printer driver.

Setting options and printing from Windows NT 4.0
You can print from Windows NT 4.0 using the printer driver included with 
Windows NT.

TO SET PRINT OPTIONS AND PRINT WITH THE MICROSOFT POSTSCRIPT 
PRINTER DRIVER FROM WINDOWS NT 4.0:

1. Choose Print in your application and click Properties.

2. Click the Advanced tab.
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3. Specify the appropriate settings for the print job.

In the Paper Size menu, specify the page size for the job.

From the Paper Source menu, choose the paper tray for the job. For example, you can 
specify that the job should be printed on pages in the Bypass tray. The Paper Source 
selection is valid for the current job only.

NOTE: If paper loaded in the selected tray is a different size, orientation, and/or media 
type than that of the job you are sending, the Fiery X2 displays an error message and 
the job will not print. You should then load the correct paper in the selected tray or 
cancel the job.
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4. Scroll down to Printer Features, and select the appropriate settings for the print job.

These print options are specific to the Fiery X2. They override settings in Fiery X2 
Printer Setup; the settings can also be changed in the Override Print Settings dialog 
box with the Fiery WebSpooler or Fiery Spooler. For information about these options 
and overrides, see Appendix A, “Print Options.”

If you choose Printer’s default, the Fiery X2 prints with the default setting specified 
during Setup.

5. Click OK, then click OK in the Print dialog box.

NOTE: The Fiery X2 does not support printing the Cover Page from the Windows 
NT 4.0 PostScript printer driver.

Printing to the parallel port
The Fiery X2 has a parallel port that enables you to print most files directly from a 
Windows computer if your network administrator has connected the Windows 
computer’s parallel port to the Fiery X2 parallel port.

NOTE: You cannot use Fiery Downloader through the parallel port.
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TO PRINT FILES TO THE PARALLEL PORT:

1. Make sure the parallel port is enabled on the Fiery X2.

Check with your site administrator to see whether printing to the parallel port is 
enabled. See Getting Started for information on setting up parallel port printing on 
your Windows computer.

2. Select the printer port that is connected to the Fiery X2 parallel port.

Select one of the local ports: LPT1, LPT2, or LPT3. For instructions, see your Windows 
documentation. 

3. Print from within your application.

Saving files to print at a remote location
If you do not have a Fiery X2 and are preparing files to take to a service bureau or 
other location, print the final files to the File port (as opposed to one of the local 
ports). You can also print to the File port to create a file to be downloaded using 
Fiery Downloader. For instructions, see your Windows documentation.

Using Fiery Downloader to print
Downloading files with Fiery Downloader is generally faster than printing from 
application software. You can use Fiery Downloader to print PostScript, EPS, or PDF 
files.

TO PRINT USING FIERY DOWNLOADER:

1. When you create a PostScript, EPS, or PDF file, specify the appropriate print options 
and include (embed) any necessary fonts not resident on the Fiery X2.

For a list of fonts resident on the Fiery X2, see Appendix B, “Font List.”

2. Launch Fiery Downloader and connect to the Fiery X2.

For instructions on setting up Fiery Downloader, see Getting Started.

3. Select the file(s) you want to download, and specify any necessary options.

4. Click Download.

For details, see Chapter 6, “Downloading Files and Fonts.”
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You can print to the Fiery X2 just as you would print to any other printer from any 
application software. First, select the Fiery X2 as the current printer in the Chooser, 
and then print the file from within your application.

Another way to print from a Mac OS computer is to download PostScript, 
Encapsulated PostScript (EPS), or Portable Document Format (PDF) files using Fiery 
Downloader.

Printing from applications
Before you can print to the Fiery X2 from applications, you must select the Fiery X2 in 
the Chooser. Then, using the Adobe PostScript printer driver and the correct 
PostScript Printer Description file (PPD), you can control many Fiery X2 printing 
features by specifying job settings from print dialog boxes. 

Selecting the Fiery X2 in the Chooser
Before you print a job, make sure the Fiery X2 is the currently selected printer.

TO SELECT THE FIERY X2 AS THE CURRENT PRINTER:

1. Make sure the Fiery X2 is connected to the network and turned on.

2. Choose Chooser from the Apple menu.

3. Click the AdobePS icon to select it.

4. If the network is divided into zones, select the zone in which the Fiery X2 is located.

5. Select the Fiery X2 by <Server Name>_<Device Name>_<Queue Name> from the 
“Select a PostScript Printer” list.

The names of all supported printers in the zone appear in the scroll list on the right. 
For information about setting up the Fiery X2 in the Chooser, see Getting Started.

NOTE: If your system administrator has not enabled the connection to the Print queue 
or the Direct connection, the corresponding name will not appear in this list.

Chapter 3:
Printing from 
Mac OS 
Computers



33-2 Printing from Mac OS Computers

6. Make sure that AppleTalk is set to Active, and then close the Chooser window.

The Fiery X2 remains selected as the current printer until you choose a new printer in 
the Chooser.

Setting print options and printing from Mac OS computers
In Mac OS applications, print options are set from both the Page Setup dialog box and 
the Print dialog box. For details, see Appendix A, “Print Options.” 

NOTE: Some default print options are set by the administrator during Setup. Check 
with the administrator for information on the current server default settings.

TO SET PRINT OPTIONS AND PRINT WITH THE ADOBEPS PRINTER DRIVER:

1. Open the file you want to print, and choose Page Setup from the application’s File 
menu.

The PSPrinter Page Setup dialog box appears.

2. In the Paper menu, specify the page size for the job and click OK.

3. Choose Print from the application’s File menu.

NOTE: Print dialog boxes vary across applications.

If the Print dialog box lets you choose from a pop-up menu of available printers, 
choose the Fiery X2.
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From the Paper Source menu, choose the paper tray for the job. For example, you can 
specify that the job should be printed on pages in the Bypass tray. The Paper Source 
selection is valid for the current job only.

NOTE: If paper loaded in the selected tray is a different size, orientation, and/or media 
type than that of the job you are sending, the Fiery X2 displays an error message and 
the job will not print. You should then load the correct paper in the selected tray or 
cancel the job.

4. From the General pane, choose Job Notes.

In the Notes 1 and Notes 2 areas, enter user and job identification information for 
accounting purposes, or whatever information is required at your site. These notes will 
appear in the Job Log.

5. From the Job Notes pane, choose Printer Specific Options.

6. Specify the appropriate settings for the print job.

These print options are specific to the Fiery X2 (you may need to scroll to see all the 
options). They override settings in Fiery X2 Printer Setup; the settings can also be 
changed in the Override Print Settings dialog box with the Fiery WebSpooler or 
Fiery Spooler. For information about these options and overrides, see Appendix A, 
“Print Options.”

If you choose Printer’s default, the Fiery X2 prints with the default setting specified 
during Setup.
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Some PPD options are ones that could also be set from an application (for example, 
Reverse Order printing or Collation). In these cases, use the PPD option to perform 
the function, rather than setting it from the application. The application may not set 
up the file properly for printing on the Fiery X2 and may also take longer to process.

7. If you want to make the new settings the default settings, click Save Settings.

8. Click Print.

NOTE: The Fiery X2 does not support printing the Cover Page from the AdobePS 
printer driver.

Using Fiery Downloader to print
Downloading files with Fiery Downloader is generally faster than printing from 
application software. You can use Fiery Downloader to print PostScript, EPS, or PDF 
files.

TO PRINT USING FIERY DOWNLOADER:

1. Create a PostScript, EPS, or PDF file. Specify the appropriate print options and include 
(embed) any necessary fonts that are not resident on the Fiery X2.

For a list of fonts resident on the Fiery X2, see Appendix B, “Font List.”

2. Launch Fiery Downloader and connect to the Fiery X2.

For instructions on setting up Fiery Downloader, see Getting Started.

3. Select the file(s) you want to download, and specify any necessary options.

4. Click Download.

For details, see Chapter 6, “Downloading Files and Fonts.”
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You can print to the Fiery X2 directly from UNIX. Jobs printed to the Fiery X2 are 
sent to the Print queue or Hold queue and can be manipulated from Windows and 
Mac OS computers on the network using Fiery WebSpooler or Fiery Spooler.

NOTE: If you print to the Hold queue, an operator must intervene from 
Fiery WebSpooler or Fiery Spooler for the job to print; jobs sent to the Hold queue are 
spooled to disk and held.

The queue name and Fiery X2 printer name are established by your system 
administrator. Contact your system administrator for the names of your queues.

For information about setting up printing from TCP/IP, see your UNIX system 
documentation.

Printing to the Fiery X2
You can use UNIX commands to print PostScript files and text files to the Fiery X2. In 
general, the basic print commands (lpr, lpq, lprm) can be used to send print jobs to a 
Fiery X2. See your UNIX manual pages or other documentation for information about 
UNIX commands.

NOTE: Only PostScript or text file formats can be printed from UNIX. 

TO PRINT FROM UNIX:

• On a system running SunOS 4.1.x or another BSD-based variant, use the lpr command 
to send a job to the Fiery X2 as follows:

lpr <-Pprinter> <-#copies> <filename>

For example, if the Print queue of your Fiery X2 is named print_Server, your file is 
named Sample, and you want to print two copies, type:

lpr -Pprint_Server -#2 Sample

Chapter 4:
Printing 
from UNIX 
Workstations
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• On a system running Solaris® 2.x or any System V implementation of UNIX, use the lp 
command to send a job to the Fiery X2 as follows:

lp -d <printername> {-n <-#copies>} <filename>

For example, if the Print queue of your Fiery X2 is named print_Server, your file is 
named Sample, and you want to print two copies, type:

lp -d print_Server -n 2 Sample

TO DISPLAY A LIST OF JOBS IN THE QUEUE:

• On a system running SunOS 4.1.x or another BSD-based variant, use the lpq command 
to see printer jobs in the queue as follows:

lpq <-Pprinter>

For example, if the Print queue of your Fiery X2 is named print_Server, type:

lpq -Pprint_Server

Your workstation displays the contents of the queue.

• On a system running Solaris 2 or any System V implementation of UNIX, use the lpstat 
command to see printer jobs in the queue as follows:

lpstat -o <printername>

For example, if the Print queue of your Fiery X2 is named print_Server, type:

lpstat -o print_Server

Your workstation displays the contents of the queue.
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TO REMOVE JOBS FROM THE QUEUE:

NOTE: Unless you log in as the root user, you can remove only your own jobs. 

• On a system running SunOS 4.1.x or another BSD-based variant, use the lprm command 
to remove jobs from the queue as follows.

lprm <-Pprinter> <job #…>

You can use the lpq command to check the job number.

For example, to remove job number 123 from the Print queue of your Fiery X2 named 
print_Server, type:

lprm -Pprint_Server 123

The lprm command reports the names of any files it removes.

• On a system running Solaris 2.x or any System V implementation of UNIX, use the 
cancel command to remove jobs from the queue.

cancel <printername> <job ID>

For example, to remove job number 123 from the Print queue of your Fiery X2 named 
print_Server, type:

cancel print_Server 123
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This chapter describes how to scan images from the copier using the Fiery Scan plug-in 
for Adobe Photoshop.

NOTE: The Windows and Mac OS versions of Fiery Scan are fundamentally the same; 
differences are noted in this chapter. Where a window or dialog box is illustrated, the 
Windows version comes first, followed by the Mac OS version.

Scanning from the copier
With the Fiery Scan plug-in for Photoshop, you can scan an image from the copier 
directly into Photoshop on your computer. 

The following requirements and constraints apply:

• Fiery Scan requires a network connection; it cannot be used with the parallel port. 
For information on supported networking protocols, see Getting Started.

• The Fiery Scan (TWAIN) plug-in must be installed in the Photoshop Plug-ins 
folder.

• Photoshop’s Monitor Setup should be currently using the Calibrated RGB 
(Mac OS) or Calrgb.ams (Windows) settings. See Getting Started for information on 
loading this file.

Fiery Scan color conversion settings
Fiery Scan offers two color conversion choices for scanned data:

• Calibrated RGB creates an RGB scan optimized for printing with Fiery X2 Rendering 
Styles (CRDs) or ICC profiles, as well as for viewing on the monitor.

• Match Copy creates a CMYK scan that, when printed on the Fiery X2, looks like a 
copy of the original made with the copier.

Chapter 5:
Scanning
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Using Fiery Scan
With Fiery Scan, you first create a prescan of the image; then you can select part, or all, 
of the prescan for final scanning.

TO PRESCAN A DOCUMENT:

1. Start the Photoshop application.

2. Place the original you want to scan on the copier.

3. From Photoshop’s File menu, choose either Import or Acquire.

The choice depends on which version of Photoshop you are using.

4. For Windows, choose Select TWAIN_32 Source from the submenu.
For Mac OS, choose Fiery Twain Select from the submenu.

5. Select Fiery Scan in the window that appears, and click Select (Windows) or OK 
(Mac OS).

6. From the File menu, choose either Import or Acquire.

The choice depends on which version of Photoshop you are using.

7. For Windows, choose TWAIN_32 from the submenu.
For Mac OS, choose Fiery Twain Acquire from the submenu.
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8. Select the Fiery X2 in the Chooser window and click OK (Windows) or Connect 
(Mac OS).

If the Fiery X2 does not appear in the Windows Chooser list, you must configure the 
connection to the Fiery X2. For instructions, see Getting Started.

9. Select the appropriate settings in the Fiery Scan dialog box.

Prescan size—Choose the paper size of the original from the pop-up menu. 
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Resolution—Specify a value for the resolution. Changing the resolution also changes 
the image size. The maximum resolution supported by the Fiery X2 appears in the 
dialog box.

Scan Mode—Specify the type of scan you want: Full Color, Grayscale, or Black & White.

10. Click Prescan.

The prescan image appears on the left side of the dialog box.

NOTE: After prescanning, you must complete the scan before the Fiery X2 is able to 
begin RIPping and printing any new jobs.

TO SELECT OPTIONS AND COMPLETE THE SCAN:

1. Drag the cursor to select the area of the prescan image that you want to acquire, or 
enter the area to acquire in the Selection area.

In the Selection area, you can specify:

Units—Specify the ruler units that appear around the preview image.

Width and Height—Enter the Width and Height of the area to scan; or, select an area 
of the page with the selection marquee. If you use the marquee to select the scan area, 
the dimensions appear in these text boxes. If you do not specify a scan area, the default 
is to acquire the entire scan.

To select a portion of the image using the marquee, you can move the selection 
marquee around by positioning the Hand tool inside the marquee and dragging the 
marquee to a new location. You can change the size of the frame by clicking and 
dragging one of the handles on the corners of the selection frame. If you want to 
deselect the area you have selected, double-click anywhere. 

The Fiery X2 scans at a maximum resolution that is dependent on the size of the 
selected area. When you select an area to be scanned, Fiery Scan displays the maximum 
resolution possible for that area. You can enter a dpi value which is less than the 
maximum resolution.
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2. Click Options to display the Fiery Options dialog box (Windows) or Scan Options dialog 
box (Mac OS). 

Original—Choose a resampling interpolation method. In general, you should choose 
Photograph if you are scanning a continuous tone photographic image and Offset Print 
or Copy if you are scanning a printed document. The Offset Print or Copy mode takes 
slightly more time but reduces moiré patterns in scans. 

Color Conversion—Choose a color conversion: Calibrated RGB or Match Copy. Use 
Calibrated RGB if you will print the image using a Fiery X2 Rendering Style (CRD). 
Use Match Copy to match the colors in a copy made by the copier as closely as possible, 
assuming that you are going to print the image to the same copier and you do not want 
to use a Rendering Style. Also see “Fiery Scan color conversion settings” on page 5-1. 

3. Specify the appropriate settings and click OK.

4. Click Scan in the main window to acquire the scan.

The progress bar displays how much of the image has been processed. You can click Esc 
(Windows) or Command-. (Mac OS) to cancel acquiring the scan.

When the scan is acquired, the scanned image is displayed in Photoshop.
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Fiery Downloader allows you to send PostScript, Encapsulated PostScript (EPS), and 
Portable Document Format (PDF) files directly to the Fiery X2 without using the 
application they were created in. It also enables you to manage printer fonts on the 
Fiery X2.

You can use Fiery Downloader from a remote workstation. Fiery Downloader requires 
a network connection—you cannot use Fiery Downloader with the parallel port. For 
information on supported networking protocols, see Getting Started.

NOTE: The Windows and Mac OS versions of Fiery Downloader are fundamentally the 
same; differences are noted. Single windows or dialog boxes illustrated depict the 
Windows version.

Using Fiery Downloader
You can use Fiery Downloader to:

• Print PostScript, EPS, and PDF files to the Fiery X2

• Check the status of the Fiery X2

• Manage the PostScript printer fonts stored on the Fiery X2 hard disk (this feature 
requires that the Direct connection is published on the Fiery X2)

NOTE: Fiery Downloader was designed specifically for the Fiery X2; you cannot use it 
with any other printer. You can also use standard LaserWriter downloaders, such as the 
Adobe Font Downloader, with the Fiery X2.

TO VIEW INFORMATION WITH FIERY DOWNLOADER:

1. Double-click the Fiery Downloader icon or choose Fiery Downloader from the 
Start>Programs menu.

Chapter 6:
Downloading 
Files and Fonts
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2. Select the Fiery X2 in the Chooser window and click OK (Windows) or 
Connect (Mac OS). 

The Fiery Downloader Status window appears and you see the Fiery Downloader 
Toolbar, menus, and the status bar at the bottom of the screen. 

Buttons for some menu functions appear in the Toolbar at the top of the window. 

Open Click to connect to a different Fiery X2.

Download Click to download a file or font to the Fiery X2.

Status If you are viewing the font list, click to display the 
status window for the current Fiery X2. 

Font list If you are viewing the status window, click to 
display a list of printer fonts on the Fiery X2 hard 
disk.

About Fiery 
Downloader 
(Windows only)

Click to view version information about Fiery 
Downloader.

Displays server status and user 
and document name of the job 
currently printing

Displays server status and user 
and document name of the job 
currently processing 

Dynamically displays the progress 
of the job

Displays the amount of available 
disk space
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You can click the font list button or choose Font List from the File menu to view font 
information in the window.

3. To select a different Fiery X2, choose Open from the File menu or click the Open 
button.

4. Select the Fiery X2 in the dialog box that appears, and click OK (Windows) or 
Connect (Mac OS).

5. To close the status window, choose Close from the File menu; to quit Fiery Downloader, 
choose Exit (Windows) or Quit (Mac OS) from the File menu.

Printing with the Fiery Downloader
Printing files with Fiery Downloader is fast—generally faster than printing from 
within applications. If you regularly print large files, be sure to try printing with 
Fiery Downloader.

TO DOWNLOAD A FILE OR FONT WITH FIERY DOWNLOADER:

1. Use your application to generate a file.

You can save a PostScript or PDF file by selecting the appropriate option in the 
application’s Print dialog box. With some applications, you can also save EPS files.

If you experience problems printing EPS files with Fiery Downloader, you can print 
the file directly from the application in which you created it.

2. Launch Fiery Downloader.
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3. Choose Download from the File menu or click the Download button.
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4. Choose the file type to display from the Files of type (Windows) or Show (Mac OS) 
menu.

You can leave this at the default All Known Formats or choose All Files. All Known 
Formats lists all files in formats supported by Fiery Downloader.

You can download files and fonts in the same batch. If the fonts are used by files in the 
same batch, the fonts should be downloaded first.

To download fonts, you must use the Direct connection (make sure that the Direct 
connection is published on the Fiery X2). If you do not have access to the Direct 
connection, you must embed any special fonts used by the file in the file when you 
generate it.

5. Choose the Connection Type (Windows) or Queue (Mac OS) to which you will download 
the files.

The options available to you in this menu depend on the setup at your site. The 
potential selections are Print Queue (Windows) or Print (Mac OS), Hold Queue 
(Windows) or Hold (Mac OS), and Direct Connection (Windows) or Direct 
(Mac OS). If your administrator has not enabled one or more of these connections, 
you cannot select it.

PDF files cannot be printed with the Direct connection. If you choose the Direct 
connection, the job is spooled to the Print queue and then printed. If the Print queue 
is not enabled, the job is spooled to the Hold queue and must be released for printing 
by the operator.

6. Select the filename and click Add File(s) (Windows) or Add (Mac OS).

The File name field (Windows) displays the name of the selected file before you click 
Add.

You can navigate to different drives and directories to select files to download. Click 
Add All (Mac OS) to add all files in a folder.

To select multiple sequential files, select the first file and then Shift-click the last file. 
Control-click to select multiple non-sequential files.

If you change your mind about a file, select the filename in the Files to Download list 
and click Remove File(s) (Windows) or Remove (Mac OS).

Click Remove All (Mac OS) to remove all files from the Files to Download list.
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7. To change the attributes of a file to be downloaded, select it and click Options. 

8. Specify the following information in the dialog box and click OK.

The options you set apply only to the selected file. You can set different options, or 
leave the default settings, for each file.

Copies—Specify the number of copies.

Brightness (PostScript and EPS files only)—Change the Brightness setting if a file 
appears to be too dark or too light. Choose 85% for a substantially lighter image, 
115% for a substantially darker image, or one of the options in between. 

NOTE: Some applications, including Adobe Photoshop, provide transfer functions that 
let you specify density settings for an image. If the file you are printing includes 
transfer functions, the Fiery Downloader Brightness option has no effect. For more 
information on using transfer functions, see the documentation for your application.

‘showpage’ after EPS files (Windows) or ‘showpage’ (Mac OS) (PostScript and EPS 
files only)—In most cases, you do not need to use this option. Select the ‘showpage’ 
option only if an EPS file fails to print without it. This option adds a ‘showpage’ 

PostScript Options dialog box (Windows) PDF Options dialog box (Windows)

PostScript Options dialog box (Mac OS)
PDF Options dialog box (Mac OS)
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PostScript language command at the end of the print job. Some applications omit this 
necessary PostScript language command when they generate EPS files. Select this 
option when printing EPS files generated by these applications. If you select this 
option unnecessarily, extra blank pages may print.

If you experience problems printing EPS files with Fiery Downloader, you can print 
the file directly from the application in which you created it.

Page range (PDF files only)—Specify the page range you want to print.

9. Click Download File(s) (Windows) or Download (Mac OS).

10. To cancel downloading, press Escape (Windows) or Command-. (Mac OS).

Downloading and managing printer fonts
The Fiery X2 includes 136 PostScript fonts; for a complete list, see Appendix B, “Font 
List.” In addition, two Adobe Multiple Master fonts are included and are used for font 
substitution in PDF files.

NOTE: The Direct connection must be published on the Fiery X2 in order to download 
and manage fonts, and to view the font list.

Before downloading a file that uses fonts not resident on the Fiery X2, you must 
download the fonts (unless the fonts are embedded in the file). To see what fonts are 
resident on the Fiery X2, choose Font List from the File menu or click the Font List 
button (see page 6-9).

You can download fonts only via the Direct connection. If you do not have access to 
the Direct connection, you must embed any special fonts used by the file in the file 
when you generate it.

The screen fonts that correspond to the printer fonts installed on the Fiery X2 are not 
automatically installed on your Windows system.

NOTE: You cannot use Fiery Downloader to download TrueType fonts. If you use 
TrueType fonts in Windows, you can print them by converting them to Adobe Type 1 
fonts. To do this with the Adobe PS printer driver, click the Fonts tab and set up the 
Font Substitution Table as necessary.



66-8 Downloading Files and Fonts

Printer fonts and Mac OS screen fonts 

Like all PostScript fonts, the fonts included with the Fiery X2 come in two forms: 
printer fonts and screen fonts. The printer fonts are installed permanently on the 
Fiery X2 hard disk. The screen fonts, which are included with the Fiery X2 user 
software, should be installed on your Mac OS computer. If you are using these fonts in 
documents you print on a LaserWriter, they are probably already installed. If not, you 
will need to install them yourself. For instructions, see Getting Started.

Occasionally, you may want to use Adobe Type 1 (Windows) or PostScript (Mac OS) 
fonts that are not included with the Fiery X2. If so, you will need to install both the 
screen fonts and the printer fonts on your computer. To do this, follow the instructions 
from the font manufacturer.

Downloading printer fonts to the Fiery X2

In general, each time you print from within a Mac OS application, the application 
automatically downloads any fonts used in your document that are not already 
installed on the Fiery X2, as long as the printer fonts are installed in your 
System Folder. These fonts remain in the Fiery X2 only until your document has 
printed. If you print the same document again, your application must download the 
fonts again.

If you regularly use one or more fonts from Windows or Mac OS applications that are 
not already installed in the Fiery X2, you can save time by downloading them to the 
Fiery X2 hard disk with Fiery Downloader. Fonts you download to the Fiery X2 hard 
disk remain installed until you remove them using Fiery Downloader, no matter how 
many times the Fiery X2 is turned off and on. You’ll probably want to download fonts 
you use on a regular basis to the Fiery X2 hard disk.

Before you download PostScript or EPS files with Fiery Downloader, make sure that all 
fonts included in your file are installed on the Fiery X2 or embedded in your file; 
otherwise the text in these fonts will not print correctly and may not print at all. For 
PDF files, font substitution occurs automatically for fonts not installed on the 
Fiery X2. Two multiple master fonts (a serif font and a sans serif font) stored on the 
Fiery X2 are used exclusively for substitution with PDF files.
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TO VIEW FONT INFORMATION, UPDATE, PRINT, AND DELETE FONTS:

• Choose Font List from the File menu or click the Font List button.

The Font List window appears with Update, Print, and Delete buttons in the title bar. 
The printer fonts included with the Fiery X2 (resident fonts) are locked. Locked fonts 
appear with a lock icon next to the name and cannot be deleted.

Click to update the information 
in the font list window

Click to print the font list to the Print queue

Select a font and click to delete it

Lock icon
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Fiery X2 user software includes a variety of tools that allow you to track and manage 
print jobs. The particular tools, and the access privileges for them, that are available to 
you depend on the conditions implemented by your site administrator. This chapter 
describes the functions of the Fiery WebTools and the Fiery utilities that let you track 
and manage jobs sent to the Fiery X2.

Tools for job tracking and management 
Depending on the workstation you use and the setup at your site, you may be able to 
choose between several Fiery X2 job tracking and management tools. 

Fiery WebTools
If your site administrator has enabled Web Services on the Fiery X2, you can access 
Fiery WebTools from Windows 95, Windows NT 4.0, and Mac OS computers with 
an Internet browser. The Fiery WebTools that provide job tracking capabilities are 
Fiery WebSpooler and the Status WebTool. Fiery WebSpooler also provides job 
management capabilities, provided you have the necessary access privileges (see 
page 7-2). For specific information on the browsers supported with Fiery WebTools, 
see Getting Started.

Fiery Spooler
Fiery Spooler, like Fiery WebSpooler, provides job tracking and job management 
capabilities. Fiery Spooler can be installed from the User Software CD on 
Windows 95, Windows NT 4.0, and Mac OS client computers, and requires only a 
network connection to the Fiery X2. If your network administrator has not enabled 
Web Services on the Fiery X2, or if you do not have the necessary system support to 
use Fiery WebTools, you may choose to use Fiery Spooler for job management. For 
information on the system and network requirements for the Windows and Mac OS 
versions of Fiery Spooler, see Getting Started.

NOTE: The interface of Fiery Spooler for Windows is virtually identical to that of the 
Fiery WebSpooler; therefore, the descriptions of both are combined into one section 
beginning on page 7-6. The interface of Fiery Spooler for Mac OS is significantly 
different from that of the Fiery WebSpooler; it is described in detail starting on page 
page 7-36.

Chapter 7:
Tracking and 
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Print Jobs
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About Fiery WebTools
Fiery WebTools reside on the Fiery X2 but can be accessed over the network from 
Windows 95, Windows NT 4.0, and Mac OS client computers. The Fiery X2 has a 
home page that lets remote users view server functions and manipulate jobs. For 
specific information on the browsers supported with Fiery WebTools, see Getting 
Started.

The following Fiery WebTools can be accessed from the Fiery X2 home page.

Access privileges
The Fiery X2 system allows the site administrator to choose and implement a level of 
access and control appropriate for your particular site. The levels of access allowed to 
remote users depend on whether the administrator has enabled use of the 

WebTool: Summary: For more information:

Status Shows you the jobs currently processing 
and printing.

See page 7-4

WebSpooler Allows you to view, manipulate, reorder, 
reprint, and delete jobs currently 
spooling, processing, or printing on the 
Fiery X2. Also allows you to view, print, 
and delete the Job Log. Most of these 
functions require an Administrator or 
Operator password, if one has been set.

See “Fiery WebSpooler and 
Fiery Spooler for Windows” on 
page 7-6

WebLink Provides a link to another web page, 
provided you have a valid Internet 
connection. The WebLink destination 
can be changed; this function requires 
the Administrator password, if one has 
been set.

See page 7-5 and the 
Administrator Guide

Installer Allows you to download Fiery X2 
printer file installers directly from the 
server.

See Getting Started

WebSetup Allows you to modify the Fiery X2 
configuration (Setup) remotely. This 
function requires the Administrator 
password, if one has been set.

See the Administrator Guide
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Fiery WebTools, and whether a password is required to use certain features of the 
Fiery WebTools. 

The three possible levels of access to Fiery WebTools are Administrator, Operator, and 
Guest. To enable maximum password protection, Administrator and Operator 
passwords must be specified in Setup (see the Administrator Guide). 

NOTE: An Operator password can be set only by using Fiery WebSetup.

When both an Administrator password and an Operator password have been specified, 
the access levels are as follows:

If you have been given the Operator password, you can manage job flow and override 
print settings of your jobs with Fiery WebSpooler (or Fiery Spooler for Windows). If 
not, you can still log in as Guest and use these tools, and the Status WebTool, to track 
the status of your jobs. Check with your site administrator for information on your 
access privileges.

TO ACCESS FIERY WEBTOOLS:

1. Start up your Internet browser application. 

See Getting Started for information about supported platforms and browsers.

2. Enter the IP address or the DNS name of the Fiery X2.

Check with the operator or administrator for this information.

Access level: Privileges and password requirements:

Administrator Has full access to all Fiery WebTools and Fiery X2 Control 
Panel functions; Administrator password required

Operator Has access to all functions of Fiery WebTools except 
Fiery WebSetup and clearing the Job Log from 
Fiery WebSpooler; Operator password required 

Guest Can view job status, but cannot make changes to jobs or Setup, 
and cannot view the Job Log; no password required
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3. If the Log In dialog box appears, select a login level, enter the password, and click OK.

The Log In dialog box appears only if the administrator has set an Administrator or 
Operator password (or both).

4. When the Fiery X2 home page appears, click to select one of the Fiery WebTools.

Move the cursor over the buttons to display information about the selections.

NOTE: The Configure button appears only if you logged in as Administrator. With 
Administrator privileges, you can click this button and specify which of the 
Fiery WebTools are available to other users.

Checking Fiery X2 status with the Status WebTool
You can use the Status WebTool to see what jobs are currently processing and printing. 
The Status WebTool does not require any special access privileges. If the administrator 
has enabled Web Services in Setup and has provided you with the IP address of the 
Fiery X2, you can use the Status WebTool to monitor the status of print jobs as they 
are rasterized and printed. 

To access the Status WebTool, point your browser to the Fiery X2 home page and click 
Status. The current RIP Status and Printer Status appear in the window.



77-5 Tracking and Managing Print Jobs

To open a new browser window for the Status display, click Float. You can then close 
other browser windows and leave the Status window open to continue checking the 
status of the Fiery X2. As long as you keep the Status window open, it is dynamically 
updated.

To obtain more information about the status of jobs, use Fiery WebSpooler or Fiery 
Spooler. 

Accessing information with the WebLink WebTool
The WebLink button on the Fiery X2 home page provides a link to another web page 
or to multiple web pages, provided you have a valid Internet connection. The WebLink 
destination is initially set to www.efi.com/weblink/xerox. From this page, you can link 
to either the Xerox home page or the Electronics for Imaging home page 
(www.efi.com). The administrator at your site can set the WebLink destination. Check 
the WebLink sites for any information available there.
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Fiery WebSpooler and Fiery Spooler for Windows
Fiery WebSpooler and Fiery Spooler for Windows both provide a window on Fiery X2 
and copier functions, and an interface from which you can control those functions. 

NOTE: After launching, the Fiery WebSpooler and Fiery Spooler for Windows 
interfaces are virtually identical. Following the explanations of how to launch each 
tool, the remainder of this section uses the term “Fiery WebSpooler” to refer to both 
Fiery WebSpooler and Fiery Spooler for Windows. Where differences exist between the 
two, they are noted. 

TO LAUNCH FIERY WEBSPOOLER:

1. From the Fiery X2 home page window, click WebSpooler.

For instructions on how to access the Fiery X2 home page window, see page 7-3. 

2. To log in as Administrator, enter the Administrator password and click OK.
To log in as Operator, enter the Operator password and click OK.
To log in as Guest, click OK, without entering any password.



77-7 Tracking and Managing Print Jobs

The Fiery WebSpooler window appears in a new browser window.

TO LAUNCH FIERY SPOOLER ON A WINDOWS COMPUTER:

1. Choose Fiery Spooler from the Start>Programs menu.

2. Select the Fiery X2 in the Chooser window that appears.

For information on setting up the connection to the server, see Getting Started.

NOTE: A TCP/IP network connection is necessary to use Fiery Spooler on a Windows 
computer. For more information, see Getting Started.
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3. Click OK.

The Fiery Spooler main window appears.

Job management features
NOTE: The Fiery WebSpooler and Fiery Spooler for Windows interfaces are virtually 
identical. The following sections use the term “Fiery WebSpooler” to refer to both 
Fiery WebSpooler and Fiery Spooler for Windows. Where differences between the two 
exist, they are noted. 

Unless passwords have been defined in Fiery X2 Setup, you can log in to 
Fiery WebSpooler without entering a password, and you are given full privileges which 
include:

• A view of current printing jobs and jobs stored on the Fiery X2

• Control of printing jobs and a view of the Job Log

• Ability to clear the Job Log
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After the Administrator has performed Setup and specified passwords, user options 
depend on your login level. If you log in to Fiery WebSpooler as Guest, you have the 
first option only. If you log in as Operator, you have the first two options. If you log in 
as Administrator, you have all three options. For information about Setup and 
specifying passwords, see the Administrator Guide.

You can use the Fiery WebSpooler to perform the following functions from your 
workstation:

• Override current job option settings

• Delete jobs 

• Duplicate or rename jobs

• RIP a job and hold the raster data

• Hold jobs in the spooled area or the RIPped area

• Remove raster data from RIPped files

• Change the priority of jobs

• Edit and merge raster data jobs (DocBuilder)

• Display, print, or delete the Job Log 

Most of these functions require the Administrator or Operator password. However, 
even without a password, you can log in to the Fiery WebSpooler as Guest with view-
only privileges.

Job List window
Your first view of Fiery WebSpooler is the Job List window, which is divided into three 
areas by Spool, RIP, and Print status bars. The Job List window is surrounded by a 
frame that includes slider buttons and menus. System information indicators at the 
bottom of the window show the current availability of hard disk space and RAM on 
the currently selected Fiery X2 server.

When the Fiery X2 is receiving and processing print jobs, the Job List window is a 
dynamic display, filled with the names of jobs and their characteristics. Status bars 
animate in real time as new jobs are processed and printed, and jobs move to different 
display areas.
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The Spool, RIP, and Print areas of the Job List window represent the stages of printing 
a job. Jobs come in at the top level (Spool) and drop down to the Print level, unless 
they are held along the way.

• Spooled jobs—Jobs listed in the area below the Spool status bar area are PostScript 
files stored on the Fiery X2 disk. These jobs were sent to either the Print queue 
(white icons) or the Hold queue (yellow icons). These PostScript files are saved on 
the server’s hard disk. PostScript files can come in packets from the network, or from 
another place on the server hard disk. Jobs are added to a queue in the order in 
which they arrive, and they generally move to another queue in the same order 
unless an operator has intervened to change the order. 

Spool status bar

RIP status bar

Rasterized (RIPped) jobs

Print status bar

Printed jobs

Spooled jobs

Menu bar

System information indicators
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• RIPped jobs—Jobs listed in the area below the RIP status bar are ready to print. 
They have already been rasterized (RIPped, or processed for printing) and are 
waiting, in order, for access to the printer. Rasterized jobs can also be held; held jobs 
are shown with a yellow icon. During RIPping, PostScript commands are 
interpreted in the Fiery X2 to allow the copier to print the file the way its originator 
intended. The result of this interpretation is a raster file associated with the original 
PostScript file. In this raster file (raster image), color data is associated with each dot 
that can be rendered by the print engine. The color data tells the print engine 
whether or not to apply cyan, magenta, yellow, or black toner to each position on 
the page.

• Printed jobs—Jobs listed in the area below the Print status bar have already been 
printed. Printed jobs can be stored on the Fiery X2 disk. The number of jobs that 
can be stored (from 1 to 99) is defined in Setup. While the PostScript file is usually 
saved to disk, raster images are held in RAM during and after each print job. 
However, you can request that the Fiery X2 save the raster image to disk along with 
the PostScript file. Saving the raster image to disk offers some advantages—raster 
files are already processed so they print quickly, and each part of the raster file is still 
identified with a page in the original document, which means that individual pages 
of a saved raster file can be accessed.

• Errors—Jobs with an error are shown in red. To display the error, double-click the 
job line. 

If you are logged in as Administrator or Operator, you can interact with a job in the 
window by selecting it and choosing a command from the Job menu, or by double 
clicking it and setting print option overrides. (However, if passwords have been set and 
you are logged in as Guest, you can only view jobs; you cannot interact with them.) 

The job icons displayed in the Fiery WebSpooler window are explained on page 7-15.

NOTE: If your job does not appear anywhere in the Fiery WebSpooler window, it may 
have already been printed; if so, it will appear in the Job Log. To view the Job Log, 
choose Show Job Log from the Window menu. (For more information on the Job Log, 
see page 7-33.)
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Menu bar

The menu bar has five menus. When an action is not available in the current context, 
the command is dimmed. When a command is marked with a check, selecting it again 
reverses, or toggles, the command.

Menu: Choose this: To do this:

File Print Job Log Print the Job Log

Delete Job Log Delete the Job Log

Exit Log out from the server and exit Fiery WebSpooler

Job 
(For more 
information on 
these commands, 
see page 7-18)

Delete Job(s) Delete one or more selected jobs

Duplicate Job(s) Duplicate one or more selected PostScript data jobs in the Spool or Print areas

Rename Rename a selected job

Hold Hold the selected job(s); see page 7-14

RIP and Hold RIP and then hold the selected job(s); see page 7-14

Print Print the selected job(s); see page 7-17

Print and Hold Print the selected job(s) and then hold it in the RIP area; see page 7-14

Process Next Give top priority to this job

Remove Raster Remove the raster information from the selected job(s); see page 7-20

Override Print 
Settings

View and edit print settings for the selected job(s); see page 7-20

Thumbnail A Open a selected held raster data job in the Thumbnail A window where you 
can view a full-screen preview of the job, edit the job, or merge it with raster 
data from other jobs; see page 7-22

Thumbnail B Open a selected raster data job (not necessarily a held job) in the Thumbnail B 
window for viewing or for copying pages into a job in the Thumbnail A 
window; see page 7-24
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Status bars

Jobs actively involved in the three processes (spooling, rasterizing, and printing) are 
listed in the status bars that span the Job List window.

Status bars show the filename and user name for the active process, and an indication 
of its progress. Each status bar heads the list of jobs that have completed the process. 
Thus, beneath the Spool status bar, you see a list of spooled files; beneath the RIP 
status bar, you see a list of rasterized (RIPped) files. Beneath the Print status bar, you 
see a list of jobs that have already been printed.

NOTE: In the Spool status bar, the filename and user information always appear as 
“Unknown” (as shown below). This information is not available until the job has 
finished spooling to the Fiery X2 disk.

Page
(DocBuilder 
commands for 
Thumbnail A)

Delete Delete the selected page(s)

Duplicate Duplicate the selected page(s)

Preview View a full-screen preview of the selected page; see page 7-32

Undo Undo previous Page menu commands (multiple undos available)

Window Show Job List Show the Job List window

Show Job Log Show the Job Log window

Help About View the Fiery WebSpooler information screen

Menu: Choose this: To do this:
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Active jobs and Held jobs

You can hold a job at any stage of the process we have described, as illustrated below. In 
the figure, boxes indicate types of job icons you would see in the Job List window.

Jobs that are held are shown with a yellow icon, just beneath the Spool or RIP status 
bar. Jobs that are held must be activated with a command in order to print.

Active jobs are shown with white icons; new jobs are added above older jobs.

Spooled and held

RIPped and held

Print and hold

RIP

Print

Printed

PostScript and 
raster data

Deleted

Spool

Spooled for printing

RIPped for printing

Print*

*A copy of the held job is printed; the held job remains in the RIP area.
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Job icons
There are three types of icons that are used for both active jobs and jobs on hold.

Spool area
The job icons in the Spool area are described below: 

Icon: Active jobs:
(white icons and rows)

Jobs on Hold:
(yellow icons and rows)

Printer icons

PostScript or raster data 
headed for printing (top) or 
after printing (bottom)

PostScript data headed for Print 
and Hold or job on Hold after 
printing (Hold)

Raster icon

PostScript and raster data 
after printing, ready for fast 
reprint

PostScript data already rasterized 
and held

Spool area icon: What it indicates: How long you see the job:

1

Yellow printer icon 
Yellow job row

PostScript data from a user on 
the network; no destination is 
defined

Until a destination is chosen

2

White printer icon 
White job row 

PostScript data headed for 
Print

Until the RIP is free

3

Yellow raster icon 
White job row 

PostScript data headed for 
RIP and Hold

4

Yellow printer icon 
White job row 

PostScript data headed for 
Print and Hold
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The Spool area is both the receiving area for jobs from users on the network (Hold 
queue) and the waiting area for jobs that will be RIPped (jobs in the Spool queue).

Hold queue jobs  When printing requires an operator (because the Print queue and 
Direct connection are disabled), the operator must assign a destination to all jobs 
received from users on the network (icon 1 in the table above). Once assigned, jobs 
(icons 2, 3, and 4) move down the Spool queue for processing. All jobs printed to the 
Hold queue require routing by an operator.

Print queue jobs  When printing does not require an operator, network jobs sent to 
the Print queue appear in the Spool area where they are shown with a white printer 
icon (icon 2). When they reach the head of the queue, they are RIPped and printed 
without operator intervention.

Direct connection jobs  Jobs printed to the Direct connection are not displayed in the 
job lists. They are displayed briefly in the status bars (where they cannot be selected) 
and are included in the Job Log.

RIP area
The job icons in the RIP area are described below: 

After a job is rasterized, it goes into the RIP area. The RIP area holds only raster data 
(i.e., jobs that have been rasterized). Jobs in the RIP area are either waiting for the 
copier to be free (Print queue jobs, icon 2 in the above table), or they are being held. 

RIP area icon: What it indicates: How long you see the job:

1

Yellow raster icon 
Yellow job row

Raster data, no destination 
defined; may have been 
printed before and held

Until it is deleted or stripped 
of its raster data and sent to 
the Spool area

2

White printer icon 
White job row 

Raster data headed for Print 
in its turn; no hold defined

Until copier is free to print 
the job
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Held jobs in the RIP area have already been rasterized (RIP and Hold) or they have 
been printed and their raster data has been routed back to the RIP area (Print and 
Hold), where they are shown in yellow rows (icon 1).

NOTE: Raster jobs in the RIP area that are waiting to print (icon 2 in the table above) 
cannot be manipulated by job commands.

Jobs held in the RIP area remain there until the operator deletes them. Printing these 
jobs does not remove them from the RIP area. Instead, a copy of the job is created and 
printed.

NOTE: For all rasterized jobs, the print option settings, in addition to the current 
calibration state of the Fiery X2, remain with the saved raster data each time the job is 
reprinted. To print the job with new print option settings and with new calibration 
data, you must remove the raster data and reRIP the job.

Print area
The job icons in the Print area are described below:

The Print area, also referred to as the Printed queue, contains jobs that have already 
been printed. These jobs were assigned the Print destination (white printer icon in the 
Spool or RIP areas) without any Hold instructions; therefore, they all have white icons 
and rows.

NOTE: A job row that appears in light red indicates that a PostScript error occurred 
while printing the job. To see the error, double-click anywhere in the row.

Print area icon: What it indicates: How long you see the job:

1

White printer icon 
White job row 

PostScript data only—raster 
data has been deleted

Until the job limit is reached

2

White raster icon 
White job row 

Raster and PostScript data

If RAM is needed to RIP an 
active job, the raster data is 
deleted and the job gets the 
PS icon (icon 1, above)

Until the job is reprinted or 
the job limit is reached
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Newly printed jobs are added to the Printed queue, and are shown at the top of the list. 
Jobs are saved in the Printed queue until the job limit is reached. When the first job 
over the limit is printed, the oldest job is deleted from the disk. The default job limit is 
10 jobs. The value for Jobs Saved in Printed Queue can be changed in Setup by the 
administrator.

NOTE: If you reprint a job in the Printed queue, the job returns to its original position 
in the Printed queue after it is printed.

While it is printing, a job consists of PostScript and raster data. The raster data in 
RAM is not cleared until memory is needed to rasterize the next job. As long as the 
raster data is intact, the job can be reprinted from the Printed queue. Printed jobs that 
still have their raster data are represented by a white raster icon in the Printed queue 
(icon 2 in the previous table); jobs with only PostScript data remaining are represented 
by a white PS icon (icon 1). If the job was printed from a held raster job (in the RIP 
area), the raster data in the RIP area remains and can be used to reprint the job after 
the raster data has been cleared from the Printed queue.

Job commands
Using the commands in the Job menu, you can alter the destinations, priorities and 
other characteristics of jobs that appear in the Fiery WebSpooler window.

Job commands are used to assign a selected job to a new destination or process. These 
commands are available from the Job menu (see page 7-12). The job commands 
available at a given time depend on the context; unavailable commands are dimmed. 

The job commands available for selected jobs in the Job List window are listed in the 
following table. The table also describes the effect of each command on raster data 
associated with the affected job(s).



77-19 Tracking and Managing Print Jobs

Choose this: To do this: Raster data is:

Delete Job(s) Delete the job(s) Deleted

Duplicate Job(s) Duplicate one or more selected PostScript data 
jobs in the Spool or Print areas. You can use the 
duplicate job(s) for different print options or a 
different destination. (The Duplicate command 
actually creates a reference to the original job, 
with the same name)

n/a
(The Duplicate command is not available for 
raster jobs)

Rename Rename the job (PostScript file with or without 
raster)

Unaffected, but associated with the new name

NOTE: If the renamed job is printed, the Job Log 
reflects the job’s original name.

Hold Hold the job in the current place (except for a job 
in the Print area, which is moved to the Spool or 
RIP area, depending on whether it still has raster 
data associated with it)

Held in RIP area, if included with job

RIP and Hold RIP the job and hold it in the RIP area Held in RIP area indefinitely

Print Print the job in its turn (RIP it first if it does not 
have raster data)
After printing, keep the printed job in the Print 
area until the job limit is reached.

Temporarily held in RAM after printing until 
memory is needed for another job
(If the job was printed from a held job in the RIP 
area, the raster data in the RIP area is kept 
indefinitely)

Print and Hold
(Like the user print 
option Save Fast 
Reprint)

Print the job in its turn (RIP it first if it does not 
have raster data) 
After printing, hold the PostScript data and the 
raster in the RIP area

Held in RIP area indefinitely (saved to disk)

Process Next Give top priority to this job
RIP (and then print) it as soon as the processor is 
free, before other waiting jobs
Option is dimmed if there are no other waiting 
jobs

n/a
NOTE: This command is available only for jobs in 
the Spool area that are not currently held.
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Overriding print settings
When logged in as Operator or Administrator, you can use the Override Print Settings 
command to check and override the print option settings (properties) of all jobs as 
follows. 

• To override a setting based on printed output or other print device conditions

• To change settings for a duplicate of the original job

• To print a single copy of a job before printing the number of copies required by the 
user

Remove Raster Remove the raster data from a job that has raster 
data (indicated by a raster icon); leave the 
PostScript data unaffected

Deleted
NOTE: If you remove raster from a job in the RIP 
area, the job is sent to the Spool area.

Override Print 
Settings

View and override print settings for a selected job 
or a group of selected jobs

Possibly deleted and regenerated, depending on 
whether you change any settings that require re-
RIPping

Thumbnail A Open the selected held raster data job in the 
Thumbnail A window where you can view a full-
screen preview of the job, edit the job, or merge it 
with raster data from other jobs 

May be changed if job is edited

Thumbnail B Open the selected raster data job (not necessarily 
a held job) in the Thumbnail B window for 
viewing or for merging into a job in the 
Thumbnail A window

Unchanged

Choose this: To do this: Raster data is:
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TO CHANGE JOB OPTIONS:

• Double-click the job line or select the job and choose Override Print Settings from the 
Job menu. 

If necessary, scroll down to see all the various job options.

The options you set here are the same ones you set from the Print dialog box when you 
print from an application. For information about print options, see Appendix A, 
“Print Options.”

For some options, changing the setting requires that the job be reRIPped; these 
options show an icon to the left of the option name.

For PDF files, you can only override number of copies and page range from the 
Properties dialog box.

NOTE: If you want to retain a copy of the job with its original settings, duplicate the job 
and rename the duplicate before you change any settings (see “Job commands” on 
page 7-18). 

Indicates reRIPping is required

Override Print Settings dialog box for 
PostScript files

PDF Settings dialog box for PDF files
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The Override Print Settings dialog box displays all the job settings encoded by the 
PostScript printer driver that can be decoded by the Fiery X2. If you (as operator) have 
not changed anything, these are the settings a user entered before sending the job.

NOTE: Some print options that are available in the printer driver are not displayed in 
the Override Print Settings dialog box. 

For information on print option settings, see Appendix A, “Print Options.”

Thumbnails and full-screen previews in DocBuilder
The Fiery WebSpooler includes a powerful DocBuilder™ tool that allows you to 
preview and edit raster data. (For information on how to identify a raster data job, see 
page 7-15.) DocBuilder consists of two thumbnail windows and several page-
manipulation commands (listed in the Page menu). 

• In the Thumbnail A window, you can see thumbnails of the currently RIPping job, 
as it is processed, or of any raster data job.

• From the Thumbnail A window you can open a full-screen preview of a raster file.

• Using the Thumbnail A and Thumbnail B windows together, you can merge raster 
data from more than one file, even if the files were printed from different 
applications on different computer platforms. 

DocBuilder’s merge features eliminate the limitations of particular software 
applications. You can merge raster pages of documents of different types, and even 
different computer operating systems. You can merge color pages from graphics 
programs with text pages from a word processor. 

Previewing print jobs

You can use the Thumbnail A window to preview pages of the currently RIPping job. 
You can also use Thumbnail A, as well as Thumbnail B, to preview any raster data job 
in the RIP or Print areas.

The thumbnail windows also allow you to open an editable thumbnail view of a held 
raster job in the RIP area and perform electronic collation or document merging. This 
feature, called DocBuilder, is described on page 7-24.
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To see the progress of jobs as they are RIPped, you can leave the Thumbnail A window 
open in RIP preview mode.

TO VIEW THUMBNAILS OF THE CURRENTLY RIPPING FILE:

1. Click the Thumbnail A tab at the right of the Job List window to open the slider.

2. Click the RIP preview icon at the left side of the window.

In this mode, Thumbnail A displays each page of the currently processing job after it 
has been RIPped.

3. Choose a PS file in the Spool or Print area and select RIP and Hold, Print, or 
Print and Hold.

As pages are RIPped, they are displayed in the Thumbnail A window. 

4. When you have finished viewing, click the Thumbnail A tab to close the thumbnail 
window.

TO VIEW THUMBNAILS OF ANY RASTER DATA FILE:

1. Select any raster data job in the RIP or Print area.

2. Choose Thumbnail A or Thumbnail B from the Job menu.

If you choose Thumbnail A, make sure the raster data preview icon (at the left side of 
the window) is selected.

Click to display the currently 
rasterizing job Click to close the

thumbnail window
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NOTE: Wait until all pages have been displayed before opening another raster file with 
Thumbnail A. If the job contains many pages, it may take some time for the entire job 
to be displayed.

3. When you have finished viewing, click the Thumbnail A or Thumbnail B tab to close 
the thumbnail window.

Editing and merging files with DocBuilder

When you select a raster data job and choose the Thumbnail A or Thumbnail B 
command from the Job menu, the corresponding Thumbnail slider opens 
automatically, displaying thumbnails of the editable file. To close the Thumbnail slider, 
click anywhere in the tab along the right edge of the Thumbnail window. When the 
Thumbnail window is open, the arrows in the tab point to the right, indicating that 
clicking the tab retracts the slider.

With the Thumbnail A window you can see thumbnail views of any raster data job—
that is, any file that is currently RIPping, or any file that has been RIPped and held to 
disk. You can also use the Thumbnail A window to edit a raster file—you can change 
the sequence of pages, delete pages, duplicate pages, and copy pages from other raster 
files into the Thumbnail A window. You can save the edited raster file as a new 
printable document.

Raster data preview icon Click to close the
thumbnail window
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The Thumbnail B window can also display thumbnails of a raster job, and the 
document displayed in Thumbnail B can be used as a source for editing the document 
shown in Thumbnail A.

NOTE: Be careful not to delete a Thumbnail job entirely without first saving a copy.

You can merge documents by dragging (copying) one or more entire pages from 
Thumbnail B to Thumbnail A. This creates a new document in the Thumbnail A 
window. If you select one or more pages in the Thumbnail A window, the commands 
in the Page menu give you additional editing possibilities. Multiple undos of Page 
menu commands are possible.

You can merge pages from multiple documents into the Thumbnail A document by 
opening documents one after another in the Thumbnail B window. Documents in the 
Thumbnail B window are view-only, and while you can copy pages from Thumbnail B 
to Thumbnail A, you cannot edit the Thumbnail B document. A merged document 
that you create in Thumbnail A can be saved (with a different name) as a new raster 
data file. 

Thumbnail B (source)

Thumbnail A (target)

Click here to close the Thumbnail B window

Click here to close the Thumbnail A window

Click to expand or retract 
the Thumbnail B window

Click to expand or retract 
the Thumbnail A window
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The ability to work with raster files gives you new opportunities to combine 
documents from different sources into a single printer file. For example, you can 
combine full color covers and chapter head pages created in a page layout application 
with two-color text pages created in a document processing application. Or, you can 
customize a slide presentation by inserting slides from a different presentation. 

You can display two raster files at once: a source file and a target file. The target file is 
displayed in the Thumbnail A window, the source in Thumbnail B. Both files must be 
held raster jobs in the RIP area.

NOTE: You cannot create a new PostScript file in this process; you must print the 
merged raster file, which has references to the original PostScript files. Before editing or 
merging files with DocBuilder, make sure the source files were RIPped using the print 
option settings and the resident calibration you want for the final output. Raster files 
edited with DocBuilder cannot be reRIPped.

TO VIEW AND EDIT RASTER DATA JOBS:

1. Select a raster data job and choose Thumbnail A from the Job menu.

The file must be a held raster job in the RIP area.

2. In the Thumbnail A window, right-click a thumbnail image to see the commands 
available for pages in Thumbnail A. 

These commands can also be accessed from the Page menu (see page 7-13) as well as 
from buttons along the left side of the Thumbnail A window (see illustration below).
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To scroll through the pages in Thumbnail A, you can click in the empty area to the left 
or right of the slider bar, or click on the arrows.

Delete deletes the currently selected page.

Duplicate duplicates the currently selected page.

Open Preview opens a full-screen preview of the currently selected page (see 
“Full-screen previews” on page 7-32).

Undo undoes the previous DocBuilder command—this command is available only from 
the Page menu.

3. To move pages within Thumbnail A, left-click to select the page(s) and hold down the 
mouse button as you drag the selected page(s) to the new location.

Shift-click to select multiple, sequential pages; Ctrl-click to select multiple, non-
sequential pages. Make sure to release the Shift or Ctrl key before moving the pages.

If you move the page(s) on top of existing page(s), the page(s) will be overwritten.

Click to open a full-screen 
preview of the page

Click to duplicate a page

Click to delete a page
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If the icon does not have an arrow, the page(s) will be replaced; if the icon has an arrow, 
the page(s) will be inserted.

4. When you are finished editing, click the Thumbnail A tab. 

If you have edited the job, you are prompted to save the job (click Yes) and enter a new 
name.

5. Enter a new name and click OK.

The new raster file is now in the RIP area, ready to print. If you saved the edited file 
with a new name, the original source file remains held in the RIP area.

…

…

Replace single page Replace multiple pages

Move single page Move multiple pages
between two pages between two pages

…

Move single page Move multiple pages
before first page before first page

…

Move single page Move multiple pages
after last page after last page
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TO MERGE TWO RASTER DATA JOBS:

1. In the Thumbnail A window, display the document you wish to edit.

The file must be a held raster job in the RIP area.

2. Right-click another source document file (a held job with a raster icon) and select 
Thumbnail B.

The Thumbnail B tab opens a second thumbnail view which cannot be edited but can 
be a source for pages added to the document in Thumbnail A.

NOTE: To merge documents, the page sizes of the source document and the target 
document must be the same.

3. In the Thumbnail B window, left-click to select the page(s) and hold down the mouse 
button as you drag the selected page(s) to the new location in Thumbnail A.

Shift-click to select multiple, sequential pages; Ctrl-click to select multiple, non-
sequential pages. Make sure to release the Shift or Ctrl key before moving the pages.

To scroll through the pages in Thumbnail A and Thumbnail B, you can click in the 
empty area to the left or right of the slider bar, or click on the arrows.

To replace page(s), drag Thumbnail B page(s) on top of page(s) in Thumbnail A; to 
add page(s), drag the page(s) to a new position between pages, before the first page, or 
after the last page in Thumbnail A (see the icons on page 7-28).

NOTE: To insert a Thumbnail B page directly after the last Thumbnail A page, drag the 
Thumbnail B page so that it is just to the right of the last Thumbnail A page and 
shows an arrow pointing to the right. If the Thumbnail B page is placed too far to the 
right of the last Thumbnail A page, the Thumbnail B page will replace the last 
Thumbnail A page.
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Multiple undos are available; use the Undo command (from the Page menu) to undo 
all the way back to your first edit. There is no Redo function.

NOTE: Make sure to save the merged job before deleting any of the source jobs you used 
to create the merged job.

Thumbnail B pages moved into Thumbnail A adopt some specific attributes of the 
Thumbnail A job, such as the document and user name. However, many color-related 
print options that are set in the Thumbnail B page, such as CMYK Simulation and 
Rendering Style, remain with the specific page. This could result in a merged job being 
made up of pages with different attributes.

Generally, the print option settings specified for the Thumbnail A job that are adopted 
by the pages copied from Thumbnail B do not require reRIPping to take effect. The 
one exception is the setting specified for the Save Fast Reprint option, which requires 
reRIPping if you want to change it.

Thumbnail B

Page 4 copied from the 
document in Thumbnail B
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The print option settings that remain with the pages copied from Thumbnail B into 
Thumbnail A are generally those that do require reRIPing to take effect.

Attributes that do not require reRIPping can be changed for the newly merged job 
without having to reRIP any original PostScript files. Attributes that require reRIPping 
result in reRIPping of the original PostScript file(s) associated with Thumbnail A.

4. To close the Thumbnail view, click once on the same tab you used to open it 
(Thumbnail A or Thumbnail B tab).

5. If you have edited Thumbnail A, you are prompted to save the job (click Yes) and enter 
a new name. Enter a new name and click OK.

The new raster file is now in the RIP area, ready to print, together with the original 
source and target files.

NOTE: If you print the edited raster file, it appears in the Job Log with the name of the 
original job, not the new name you specified for the edited job.

Since you cannot create a new PostScript file by merging two raster data jobs, you must 
print the merged raster file, which has references to the original PostScript files. If a 
merged job is reRIPped and printed, then only the pages of the original PostScript job 
in Thumbnail A will be processed and printed.

NOTE: In cases where multiple users are connected to the Fiery X2 via 
Fiery WebSpooler and/or Fiery Spooler, and one user makes changes to a Thumbnail A 
job, not all users may see the results of those changes. If you are unable to view changes 
in a job, or if selecting a Thumbnail window results in a message indicating zero pages, 
then close and relaunch Fiery WebSpooler or Fiery Spooler.
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Full-screen previews

Double-clicking any page in the Thumbnail A window opens a full-screen preview of 
the page. The full-screen preview is a view-only display, and it takes time to retrieve the 
data. Once begun, the process cannot be canceled. 

NOTE: If you have edited a raster job with DocBuilder, you must save the edited file 
before you can view full-screen previews of all its pages.

Using the icons in the full-screen preview, you can display adjacent pages, rotate the 
page, or close the preview.

Click to view adjacent pages Click to
close the

full-screen
previewClick to rotate 90 degrees 

clockwise

Click on
arrows, in

empty
spaces, or
move bar
to scroll

up or down

Click on arrows, in empty spaces, or 
move bar to scroll left or right
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Using the Job Log
From the Fiery WebSpooler, you can view and print a log of all jobs printed by the 
Fiery X2, including jobs downloaded with the Fiery Downloader. 

NOTE: If you logged in as Administrator, you can delete the Job Log from the 
Fiery WebSpooler (see page 7-34). The Job Log is not available if you logged in as 
Guest.

TO DISPLAY, UPDATE, PRINT, DELETE, AND SAVE THE JOB LOG:

1. Choose Show Job Log from the Fiery WebSpooler Window menu.

2. Click All or specify a date range.

3. Click OK.

The Job Log appears in a new browser window.

NOTE: The Delete button appears only if you logged in as Administrator.
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The Job Log displays each job and the following information: status, document name, 
user name, date, start time, end time, process time, file size, device, paper size, media, 
number of originals, number of color pages, number of black-and-white pages, total 
number of pages, Note1, and Note2.

The Status column provides the following information about jobs:

4. To update the Job Log, click the Update button.

5. To print the Job Log, choose Print Job Log from the File menu or click the Print 
button.

The information displayed in the Job Log window prints to the current Fiery X2. 
When you print the Job Log, totals are printed for all appropriate columns.

6. If you logged in as Administrator, you can choose Delete Job Log from the File menu 
or click the Delete button to clear the Job Log.

The system administrator can also print and clear the Job Log from the Control Panel.

OK The job was printed normally.

ERROR An error occurred during processing or printing.

CANCEL The job was canceled before printing was completed.

Update

Print

Delete
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Differences between Fiery WebSpooler and Fiery Spooler 
for Windows 
Though the interfaces for both Fiery Spooler for Windows and Fiery WebSpooler are 
almost identical, there are some feature differences.

Connecting to a different Fiery X2

With Fiery Spooler, you can connect to a different Fiery X2 from within the 
application using the following procedure.

TO CONNECT TO A DIFFERENT FIERY X2:

1. Choose Open Fiery from the File menu.

2. Select the Fiery X2 in the Chooser window that appears.

For information on setting up the connection to the server, see Getting Started.

3. Click OK.

The Fiery Spooler main window appears.

Saving the Job Log as a file

With Fiery Spooler, you can save the Job Log as a file that you can view with a different 
application.

TO SAVE THE JOB LOG AS A FILE:

1. Choose Export Job Log from the File menu or click the Export button at the top of the 
Job Log window.

2. In the File name area, enter a name for the Job Log file (the default name is 
Fiery Job Log.txt).

Export button
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3. Browse to the location where you want to save the file, and click Save.

The Job Log is saved as a text file, and the Job Log window reappears.

You can view the information in any application that can read a text file. Items are 
separated by tabs.

Fiery Spooler for Mac OS computers
For Mac OS computers, the Fiery Spooler interface and functionality differs from the 
Fiery WebSpooler, and the Windows version of Fiery Spooler.

On a Mac OS computer, Fiery Spooler jobs can be in one of the following queues:

Jobs in the queues are stored on the Fiery X2 hard disk. Make sure that you leave 
enough space on the hard disk for fonts and other Fiery Spooler jobs.

You can use the Fiery Spooler Job Log to view information about jobs printed to the 
Fiery X2 for job accounting purposes, or saved for reference. The Job Log can be 
printed to the Fiery X2 or saved as a file and viewed in other applications.

Print Normal print jobs sent to the Fiery X2 appear in the Print queue. You 
can move and manipulate these jobs as described below.

Hold Jobs sent to the Hold queue remain in the queue until they are moved to 
the Print queue or deleted. If you need to print the same document 
frequently, you can send it to the Hold queue and move a copy of the 
job to the Print queue every time you need to print it. You can also send 
large jobs to the Hold queue and then move them to the Print queue 
when other users are not printing.

Printed The jobs most recently sent to the Fiery X2 are saved in the Printed 
queue. You can drag these jobs back to the Print queue to print 
additional copies. The number of jobs saved in the Printed queue is set 
by your system administrator in Fiery X2 Setup.
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TO LAUNCH FIERY SPOOLER ON A MAC OS COMPUTER:

1. Double-click the Fiery Spooler icon.

2. If your network is divided into zones, select the zone in which the Fiery X2 is located.

3. Select the Fiery X2 from the list of servers that appears, and click Connect.

The Fiery Spooler main window appears.

4. To access Administrator functions, choose Password from the Administrator menu.

This menu is active only if a password was created on the Fiery X2.

5. Enter the password in the window that appears, and click OK.

Current Print and RIP status

Name of the job currently 
printing

Scroll list of every document 
sent to the Print queue

Jobs with PostScript errors 
appear in Printed queue with 
Alert icon

Name of the job currently 
processing

Server name or IP address 
of Fiery X2

Available space on 
Fiery X2 hard disk

Scroll list of every document 
sent to the Hold queue
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The job list
The job list includes information about the document name, user name, time and date 
sent, print device, and file size.

The window is split into regions that correspond to the different queues and steps in 
the printing process. You can click and drag a job to the Print or Hold region of the 
window to move it to the corresponding queue.

Buttons appear above the scroll list:

The icons provide information about the job:

Update Click this button to update the information in the Fiery Spooler main 
window.

Duplicate 
and Print

Drag a document onto this button or select the document and click 
this button to duplicate it and put the duplicate in the Print queue.

Print Drag a document onto this button or select the document and click 
this button to print it to the Print queue.

Hold Drag a document onto this button or select the document and click 
this button to move it to the Hold queue.

Delete/
Cancel

Drag a document onto this button or select the document and click 
this button to delete it or cancel processing or printing it. You will be 
asked to verify that you want to delete the job. You can eliminate the 
verification notice by turning off the Confirm file deletion option in 
the Preferences dialog box.

Printing Printing icon The job that is currently printing appears in this list; it can be selected 
and deleted to cancel printing.

Waiting Printing icon Jobs that have been processed and are waiting to print appear in this 
list, but they are dimmed because their settings cannot be changed 
and they cannot be moved or canceled.

Ripping RIP icon Jobs that are processing appear in this list; they can be selected and 
deleted to cancel processing.
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Choose Preferences from the Edit menu to configure how the Fiery X2 updates and 
deletes files.

You can use this window to specify that the Fiery X2:

Update Automatically every n seconds or Update Manually—This option lets you 
specify whether the Fiery Spooler main window is automatically updated every 20 
seconds (or at an interval that you set), or whether it is updated only when you choose 
the Update command from the Window menu. By default, the Fiery Spooler main 
window is updated automatically every 20 seconds.

Print Print icon Jobs that have not been processed appear in this list, in the order they 
will be processed and printed. The jobs can be selected and deleted to 
cancel processing and printing.

Hold Hold icon Jobs in the Hold queue appear with the Hold icon. You can move the 
job to the Print queue to print it.

RIP and 
Hold

RIP and 
Hold icon

Jobs that have been RIPped and held appear in the Hold queue with 
the RIP and Hold icon. You can move the job to the Print queue to 
print it.

Printed Printed icon Jobs that have been printed are saved in this list. Jobs are stored in the 
Printed queue until the limit set by your system administrator in 
Fiery X2 Setup is reached. The jobs can be selected and deleted from 
the Fiery X2 hard disk.

Printed Alert icon If a PostScript error occurred while a job was printing, it appears in 
the Printed queue with an Alert icon (the Printed icon with a red 
slash) next to it. You can double-click the Alert icon to display the 
error message. The jobs can be selected and deleted from the Fiery X2 
hard disk.
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NOTE: When automatic updating is on, data is coming from the Fiery X2 across the 
network very frequently. This data adds to the network traffic, and may slow down 
other network jobs. For optimum network performance, turn off automatic updating 
in the Fiery Spooler Preferences dialog box; when you want to view updated 
information in the Fiery Spooler window, choose Update from the Window menu or 
click the Update button.

Confirm file deletion—Select this if you want a confirmation dialog box to appear 
before you delete a file.

Duplicating, copying, moving, and deleting jobs
Users monitor their own print jobs. The Fiery X2 system administrator (or anyone 
with Fiery Spooler Password access) can move, delete, and configure jobs for all users, 
and can re-order jobs within a queue.

You can move your jobs from the Hold queue and the Printed queue to the Print 
queue. If, for example, you frequently print the same file, you can send it to the Hold 
queue and later drag a copy of the file to the Print queue. By copying rather than 
moving a job, you leave a copy of the job in the Printed queue so that you can print the 
job again later. You can also duplicate a job if you want to have multiple copies of a job 
in the same queue.

Duplicating jobs

You can duplicate jobs in the Print and Printed, and Hold queues:

• If you want to change printing parameters in the Override Print Settings dialog box 
without losing the original settings

• If you want to print more than 20 copies to the sorter (the maximum number of 
copies that you can print to the sorter is 20)

When you duplicate a job, the Fiery X2 creates a reference to the original file, so 
duplicate files do not require the full amount of disk space on the Fiery X2. As long as 
one of the duplicates remain, the Fiery X2 saves the file, so you can delete all but one 
reference to a file.
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TO DUPLICATE A JOB WITHIN A QUEUE: 

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted. If you want to select more than one job, shift-click to 
select multiple, adjacent jobs; control-command-click to select multiple, non-adjacent 
jobs.

2. Choose Duplicate Job(s) from the Edit menu.

The job appears at the bottom of the queue. 

TO DUPLICATE AND PRINT A JOB: 

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted.If you want to select more than one job, shift-click to 
select multiple, adjacent jobs; control-command-click to select multiple, non-adjacent 
jobs.

2. Click the Duplicate and Print button, or drag the job to the Duplicate and Print button.

The job appears at the bottom of the Print queue. 

TO COPY A JOB TO ANOTHER QUEUE:

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted. If you want to select more than one job, shift-click to 
select multiple, adjacent jobs; control-command-click to select multiple, non-adjacent 
jobs.

2. Hold down the Option key as you drag the job to either the Hold or Print queue icon or 
to the Hold or Print section of the job list.

A copy of the job is moved to the queue you have selected, but the original job still 
appears in the Hold or Printed queue so that you can print the job at another time.
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TO MOVE A JOB WITHIN A QUEUE:

1. Choose Password from the Administrator menu and enter the password.

If there is no password, go to step 2.

2. Select the job that you want to move by clicking its name. 

The selected job is highlighted. If you want to select more than one job, shift-click to 
select multiple, adjacent jobs; control-command-click to select multiple, non-adjacent 
jobs.

3. Drag the file to the new location in the queue.

TO MOVE JOBS BETWEEN QUEUES:

1. Select the job that you want to move by clicking its name. 

The selected job is highlighted.If you want to select more than one job, shift-click to 
select multiple, adjacent jobs; control-command-click to select multiple, non-adjacent 
jobs.

2. Move the selected job to another queue by dragging it to the queue icon of your choice 
or to the Hold or Print section of the job list.

For example, move a job that is currently in the Hold queue to the Print queue by 
dragging the job to the Print queue icon. 

TO DELETE A JOB FROM ANY OF THE QUEUES:

1. Select the job that you want to delete by clicking its name.

2. Drag the selected job to the Delete button or click the Delete button.

You can also choose Delete Job(s) from the Edit menu.

System administrators (or anyone with Fiery Spooler Password access) can delete any 
job.
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Changing print settings for a job
You can set certain printing parameters for a job in the Override Print Settings dialog 
box. The settings in this dialog box override the settings in the Printer Specific Options 
dialog box and in Fiery X2 Setup.

You can change printing parameters only for jobs in the Hold, Print and Printed 
queues of the Fiery Spooler main window.

System administrators (or anyone with Fiery Spooler Password access) can change print 
settings for any job.

NOTE: The Override Print Settings dialog box may not reflect the entire set of print 
options that are available from the printer driver; additionally, it does not indicate 
which options require reRIPing of the job.

TO CHANGE PRINT SETTINGS FOR A JOB:

1. Double-click a job or select the job and choose Override Print Settings from the Edit 
menu.

The Override Print Settings dialog box appears.
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2. Choose the new settings from the pop-up menus.

If you select Default Settings, the job will use the settings in the Printer Specific 
Options dialog box.

For information about these options, see Appendix A, “Print Options.”

3. Click OK to make changes.

Using the Job Log
With Fiery Spooler, you can view and print a log of all the jobs printed to the Fiery X2. 
You can also save the Job Log as a text file that you can then import into a spreadsheet 
or word processing application for job accounting purposes. All jobs printed to the 
queues, printed by direct connection, and scanned from the copier are listed in the 
Job Log.

TO DISPLAY, UPDATE, PRINT, SAVE, AND DELETE THE JOB LOG:

1. Choose Show Job Log from the Window menu.

2. Specify the period for the Job Log in the window that appears.

Click All to view all jobs since the Job Log was cleared; click Date if you want to specify 
a period of time for the Job Log.

3. Click OK.

The Job Log window displays a list of all the jobs and the following information about 
them: status, document name, user name, date, start time, end time, process time, file 
size, print device, paper size, media, number of originals, number of color pages, 
number of black and white pages, total number of pages, Notes 1, and Notes 2.

The information in the note fields is specified in the Print dialog box if you are using 
the Adobe PostScript printer driver. 
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Use the scroll bar at the bottom of the window to view all fields in the Job Log 
window.

The text in the Status column provides information about the job:

4. To update the Job Log, click the Update button at the top of the window.

5. To print the Job Log, choose Print Job Log from the File menu or click the Print button 
at the top of the window.

The information displayed in the Job Log window prints to the current Fiery X2. 
When you print the Job Log, totals are printed for all appropriate columns.

6. To save the Job Log as a file that you can view with a different application, choose 
Export Job Log from the File menu or click the Export button at the top of the window. 
Enter a name for the log file, and click Save. 

The Job Log is saved as a text file, and the Job Log window reappears.

You can view the information in any application that can read a text file. Items are 
separated by tabs.

7. If you entered the Administrator password, you can choose Delete Job Log from the 
File menu to clear the Job Log. 

The system administrator can also print and clear the Job Log from the Control Panel.

OK The job was printed normally.

ERROR A PostScript error occurred while a job was processing. You can 
double-click ERROR to display the error message. A dialog box 
displays the PostScript error. Click OK to close the dialog box.

CANCEL The job was canceled before printing was completed.

Update

Print

Export

Delete
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Calibrating the Fiery X2 ensures consistent, reliable color output. You can calibrate the 
Fiery X2 in the following ways:

• Using AutoCal from the Fiery X2 Control Panel—AutoCal allows you to obtain 
measurements from the copier and apply a calibration using the copier’s built-in 
scanner. 

• Using Fiery Print Calibrator and a densitometer from a remote computer—By 
connecting an X-Rite DTP32 automatic scanning densitometer to the serial port on 
your computer, you can quickly measure color patches and download measurements 
to the Fiery X2 using Fiery Print Calibrator. 

This chapter describes the purpose of calibration and provides instructions for all 
calibration procedures. Calibrating with AutoCal from the Fiery X2 Control Panel is 
described first; calibrating with Fiery Print Calibrator and a densitometer is described 
on page 8-6.

For information on advanced calibration and simulation features available with Fiery 
Print Calibrator, such as editing targets and creating custom targets, see Chapter 9.

The Fiery Print Calibrator procedures described in these chapters are fundamentally 
the same for Windows and Mac OS computers. The main differences are the interface 
cable and the port used to connect to the densitometer. The term “computer” is used 
to refer to any computer running Fiery Print Calibrator.

Introduction to color calibration
A calibration is generated from two components that originate separately: 
measurements and a target. 

• Measurements represent the actual color behavior of the copier; they are computed 
from readings taken by the copier’s scanner or a densitometer.

• Targets represent the goal of printing, such as obtaining pleasing color from the 
copier or simulating another print device. A copier-specific target is provided with 
the Fiery X2.

Chapter 8:
Color Calibration
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Calibration generates curves describing various color densities based on a specified 
target and a set of measurements that you provide.

Once you have calibrated the Fiery X2 with Fiery Print Calibrator, a calibration is 
stored on the Fiery X2; this calibration is referred to as the “resident calibration.” The 
resident calibration is applied to all print jobs unless bypassing of calibration is 
specified by setting the CMYK Simulation print option to Match Copy (see 
Appendix A).

NOTE: Changing the resident calibration has the potential to affect all jobs for all users, 
so you may want to limit the number of people authorized to perform calibration. An 
Administrator password can be set to control access to calibration from the Fiery X2 
Control Panel. Administrator and Operator passwords can be set with Fiery WebSetup 
to control access to calibration with Fiery Print Calibrator.

Understanding calibration
The Fiery X2 allows you the flexibility to choose a standard calibration or a custom 
calibration. A standard calibration uses one of the targets provided with the Fiery X2 
(5750, 5790, 5799, or Linear) with a new set of measurements. 

Calibration allows you to:

• Maximize the color reproduction capabilities of the Fiery X2

• Ensure consistent color quality across time

• Produce consistent output across Fiery X2 servers of the same engine

• Achieve better color matches when reproducing spot colors, such as PANTONE 
colors or other named color systems

• Optimize the Fiery X2 for using ColorWise Color Rendering Dictionaries (CRDs) 
and CMYK simulations, and for using ICC-compatible profiles when printing RGB 
color data)

• Linearize the Fiery X2 while maintaining the currently available density range

Chapter 9 discusses advanced calibration techniques, including how to:

• Use the Fiery X2 as a proofing system by printing press simulations

• Create custom calibration and simulation targets
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How calibration works
Success in obtaining satisfactory print quality from a digital color printer depends on 
many factors. Among the most important are establishing and maintaining optimal 
toner densities. Density is a measure of the light absorbed by a surface. By carefully 
regulating toner densities, you can obtain consistent printed color. 

Even with a calibrated system, toner density is affected by such variables as room 
humidity and service settings; it also tends to drift over time. Regular measurement 
detects day-to-day variations in densities, and calibration corrects for them.

Calibration works by creating calibration curves on the Fiery X2 that compensate for 
the difference between actual and desired density values. 

Calibration curves and target curves are the graphic equivalent of transfer functions, 
which are mathematical descriptions of changes that will be made to the data you start 
with. Transfer functions are often graphed as Input/Output curves.

Target curves (targets, for short) result from applying one or more transfer functions in 
sequence. The server generates calibration curves after comparing measured values to 
the final target values for each of the four toner colors.

Measurements

Measurements files contain numerical values that correspond to the toner density 
produced by the copier when it prints solid cyan, magenta, yellow, and black, and 
graduated tints of those colors.

To create a measurements file, you first print a page of color patches from the Control 
Panel or from Fiery Print Calibrator to the copier. Then you measure the patches, 
using either the copier’s scanner or an X-Rite DTP32 densitometer connected to a 
computer on the network. The new measurements are automatically downloaded to 
the Fiery X2.

You can print a calibration Comparison Page showing the result of using the new 
measurements with any of the current targets. When you are satisfied with a particular 
combination of measurements and target, you apply the calibration to the Fiery X2; 
this becomes the new resident calibration. 
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NOTE: You might also be able to create measurements with a different brand Status T 
densitometer if the densitometer manufacturer provides utility software to create a 
measurements file.

Targets

Target files define desired calibration results. Two target files are provided with the 
Fiery X2. You can create additional ones by modifying existing targets with Fiery Print 
Calibrator. When you calibrate the Fiery X2, you can select the target file that 
corresponds to the typical printing goals at your site. This becomes the resident 
calibration target that is used by default.

The calibration targets provided with the Fiery X2 are:

• 5750, 5790, or 5799—Optimized for best results with the copier.

• Linear—Results in output that divides the maximum measured density for each 
color into equal density steps to provide an even distribution of tones over the 
copier’s density range. When you linearize the printer, the entire measured density 
range in each color channel is divided into equal steps. Equal steps in toner 
percentage, such as 0%, 10%, and 20%, are printed in equal steps in density, and 
appear as roughly equal visual steps. This gives a linear response using the range of 
densities available.

You can store targets on the computer where you use Fiery Print Calibrator, on another 
connected disk, or on the Fiery X2 disk (or all three). 

Scheduling calibration
In general, you should calibrate the Fiery X2 at least once a day, depending on the 
volume of print jobs. If it is very important to maintain consistent colors, or if the 
copier is subject to wide fluctuations in temperature or humidity, calibrate every few 
hours. Calibrate when you change paper stock. In general, to get the best performance 
from the copier, calibrate whenever there is a noticeable change in print quality.

If you need to split a print job into two or more batches, it is especially important to 
calibrate before printing each batch.
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You should also calibrate the Fiery X2 system after copier maintenance. However, 
because the copier may be less stable immediately after maintenance, wait until you 
have printed approximately 50 pages before you calibrate.

NOTE: Output from the copier is very sensitive to changes in temperature and 
humidity. To minimize these effects, the copier should not be installed near a window 
or in direct sunlight, or near a heater or air conditioner. Paper is sensitive to climate 
changes as well, and should be stored in a cool, stable environment.

The copier has a self-calibration feature (Automatic Gradation Adjustment, or AGA) 
that optimizes toner densities after scanning two test prints on the copier glass. The 
copier has a self-calibration feature that optimizes toner densities. If you never calibrate 
the Fiery X2 from Fiery Print Calibrator or from the Control Panel, the self-calibration 
feature can improve the color output of print jobs. Using the copier’s self-calibration 
feature alone will not necessarily bring output densities from the copier to the optimal 
values for Fiery X2 printing. However, if you regularly calibrate the Fiery X2, your 
print jobs can sometimes be improved by asking a service technician to disable the 
copier’s self-calibration feature.

The copier allows you to adjust printed color from its touch panel display. You can 
typically increase or decrease toner density for one or all toner colors. These control 
panel settings affect copies made from the copier glass, and may affect Fiery X2 output 
as well. If they do, make sure these settings remain the same (preferably at a neutral 
position) prior to calibration, and from one print job to the next. If you change these 
settings, calibrate the Fiery X2 when you have finished changing settings.

Print some standard color pages such as the Color Charts from the Control Panel and 
the Color Reference pages included with the user software (see Getting Started). All of 
these pages include fully saturated color patches and pale tints of cyan, magenta, 
yellow, and black. Images with skin tones offer a very good basis for comparison. You 
can save and compare pages you printed at different times. If there is a noticeable 
change in appearance, you should calibrate or linearize the Fiery X2 system.

If the solid density patches (100% cyan, magenta, yellow or black) look less saturated 
with time, show the pages to the copier technician to find out whether adjusting the 
copier can improve the output.
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Checking calibration status
You can check whether the Fiery X2 is calibrated, what target was used, and when the 
printer was last calibrated. You can view information about the last calibration:

• By printing a Configuration page or Test Page from the Control Panel.

• With Fiery Print Calibrator, by choosing Server Status from the Server menu (see 
page 8-13).

Calibrating with AutoCal from the Control Panel
You can calibrate the Fiery X2 from the Control Panel using AutoCal, which calibrates 
the Fiery X2 using the copier’s built-in scanner as a densitometer. If an Administrator 
password has been set, you will need it for calibration.

For instructions on using the Fiery X2 Control Panel, and for more details on the 
AutoCal options, see the Administrator Guide.

For information on error messages you may see during the AutoCal procedure, see 
“AutoCal error messages” on page C-10.

NOTE: To calibrate using AutoCal, you will need the Kodak Gray Scale strip that came 
in the media pack with your Fiery X2.

TO ACCESS AND USE AUTOCAL:

1. Reboot the Fiery X2, and be ready to press a button at the Control Panel shortly after 
startup diagnostics.

2. Press any key when the Fiery X2 message “For software update or setup, press any 
key.” appears.

3. Choose Calibration, and choose Set Up Calibration.

4. For Tray, choose the paper source for the patch page.

LTR/A4 prints 21 patches per color; 11x17/A3 prints 34 patches per color.

5. Choose Calibrate.

The Select Target screen appears.
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6. Select the target.

You can choose from the list of all targets on the Fiery X2. This includes the targets 
included with the Fiery X2 and any custom targets you have created with Fiery Print 
Calibrator.

7. When prompted, select Yes to print the measurement page.

This page is comprised of swatches of color that will be measured by the copier and 
then compared to the target color values.

After the page is printed, the Measure Page screen is displayed.

8. Select Yes in the Measure Page screen.

9. When prompted on the Control Panel, place the Kodak Gray Scale strip face down along 
the top of the copier glass.

10. Place the color measurement page face down over the grayscale strip. 

Align the top-left corners of the grayscale strip and the color measurement page with 
the arrow at the top-left corner of the copier glass.

Make sure the patches on the grayscale strip do not overlap the color patches.

11. Close the copier lid, being careful not to move the grayscale strip and color 
measurement page.

12. Click OK.

Status messages display the progress of scanning and calculating measurements.

13. When prompted to Print Comparison Page, select Yes.

This page provides you with a preview of the selected calibration.

14. When prompted to overwrite calibration, select Yes.

�� ��@@��ÀÀ��@@��ÀÀ��@@��ÀÀ��@@��ÀÀ����@@��ÀÀ��@@��ÀÀ��@@��ÀÀ��@@��ÀÀ�� Place color measurement page face
down over grayscale strip

Place grayscale strip 
face down
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15. Select Yes to confirm.

Status messages display progress information. The new calibration becomes the 
resident calibration.

16. When calibration is complete, choose Exit Calibration. 

This automatically restarts the Fiery X2.

Removing calibration
It is also possible to remove calibration from the Fiery X2. In general, it is not 
necessary because any new calibration replaces the existing one. 

TO REMOVE CALIBRATION FROM THE CONTROL PANEL:

1. From the Control Panel, access the Calibration menu as described on page 8-6.

2. Choose Remove Calibration.

3. When prompted, verify that you want to proceed with removing calibration.

The current calibration curves are removed, and a default calibration is restored.

Calibrating with Fiery Print Calibrator
Fiery Print Calibrator allows you to calibrate from a computer networked to the 
Fiery X2. You can calibrate to targets provided with the Fiery X2 as described in this 
chapter, or you can customize targets and calibration curves to suit the specific needs of 
your printing environment as described in Chapter 9.

Using a densitometer
Fiery Print Calibrator is designed to work with the X-Rite DTP32 reflection 
densitometer so that color measurements are entered automatically. Before you 
calibrate the Fiery X2, you need to connect, configure, and calibrate the densitometer 
to prepare for measuring the printed patches (see “Calibrating the densitometer” on 
page 8-21). For additional information about setting up and using the densitometer, 
see the documentation included with it. 
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TO CONNECT THE X-RITE DTP32 TO THE COMPUTER:

1. Turn off the computer.

2. Plug the square end of the interface cable (like a modular phone plug) into the I/O 
port on the side of the X-Rite DTP32.

3. Attach the connector to the computer.

For a Windows computer, attach the 9-pin connector to the COM1 or COM2 port on 
the computer and tighten the screws. 

For a Mac OS computer, use the Macintosh interface cable to connect the 8-pin DIN 
plug to the printer or modem port of the computer.

Square connector

Square connector

Unused connector

Connect to COM port

Connect to keyboard port

Interface cable
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Connect the 4-pin DIN plug to an ADB port of the Mac OS computer.

4. Use the optional AC adapter (available from X-Rite) to provide power.

Plug the small connector on the adapter cable into the side of the X-Rite DTP32 and 
plug the adapter into a wall outlet.

5. Turn on the computer.

6. Calibrate the densitometer (see page 8-21).

7. Use Fiery Print Calibrator to calibrate the Fiery X2 (see the next section).

ADB port on Mac OS 
computer

Modem port

ADB port

Modem port

AC adapter

Small connector
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TO USE FIERY PRINT CALIBRATOR:

1. Start Fiery Print Calibrator and connect to the server you want to calibrate.

To calibrate a different Fiery X2, choose Open from the File menu.

For instructions on configuring the connection to the Fiery X2 from a Windows 
computer, see Getting Started.

2. If this is the first time you are calibrating, you are prompted to select a target. 

The first time you use Fiery Print Calibrator, you see only the targets provided with the 
Fiery X2. You can store additional targets on the Fiery X2 and on your computer. You 
can designate any target stored on the Fiery X2 as the resident target.

The initial default target is the copier target; it is the one with the copier device name 
(5750, 5790, or 5799).

3. Select a target and click OK.

The target you choose becomes the default target. The target can be changed 
independently of your measurements.
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The Calibration Mode window
The Calibration Mode window of Fiery Print Calibrator has large buttons which 
indicate the sequence for the main Fiery Print Calibrator functions. There is a menu 
bar with File, Edit, Measurements, Server, and Window menus, and a status message at 
the bottom of the window. The functions that are unavailable at any particular time are 
dimmed and cannot be selected. 

The buttons and their actions are:

• View Measurements—Displays a table of density values in the current measurements 
file. Below the button is the date of the active measurements.

• Select Target—Allows you to select a new target for calibration or for customizing. 
Below the button is the name and creation date of the currently selected target. This 
target is not necessarily the resident calibration target used by the Fiery X2.

• Edit Calibration—Allows you to view the current measured and target curves and 
customize the selected target.

• Test Calibration—Prints a page so that you can view the results of calibration before 
updating the resident calibration on the Fiery X2.

• Apply Calibration—Updates the resident calibration on the Fiery X2.

In order to Apply Calibration to the Fiery X2, you must have a Measurements file 
and a Target.
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To view current calibration information, choose Server Status from the Server menu.

If the Fiery X2 is calibrated, the Server Status dialog displays the user name or login 
name of the person who last calibrated the Fiery X2, the name of the current Fiery X2, 
the date and time of the current measurement file, the name of the resident calibration 
target, and the date and time of the most recent calibration.

Measurements
Measurements files provide toner values that correspond to standard color patches. 
Typically, you measure a page of patches with a densitometer and the measurements 
are loaded on the Fiery X2.

The creation date and time of the current measurements file appears below the 
Measurements button in the Calibration Mode window. 

NOTE: For demonstration purposes only, if you do not have a measurements file, 
you can use the DEMO.MEA file on the User Software CD. This file should not be used 
to calibrate the Fiery X2.
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Measuring values with a DTP32 densitometer
To create a measurements file you print a patch page and feed it into the densitometer. 
The densitometer scans the density of the patches on the page and automatically 
transmits the measured values to Fiery Print Calibrator. 

After each column of patches is scanned, you move the page to scan another column. 
The DTP32 densitometer has an adjustable strip guide to the right of the strip 
entrance. The density measurements are used to create a Measurements file. In general, 
valid measurements for all patches fall within the range of 0 to 3.05. Values between 
-0.01 and +0.005 are shown in Fiery Print Calibrator as 0. Values that appear in the 
Measurements window as negative numbers might indicate a problem with the 
densitometer.

TO PRINT PATCHES FOR MEASUREMENT:

1. From the Calibration Mode window, choose Print Patch Page from the Measurements 
menu.

2. Select a page size and paper tray.

Letter/A4 prints 21 patches per color; 11x17/A3 prints 34 patches per color.

The Fiery X2 downloads the patch page to the copier. The patch page has four 
columns of progressively less saturated tints of each process color.

TO PRINT SPECIAL PATCHES FOR CALIBRATING:

• With Fiery Downloader for Windows, download either Custom21.ps or Standard21.ps 
(21 patches); or Custom34.ps or Standard34.ps (34 patches) from the Color Files:
Calibration folder on the User Software CD.

With Fiery Downloader for Mac OS, download either Custom21.ps or Stand21.ps (21 
patches); or Custom34.ps or Stand34.ps (34 patches) from the Clrfiles\Calibrat folder 
on the User Software CD.
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These files are PostScript measurements files. Custom21.ps and Custom34.ps are 
provided to enable you to download measurement patches that incorporate the copier’s 
current calibration set, while Standard21.ps and Standard34.ps are provided to enable 
you to download standard measurement patches that ignore the copier’s current 
calibration set. These files are provided for expert users and should not be used for 
day-to-day calibration.

TO MEASURE CALIBRATION PATCHES WITH AN X-RITE DTP32: 

1. Make sure your X-Rite DTP32 is connected (page 8-8) and calibrated (page 8-21).

2. Choose Densitometer from the Measurements menu.

3. Select the page size that matches the patch page you printed.

The Long page size has more patches with more finely distinguished color gradations.

4. In the Select densitometer port pop-up menu, choose the port with the densitometer 
interface cable.

If the densitometer screen does not display MAIN MENU, for example after calibrating 
the densitometer, press the two MENU buttons at the same time.

5. Click Start.

6. Follow the on-screen instructions to measure patches.
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7. When prompted, position the pointer on the strip guide to 15.

The first column you’ll measure is the cyan column.

8. With the arrow above the cyan column pointing towards the densitometer, align the 
right side of the patch page with the strip guide.

9. Insert the patch page into the densitometer until it rests against the drive rollers and 
the motor is activated.

There may be a slight hesitation before the rollers start.

10. Hold the page against the guide to prevent any skewing while the strip is being 
measured.

After the strip is measured, Pass #1 of 1 OK! appears in the densitometer display. 
Transmitting Data appears briefly after each pass.

11. When prompted (onscreen and on the densitometer), move the strip guide to 30 and 
feed the patch page to measure the magenta column.

After the magenta strip is measured, Pass #1 of 1 OK! appears in the densitometer 
display.
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12. Turn the patch page around so that the arrow above the yellow column is pointing 
toward the densitometer.

Leave the strip guide set to 30.

13. When prompted, align the right side of the patch page with the strip guide and 
measure the yellow column.

After the yellow strip is measured, Pass #1 of 1 OK! appears in the densitometer display.

14. When prompted, move the page guide to 15 and measure the black column.

After the black strip is measured, Pass #1 of 1 OK! appears in the densitometer display.

NOTE: If there is a problem measuring a color, follow the instructions on the 
densitometer to remeasure it.

15. When all four columns have been measured, click Accept in the Densitometer window.

The Densitometer window closes; the date beneath the Measurements button is 
updated to the current date because the measurements have been saved to the 
Fiery X2.

TO SAVE THE MEASUREMENTS FILE:

• Choose Export from the Measurements menu to save the measurements file to your 
computer hard disk.

If you save the measurements file to your hard disk, use it only as a backup for your 
own reference. You can import this file later without having to remeasure, but this is 
usually not recommended. For optimal calibration, use a new measurements file based 
on current densitometer values.

For your information, exported measurements files are tab-delimited ASCII files that 
you can open in a word processing, spreadsheet, or database program.
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TO VIEW STORED MEASUREMENT VALUES:

• Click the View Measurements button to view values in the current measurements file. 

Fiery Print Calibrator displays the current measurements on the Fiery X2. They are the 
measurements that were stored on the Fiery X2 when you last clicked Accept.

Testing and applying calibration
You can view a sample calibration before applying it to the Fiery X2 as the resident 
calibration. Since the measurements have already been updated, you are actually 
checking the combination of your measurements with one or more targets.

You can use the Comparison Page provided with the Fiery X2 to test a calibration 
before applying it. This page shows a comparison of uncalibrated and calibrated data. 

The Comparison Page provides the following calibration information:

RGB using Color Rendering Dictionary section

• Name—the name of the Fiery X2 defined in Setup

• Model—the Fiery X2 model name and copier model

• Target—the currently selected target in Fiery Print Calibrator, not necessarily the 
target for resident calibration on the Fiery X2
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• Measurements—how measurements were obtained

• Rendering Style—the default rendering style specified in Setup

• Date & Time—when the Comparison Page was printed

For a description of the information in the section of the page labeled “Press CMYK 
using Simulation” see page 9-18.

You can also create your own comparison page. To do this, create a PostScript or an 
EPS (Encapsulated PostScript) file and name it Calib.eps. Use Fiery Downloader to 
download the Calib.eps file to the Hold queue of the Fiery X2.

TO TEST AND APPLY CALIBRATION:

1. Click Test Calibration in the Calibration Mode window.

2. Select a page, choose a paper tray, and click Print.

3. If you are satisfied with colors on the printed page, click Apply Calibration, and click 
Continue to update the resident calibration.

Alternatively, if you are not ready to apply the calibration, you can print a Comparison 
Page with a different target or saved measurements file. 

4. Select the target or measurements file, and click the Test button.

5. When you have finished working with Fiery Print Calibrator, choose Exit (Windows) or 
Quit (Mac OS) from the File menu.
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Calibration checklist
Once you have calibrated the Fiery X2 and, if necessary, adjusted your target to get 
satisfactory output, calibrating again is just a matter of taking new color measurements 
and applying them to the current target. A summary of the steps follows.

Prepare the densitometer

Connect and configure the densitometer.

If color is critical, calibrate the densitometer. Otherwise, wait until the densitometer 
prompts you to do so.

Use Fiery Print Calibrator

Start Fiery Print Calibrator.

Check the target indicated in the main window. This is your current target.

Choose Print Patch Page from the Measurements menu.

Choose Densitometer from the Measurements menu.

Choose the densitometer port and click Start.

Pick up the patch page from the copier and feed it into the densitometer, following the 
prompts in the Densitometer dialog box on the Fiery Print Calibrator screen.

When you have measured all four colors, click Accept in the Densitometer dialog box.

Check the results

Click Test in the main window to print a calibration Test Page.

Compare the calibrated and uncalibrated color. If the result of using the new 
measurements is satisfactory, click Apply Calibration. If not, either measure again or 
edit the target, and test once more before clicking Apply Calibration.

Click OK in the confirmation dialog boxes and close Fiery Print Calibrator.
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Calibrating the densitometer
You will need the black-and-white Auto-Cal strip included with the densitometer. 
Calibrating the densitometer does not require Fiery Print Calibrator.

TO CALIBRATE THE X-RITE DTP32:

1. Connect the densitometer to the computer and supply power (see page 8-8).

2. On the X-Rite DTP32, simultaneously press the two buttons marked MENU.

The words MAIN MENU appear in the display.

3. Press the p1 key until p2 appears.

4. Press the cal key.

CALIBRATION appears in the display.

5. Press the den key.

CALIBRATING TRANSMISSION is displayed, followed by the words INSERT CAL STRIP.

6. Position the strip guide at 5.

7. Insert the arrow end of the Auto-Cal strip into the entrance of the X-Rite DTP32 until 
the roller starts pulling the strip.

READING appears momentarily, followed by the density values and CALIBRATION OK.

If UNRECOGNIZABLE STRIP appears, try cleaning the strip (see the X-Rite DTP32 
Operating Manual).

8. Start Fiery Print Calibrator and proceed to calibrate the Fiery X2 (see page 8-14). 

Recalibrate the densitometer at least once month. For critical color, calibrate the 
densitometer every time you calibrate the Fiery X2.

Strip guide
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This chapter describes advanced features of Fiery Print Calibrator, including 
customizing calibration and simulation targets. For introductory information about 
Fiery Print Calibrator and for instructions on performing calibration, see Chapter 8. 
For information on the simulation capabilities of the Fiery X2, see Appendix A.

The Fiery Print Calibrator procedures described in these chapters are fundamentally 
the same for Mac OS and Windows computers. The main differences are the interface 
cable and the port used to connect to the densitometer. The term computer is used to 
refer to any computer running Fiery Print Calibrator.

The following section describes the advanced calibration features of Fiery Print 
Calibrator. For information on working with simulations, see “Using advanced 
simulation features” on page 9-10.

Using advanced calibration features
Fiery Print Calibrator offers additional flexibility for advanced users. You can:

• Use a different measurements file stored on your computer

• Select a different target when your printing goals change

• Edit an existing target to suit your needs, test it, save it as a custom target, and save it 
on the Fiery X2

• Save measurements as a target

• Back up the targets that are stored on the server

• Remove targets from the server

Choosing a measurements file
Although you can import a saved measurements file, the measurement file you use 
should reflect the current color behavior of the copier. Therefore, import saved 
measurements only if you have reason to doubt your current measurements, or if you 
don’t have access to a densitometer. You cannot edit measurement values with Fiery 
Print Calibrator.

Chapter 9:
Advanced Fiery 
Print Calibrator 
Topics
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NOTE: The measurements file is copied to the server as soon as you load a new one. It is 
also copied as soon as you accept new measurements in the Densitometer dialog box 
(see Chapter 8).

Any measurement accepted or imported into Fiery Print Calibrator automatically 
becomes the measurements file for the connected Fiery X2. This measurements file is 
used to create the resident calibration as well as all the other calibrations stored on the 
Fiery X2.

NOTE: You should view or back up the current measurements before changing them.

TO USE A MEASUREMENTS FILE:

1. To view the density values in the current measurements file, click the Measurements 
button.

2. To back up the measurements, choose Export from the Measurements menu and enter a 
descriptive name.

3. To use a different stored measurements file, choose Import from the Measurements 
menu and select a saved measurements file from your computer.

Working with targets
Target files provided with the Fiery X2 contain desired calibration goals. Select the 
target file that corresponds to the type of printing done at your site.

You can view your current measurements and compare them with the current target. 
You can also edit the target file and save the changes as a new target file. This allows 
you to fine-tune the calibration on the Fiery X2 to meet your exact specifications.

Custom targets are always based on an existing target. Select the target to use as a base 
for the custom target on a target. In most cases, you’ll use the copier target (5750, 
5790, or 5799).
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The target for the resident calibration can be either of the provided targets, or a custom 
target with any name. (Instructions for creating custom targets are provided later in 
this chapter.) Select a target to use for the resident calibration, and click Apply 
Calibration. 

You can test calibrations by comparing calibrated and uncalibrated image data on the 
Comparison Page, which uses both CMYK and RGB images. You can also create a 
custom comparison page as described on page 8-19.

Comparing the measured and target curves

Before editing a target curve, compare it to the current measured curve. By doing so, 
you can determine how close the measured color densities are to the target densities. 
The closer the measured densities are to the target densities, the better the results you 
get from calibration. 

NOTE: Large differences between the standard copier target and measured curves may 
mean that the copier needs servicing.

TO COMPARE THE MEASURED CURVE AND THE CURRENT TARGET CURVE:

1. Start Fiery Print Calibrator and select a target from the list of available target files.

The targets in this list are stored on the Fiery X2. Alternatively, click Local to use a 
target stored on your computer.

2. Click OK.
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3. Click the Edit Calibration button in the Calibration Mode window.

4. Select Target/Measured and turn on the Measured option in the View Curves region.

These curves represent the values in the measurements file and cannot be changed.

5. Turn on the Target option and compare the target curve (thick lines) to the measured 
curve (thin lines).

Turn on Measured

Select Target/Measured

Turn on Target
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Customizing calibration targets
The copier’s calibration target provided with the Fiery X2 should be used for general 
printing purposes. You may, however, have special printing needs that require a custom 
calibration. In this case, you can use Fiery Print Calibrator to edit an existing 
calibration target and save it as a custom target.

The Edit Calibration window provides information about your current target and 
measurements in graphic form and lets you edit curves and values to create a new 
target. 

NOTE: All changes are stored as you make them. To discard changes, reload the target 
from the server or your computer.

The graph on the left side of the window allows you to view and manipulate color 
output values. The View Channels check boxes (beneath the graph) and the View 
Curves areas (to the right of the graph) specify the curves displayed on the graph.

You can change several components of a target. The changes are accumulated in the 
custom target that you eventually save. You can:

• Change the maximum density (Dmax). 

An adjusted target is created with the new maximum density.
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Independently, you can:

• Adjust brightness

• Adjust dot gain for more saturated output without affecting the overall color balance

• Load a custom curve and edit points in the curve

The current custom curve is applied to the original target curve or, if you adjusted 
the Dmax, it is applied to the target with the new maximum density.

• By clicking Save, save a copy of the edited target to your computer

• Choose Apply Calibration when you are ready to update the resident calibration on 
the Fiery X2

NOTE: The values in the following illustrations do not represent standard values. They 
are intentionally exaggerated for example purposes.

TO ADJUST MAXIMUM DENSITY (DMAX):

1. Select the target to edit (see page 8-11).

2. Click the Edit Calibration button.

3. In the View Curves area, click Target/Measured and Target.

4. For each color, enter a value in the Maximum Density areas, and press Tab or Enter to 
adjust the endpoint of the target curve as needed.

You can enter a value from 0.1 to 3.0.

The rest of the curve adjusts to make a smooth transition to the new endpoint. The 
adjusted target is stored. To discard changes, reload the target from the server or from 
the local disk.

TO CUSTOMIZE A TARGET:

1. Select the target to edit (see page 8-11).

2. Click the Edit Calibration button.
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3. In the View Curves area, click Custom to edit the input/output curve.

The graph maps input ink percentage to output ink percentage by analogy to ink on a 
press. Initially, the graph is a 45° straight line; that is, input values equal output values. 
This is the starting place for your editing.

As you make changes, you either increase or decrease the amount of toner that will be 
used to render a certain percentage tone. An ink density of 100% is a fully saturated 
color; 0 to 5% is a highlight color. 

4. In the View Channels area, select the channels to edit.

You can view information for all four colors at the same time (cyan, magenta, yellow, 
and black), or any combination of these. Working with only one or two colors at a 
time helps you to distinguish the curves and to fine-tune your adjustments, especially 
when using a monochrome monitor.

5. In the “Apply setting to” menu, choose the channel to adjust in the 
Lightness/Darkness area of the window.

6. Use the Brightness menu to adjust brightness as needed.
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7. Adjust the dot gain as needed.

These values are used independently of the Brightness curve. Changing the values for 
dot gain can give more saturated color output without affecting the overall color 
balance. The dot gain values simulate dot gain, not compensate for dot gain.

You can choose either the North American or European standard and then enter the 
desired Dot Gain. The valid values for North American gain at 50% input are 0% to 
50% output. The valid values for European gain at 40% input must be less than the 
80% input setting plus 40%; the valid values for European at 80% input are 0% to 
20% gain on output.

If you use Dot Gain values, the curve will be smoothed so that there are no spikes or 
jumps in output value.

NOTE: You should measure this value from actual press output, using a densitometer.

8. In the graph, drag points to adjust the curve as needed.

The graph maps input percentage to output percentage in 10% increments. Points 
along the curve are marked so that you can adjust them.

NOTE: You should adjust points in this way after you have applied a brightness or dot 
gain curve. If you attempt to change a brightness or dot gain setting after you have 
adjusted the points on the graph, your earlier changes are not registered.
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9. You can test the changes now by using the Test Calibration button in the Calibration 
Mode window, or customize the target further.

If you edit a local target file, you are prompted to save it on the Fiery X2 before 
calibration can be changed. 

NOTE: You cannot use the name of an existing target.

10. Enter a name for the edited target file and click Save.

11. To save the target on your computer, click Save (in the Edit Calibration window) and 
enter a name for the new target.

You can use a saved target again or continue editing it later.

Backing up Fiery X2 targets
If you think you may need a target later, you can back up targets to save the target to 
your computer before you delete it from the Fiery X2. You should always save targets 
before updating Fiery X2 system software to ensure that no custom targets are lost.

TO BACK UP TARGETS:

• Choose Back Up Targets from the Server menu.

This copies the target files from the Fiery X2 to your computer. 
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Deleting custom targets
If desired, you can delete custom targets permanently from the Fiery X2. You may 
want to do this to make sure no one applies a calibration using the wrong target file. 
You cannot delete the original targets (5750, 5790, 5799, and Linear). 

TO DELETE CUSTOM TARGETS FROM THE FIERY X2 HARD DISK:

1. Start Fiery Print Calibrator.

2. Choose Delete Target from the Server menu. 

3. Select the target and click OK.

NOTE: Deleting the target used for the resident calibration does not affect the resident 
calibration. To delete a calibration based on a deleted target, you must apply another 
calibration that uses a different target, or remove calibration as described in the next 
section.

Removing calibration
If desired, you can remove calibration from the Fiery X2. When you remove 
calibration, the resident calibration curves are removed, and a default calibration is 
restored.

TO REMOVE CALIBRATION:

1. Choose Remove Calibration from the Server menu.

2. When prompted, confirm that you want to remove calibration.

Using advanced simulation features
Fiery Print Calibrator offers simulation features for advanced users. You can:

• Change the default simulation on the Fiery X2

• Edit an existing simulation to suit your needs, test it, save it as a custom simulation, 
and save it on the Fiery X2

• Back up the simulations that are stored on the server

• Remove simulations from the server
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Working with simulations
Simulations, or press simulations, allow you to use the copier as a proofing device for 
jobs that will print on an offset press. Because the range of colors available on the 
copier is different from that of a press, the Fiery X2 automatically adjusts the color so 
that the output falls within the range of colors a press can produce.

Several simulations are provided with the Fiery X2, and you can create additional ones 
by editing existing simulations with Fiery Print Calibrator. A default simulation target 
is specified by the administrator in Setup. You can change the default simulation using 
Fiery Print Calibrator.

The simulations provided with the Fiery X2 are:

• DIC—Japanese press standard

• Euroscale—European press standard

• SWOP-Coated—US press standard

• Match Copy—Bypasses calibration and produces output that matches a copy made 
from the copier glass

Each of the press simulations has both a Quick and Full version. These versions 
correspond to the method of mapping colors from your copier’s color gamut to that of 
the desired press standard as follows:

• Quick—Compensates for only density (one-dimensional mapping)

• Full—Corrects for hue as well as density (four-dimensional mapping)

The PPD for the Fiery X2 provides placeholders for five custom simulations named 
Custom-1, Custom-2, and so on. These can be made available for users to select from 
the CMYK Simulation print option when printing a job.
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You can store targets on the computer where you use Fiery Print Calibrator, on another 
connected disk, or on the Fiery X2 disk (or all three). However, only the original 
simulations and five custom simulations are available to users who choose a simulation 
on a job-by-job basis (with the CMYK Simulation print option).

For a custom simulation intended to be available only as a CMYK Simulation setting 
in Setup, any name can be used. For a custom simulation intended to be available for 
users to choose on a job-by-job basis, the name must be “Custom-1”, “Custom-2”, and 
so on. 

NOTE: The custom simulation names “Custom-1” and “Custom-2” appear in the users’ 
CMYK Simulation settings, and users can choose them, whether or not the 
corresponding custom options have been created and loaded on the Fiery X2. Jobs 
printed with a non-existent custom simulation fail printing and show an error. 

For more information on the CMYK Simulation and CMYK Simulation Method 
print options, see Appendix A.

Using the Simulation Mode window
After starting Fiery Print Calibrator, choose Simulation Mode from the File menu. The 
Simulation Mode window has buttons for the most frequently used Fiery Print 
Calibrator functions. There is also a menu bar with File, Edit, Measurements, Server, 
and Window menus, and a status message at the bottom of the window. Functions 
unavailable at any particular time are dimmed and cannot be selected. 
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The buttons and their functions are:

• Select Simulation—Allows you to select a simulation to work with. You must select a 
simulation before editing or applying it to the Fiery X2. Below the button are the 
name and creation date of the currently selected simulation, which is not necessarily 
the default simulation on the Fiery X2.

• Edit Simulation—Allows you to view and customize the current simulation.

• Test Simulation—Prints a test page so that you can view the results of the simulation 
you are currently working with.

• Set Default Simulation—Updates the default simulation on the Fiery X2.

Checking the current simulation
You can use Fiery Print Calibrator to see the simulation currently selected as the 
default on the Fiery X2.

TO VIEW INFORMATION ABOUT THE CURRENT SIMULATION: 

1. Start Fiery Print Calibrator and connect to the Fiery X2.

2. Choose Server Status from the Server menu.

The bottom section of the Server Status window displays the default simulation.
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Editing simulations
You can edit a press simulation to meet your exact specifications. You can also save the 
changes as a new simulation.

NOTE: The values in the following illustrations do not represent standard values. They 
are intentionally exaggerated for example purposes.

TO EDIT A SIMULATION:

1. Start Fiery Print Calibrator and connect to the Fiery X2.

2. Choose Simulation Mode from the File menu.

3. Click the Select Simulation button.

A dialog box displays the simulations available on the Fiery X2.

4. Select a simulation and click OK.

Click Local to select a simulation on your computer.
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5. Click the Edit Simulation button.

You can use this dialog box to view or to edit simulations.

6. In the View Channels area, select the channels to edit.

You can view information for all four colors at the same time (cyan, magenta, yellow, 
and black), or any combination of these. Working with only one or two colors at a 
time helps you to distinguish the curves and to fine-tune your adjustments, especially 
when using a monochrome monitor.

7. For each color, enter a value in the Maximum Density areas and then press Tab or Enter 
to adjust the endpoint of the target curve as needed.

You can enter a value from 0.1 to 3.0.

The rest of the curve adjusts to make a smooth transition to the new endpoint. The 
adjusted target is stored. To discard changes, reload the target from the server or from 
the local disk.

8. From the “Apply setting to” menu, choose the channel to adjust in the 
Lightness/Darkness area of the window.

Select channels
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9. Use the Brightness menu to adjust brightness as needed.

NOTE: If you change a value for a color with the Brightness menu, it overrides values 
set elsewhere in the dialog box.

10. Adjust the Dot Gain value as needed.

You can choose either the North American or European standard and then enter the 
desired Dot Gain. The valid values for North American gain at 50% input are 0% to 
50% output. The valid values for European gain at 40% input must be less than the 
80% input setting plus 40%; the valid values for European at 80% input are 0% to 
20% gain on output.

If you use Dot Gain values, the curve is smoothed so that there are no spikes or jumps 
in output value.

11. In the graph, click and drag points to adjust the curve as needed.

The graph maps input percentage to output percentage in 10% increments. The points 
along the curve are marked so that you can adjust them.

NOTE: You should adjust points on the curves after you have entered values in the other 
areas of the window. If you change values after you have adjusted the curve on the 
graph, values might not be valid.

12. When you are finished, click Save and enter a name for the new simulation.

This saves the simulation to Fiery X2. Use Local to save the simulation to your 
computer hard disk so that you can use it again or continue editing it later.

• Give the simulation a new name. You cannot overwrite the name of an original press 
target.

• Include part of the original name in the new name, for example, “SWOP-New.” 
This helps you remember what the new simulation is based on. 

• To allow users to print with the simulation on a job-by-job basis, you must use the 
exact names “Custom-1”, “Custom-2”, and so on. Give users a description of the 
custom simulations because they see only the “Custom” names from the printer 
driver interface. 

NOTE: If custom simulations are later deleted from the server, users might still select 
them when they print. However, jobs printed with non-existent custom simulations 
will fail printing and report an error.
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Managing simulations
With Fiery Print Calibrator, you can back up and delete simulations. You can also set 
the default simulation to None. 

TO BACK UP SIMULATIONS:

• Choose Backup Simulations from the Server menu to copy the simulations from the 
Fiery X2 to your computer. 

Simulations are saved in a folder called Backup in the folder where Fiery Print 
Calibrator is located. You can save simulations for safekeeping. You should always save 
simulations before updating Fiery X2 system software to ensure that no custom 
simulations are lost.

TO DELETE CUSTOM SIMULATIONS FROM THE FIERY X2 HARD DISK:

1. Choose Delete Simulation from the Server menu. 

2. Select the custom simulation and click OK.

You can delete simulations to make sure no one uses the wrong simulation file. You 
should always use the Backup Targets command to save simulations before you delete 
them.

TO SET THE DEFAULT SIMULATION TO NONE:

1. Choose Set Default Simulation to None from the Server menu.

2. When prompted, confirm you want to reset the default.

Testing and setting a new default simulation
You can use the Comparison Page provided with the Fiery X2 to test a simulation 
before making it the default simulation on the Fiery X2. This page shows a comparison 
of images with and without simulation applied. 

The Comparison Page provides the following simulation information:
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Press CMYK using Simulation section

• Simulation—The currently selected simulation in Fiery Print Calibrator, not 
necessarily the default simulation on the Fiery X2.

• Method—Quick or Full. Quick corrects for only the density of colors (one-
dimensional mapping) to the press goal. Full corrects for both density and hue (four-
dimensional mapping).

• Press—The press standard for which the sample CMYK images were separated (for 
example, SWOP or Euroscale).

For a description of the information in the section of the page labeled “RGB using 
Color Rendering Dictionary,” see page 8-18.

You can also create your own comparison page. To do this, create a PostScript or EPS 
(Encapsulated PostScript) file and name it Calib.eps. Use Fiery Downloader to 
download the Calib.eps file to the Hold queue of the Fiery X2.

TO TEST AND APPLY A SIMULATION:

1. In the Simulation Mode window, click Test Simulation.

2. Select a page and choose a paper tray.
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3. Click Print.

4. When you have visually verified that the test page displays appropriate colors, click 
Set Default Simulation.

5. Select the simulation to set as the default.

The default simulation is used when users select the Printer’s Default setting for the 
CMYK Simulation print option. Users can choose a different simulation on a job-by-
job basis.
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Print options give you access to the special features of the copier and the Fiery X2. 
Print options can be specified in several places—in Fiery X2 Setup from the Control 
Panel or from Fiery WebSetup, from the printing application, from Fiery Downloader, 
and from Fiery WebSpooler or Fiery Spooler. The table in this appendix briefly 
describes each print option, gives its default setting, and provides information on any 
constraints or requirements in effect. 

Where to set print options
• During Setup (from the Control Panel or from Fiery WebSetup)

Some settings are specified during Setup by the administrator. To see the current 
default settings, print the Configuration page from the Fiery X2 Control Panel. 

• From applications

With the Adobe PostScript printer drivers (included in your user software) and the 
Windows NT 4.0 PostScript printer driver, you can specify and override job settings 
when you print a job. See Chapter 2, “Printing from Windows Computers” and 
Chapter 3, “Printing from Mac OS Computers” for information about specifying 
job settings from applications. 

NOTE: The job settings you specify can be overridden from Fiery WebSpooler or Fiery 
Spooler.

• From Fiery Downloader

Only a few settings—Page Range (for PDF files only), Copies, and Brightness—can 
be specified when printing jobs with Fiery Downloader. To change options in Fiery 
Downloader, select the job in the Files to be Downloaded (Windows) or Files to 
Download (Mac OS) list and click Options. For more information, see Chapter 6, 
“Downloading Files and Fonts”.

• Overrides from Fiery WebSpooler or Fiery Spooler

To change job settings from Fiery WebSpooler or Fiery Spooler, double-click a job to 
display the Override Print Settings dialog box. For more information, see Chapter 7, 
“Tracking and Managing Print Jobs.”

Appendix A: 
Print Options
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Print options and override hierarchy
In the following table, underlined settings in the “Option and settings” column 
indicate default printer driver settings (PPD defaults). The Printer’s Default setting 
indicates that a default has been specified in Fiery X2 Setup. To find out about the 
current Setup defaults, print the Configuration page from the Fiery X2 Control Panel.

The override hierarchy is as follows: 

• A user’s printer driver settings override the Fiery X2 Setup settings.

• Settings made from Fiery WebSpooler or Fiery Spooler override the user’s printer 
driver settings. 

Option and settings:
(Default setting is underlined)

Description:
Requirements, constraints, 

and information:

Black Overprint
Printer’s Default/Off/On

Select On to overprint black text on 
colored backgrounds. Select Off to cause 
black text to knock out colored 
backgrounds. 

If this option is set to On:
• The Pure Black Text/Graphics option 

is automatically set to On.
• The Combine Separations option 

must be set to Off.
• The Compression option must be set 

to On.

This option cannot be set to On when 
printing separations, only when printing 
composites.

See page A-6 for more information.

Brightness
85% Lightest/90% Lighter/
95% Light/100% Normal/105% Dark/
110% Darker/
115% Darkest

Select 85% for a substantially lighter 
image, 115% for a substantially darker 
image, or one of the settings in between.

CMYK Simulation
Printer’s Default/SWOP-Coated/DIC/
Euroscale/Custom-1/Custom-2/
Custom-3/Custom-4/Custom-5/None/
Match Copy

Select a CMYK simulation target to use 
for the job.

This print option affects CMYK 
data only. See page A-7 for more 
information.
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CMYK Simulation Method
Printer’s Default/Quick/Full

Select Quick to apply one-dimensional 
transfer curves that adjust output 
density. Select Full to apply four-
dimensional transfer curves that adjust 
hue as well as output density. 

This print option affects CMYK 
data only. See page A-7 for more 
information.

Color Mode
Printer’s Default/CMYK/Grayscale

Specify the color mode for the current 
print job. Select CMYK for a full-color 
document or Grayscale for a grayscale or 
black-and-white document.

Combine Separations
Printer’s Default/Off/On

When printing separations from a 
desktop publishing application:
Select On to combine separations on a 
single page. Select Off to view separations 
as four individual black-and-white pages, 
each representing one color plate.

See page A-8 for more information.

Compression
Printer’s Default/On/Off

Select Off to disable compression for 
printing very complex images. This 
requires a significant amount of memory 
to process and print; however, images 
print faster with the best possible image 
quality.

Select On to enable compression when 
printing multiple-page jobs that do not 
consist of complex pages.

.

Copier Mode
Printer’s Default/Photo/Map

Select Text Enhancement or Photo if the 
file is a photograph. Select Map if the file 
is a combination of text and 
photographs.

Copies
1 - 999

Specify the number of copies of the job 
to print.

Media Type (Paper Type)
Printer’s Default/Plain Paper/
Thick Paper 1/Transparency/
Interleaved/Coated Paper/Thick Paper 
2/Tacking Film/SST/Labels

Specify the type of media on which to 
print the job. Select Interleaved if you 
will be printing multiple transparencies 
with blank paper separators.

Available selections depend on copier 
type.

Option and settings:
(Default setting is underlined)

Description:
Requirements, constraints, 

and information:
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Notes 1 and Notes 2 Use one or both of these fields to enter 
special information about the job (see 
also Instructions).

The Notes 1 and Notes 2 fields each 
have a 32-character limit.

(Other) Gamma
Printer’s Default/1.0/1.2/1.4/1.6/1.8/
2.0/2.2/2.4/2.6/2.8/3.0

Specify a source gamma value for 
printing RGB images, objects, and text.

To enable this option, RGB Source must 
be set to Other.

See page A-10 for more information.

(Other) Phosphors
Printer’s Default/Hitachi EBU/
Hitachi-Ikegami/NTSC/Radius Pivot/
SMPTE/Trinitron

Specify a source monitor phosphors 
value for printing RGB images, objects, 
and text.

To enable this option, RGB Source must 
be set to Other.

See page A-10 for more information.

(Other) White Point
Printer’s Default/5000 K (D50)/5500 
K/6500 K (D65)/7500 K/9300 K

Specify a source white point value for 
printing RGB images, objects, and text.

To enable this option, RGB Source must 
be set to Other.

If you set this option to anything other 
than Printer’s Default, set the Rendering 
Style option to Solid Color for best 
results.

See page A-10 for more information.

Page Order
Printer’s Default/Forward/Reverse

Select Forward for front-to-back output 
or Reverse for back-to-front output.

Page Orientation
Portrait/Landscape

Specify the orientation of the document.

Page Range
All/Even/Odd/Range (1-3, 5, 7)

Specify which pages of the document to 
print. To print a contiguous page range, 
specify the first and last page numbers of 
the range separated by a hyphen. To 
print non-contiguous pages, specify the 
page numbers using commas as 
separators.

See page A-8 for more information.

Paper Size 
Letter/A4/11 x 17/A3/12x18/Legal/
Legal 13/B4/B5/A6/SEF Letter/
SEF A4/SEF B5/SEF 8x10/8x10/9x11/
9x12/Docupac

Specify the size of the paper on which to 
print the document. 

Available selections depend on copier 
type.

Option and settings:
(Default setting is underlined)

Description:
Requirements, constraints, 

and information:
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Paper Source
Auto Select/Tray 1/Tray 2/Tray 3/
Tray 4/Bypass Tray/

Specify the source for the media on 
which to print the job.

See page A-9 for more information.

Available selections depend on copier 
type.

Pure Black Text/Graphics
Printer’s Default/Off/On

Select Off to print black text and 
graphics as a four-color black using C, 
M, Y, and K toner, and to use normal 
PostScript rendering. Select On to print 
black text and graphics as one-color 
black using 100% black toner only.

This option is automatically set to On if 
the Black Overprint option is set to On.

If this option is set to On, Compression 
must be set to On.

This option’s On setting can be used 
only when printing composites, not 
when printing separations. 

See page A-9 for more information.

Rendering Style
Printer’s Default/Photographic/
Presentation/Solid Color

Specify a color rendering dictionary 
(CRD) to be used when you print RGB 
images, objects, and text. 

The Color Mode option must be set to 
CMYK. 

The Rendering Style option has no effect 
on CMYK data.

See page A-10 for more information.

RGB Source
Printer’s Default/EFIRGB/sRGB (PC)/
Apple Standard/Other/Off

Specify a source color space definition 
for printing RGB images, objects, and 
text.

See page A-10 for more information.

Scale
100%/200%/150%/75%/50%

Specify the percentage at which to print 
the job.

See page A-11 for more information.

Sharpness
Printer’s Default/Softer/Normal/
Sharper

Change the Sharpness setting to alter the 
results of a print. Select Sharper to make 
edges appear more defined; select Softer 
to make edges less defined.

Sorter Mode
Printer’s Default/Off/Collate/Sort

Specify whether or not to sort the job. If the Suspend Printing command is 
used during printing of a sort job, 
printing cannot be resumed—the job 
must be resent. 

Option and settings:
(Default setting is underlined)

Description:
Requirements, constraints, 

and information:
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More information about print options
The following sections provide additional information about print options. See the 
table above for information on the settings, requirements, and constraints in effect for 
these options.

Black Overprint

For documents containing black text on color backgrounds or graphics, the black text 
can be printed in one of two ways: either as part of the color background (“knocking 
out” the color background), or on top of (“overprinting”) the color background. The 
Black Overprint option lets you choose which way the black text will be printed.

• On—Black text overprints color backgrounds, eliminating any potential for halo 
effects or misregistration of colors, and creating a richer black.

• Off—Black text knocks out colored backgrounds.

Generally, the Black Overprint option should be set to On.

The Black Overprint option affects only black text defined in RGB as R0%, G0%, 
B0%, or in CMYK as C0%, M0%, Y0%, K100%. Because this option requires the 
presence of text defined as black, setting Black Overprint to On automatically sets the 
Pure Black Text/Graphics option to On.

Spot Color Matching
Printer’s Default/Off/On

Select Off to print specified PANTONE 
colors in your job using the current 
CMYK Simulation and CMYK 
Simulation Method. 

Select On to activate the Fiery X2 built-in 
PANTONE lookup tables to generate 
the closest CMYK matches of 
PANTONE library colors the copier can 
produce.

This option cannot be set to On when 
printing separations, only when printing 
composites.

The On setting does not work with 
PANTONE blends, or with duotones, 
tritones, or quadtones in, or with 
monochrome images specified with a 
spot color by QuarkXPress (recolor 
image option). 

See page A-11 for more information.

Option and settings:
(Default setting is underlined)

Description:
Requirements, constraints, 

and information:
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CMYK Simulation

You can use the Fiery X2 to proof offset press jobs or to simulate the output of other 
print devices. The CMYK Simulation option lets you specify the offset press standard 
or other color gamut you want to simulate. You can also specify a CMYK Simulation 
Method (Quick or Full) to use for the job (see page A-8).

The Fiery X2 provides CMYK Simulation targets for the major international press 
standards. You can also create custom simulations using the Fiery Print Calibrator (see 
Chapter 9, “Advanced Fiery Print Calibrator Topics”). 

SWOP-Coated—Uses the United States press standard.

DIC—Uses the Japanese press standard.

Euroscale—Uses the European press standard.

Custom-1(2, 3, 4, 5)—Uses a custom simulation goal. Before selecting one of these 
settings, make sure the corresponding simulation goal has been created with Fiery Print 
Calibrator and named exactly as it appears in the list of custom simulation settings.

None—Uses no simulation goal. Select this setting when the CMYK data for your job 
was separated for your specific printer (see below).

Match Copy—Uses no calibration and no simulation goal. Select this setting when 
printing images imported with Fiery Scan (with the Color Conversion option set to 
Match Copy), or to bypass Fiery X2 calibration and simulation and simulate the color 
of a copy produced by the copier. 

The CMYK Simulation setting you should specify depends on the press standard or 
device for which the CMYK data was separated. 

• For images that were separated for a press standard, select the corresponding press 
setting (SWOP-Coated, DIC, or Euroscale). 

• For images that were separated using a custom Fiery X2 separation, select the None 
setting. For example, select this setting when the CMYK data was separated using a 
Fiery X2 Separation Table in Photoshop or using a Fiery X2 ICC or ICM profile and 
your computer’s or your application’s Color Management System.

• To simulate the color of a copy made from the copier glass, select the Match Copy 
setting. This setting bypasses Fiery X2 calibration and simulation. 
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CMYK Simulation Method

Use the CMYK Simulation Method print option to specify the quality of simulation 
desired: Quick or Full. The Quick method corrects for only the density of colors (one-
dimensional mapping) to the press goal. The Full method corrects for both density and 
hue (four-dimensional mapping).

Depending on image size and resolution, Full simulation may take more time than 
Quick simulation.You can create up to five custom Quick simulations and five custom 
Full simulations using the Fiery Print Calibrator. For more information, see Chapter 9, 
“Advanced Fiery Print Calibrator Topics.”

Combine Separations

The Combine Separations option specifies whether to combine color separations 
created in desktop publishing applications on a single page to simulate printing on a 
press from film separations. It allows you to proof overprinting, trapping, and other 
four-color printing effects before having film separations created. It also enables you to 
combine Desktop Color Separations (DCS) format files to print them at full resolution 
instead of printing the low-resolution master file. 

Your job must have been printed as color separations or DCS format when you printed 
it from your application. If you did not print the job in this manner, the Combine 
Separations option has no effect. 

NOTE: This option is supported only for Adobe PageMaker and QuarkXPress.

Media Type

The Media Type option allows you to select the type of media for loading into the 
bypass tray.

Page Range

The operator can specify a page range override, but this range applies only to the pages 
included in the active job. For example, if a user specifies Odd for Page Range in the 
original job, even if the operator specifies a Page Range override of All, only the odd 
pages of the original document are printed (“all” the odd pages).
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Paper Source

If you choose the Auto Select setting, the copier prints from any tray containing the 
paper size needed for the job.

Pure Black Text/Graphics

The Pure Black Text/Graphics option provides a way to optimize the quality of black 
text and line art by printing one-color black at the full density of your print device. 
Setting this option to On can also minimize the amount of toner used when printing 
documents consisting of a mixture of color and black-only pages. 

The Pure Black Text/Graphics option affects only black text and line art elements 
defined in RGB as R0%, G0%, B0%, or in CMYK as C0%, M0%, Y0%, K100%. It 
does not affect colors in continuous tone images.

• On—Black text and line art are printed using black toner only at the maximum toner 
density of the print device. This setting eliminates the potential for blasting and 
misregistration of colors that exists when using a four-color black. 

• Off—Black text and line art defined as R0%, G0%, B0% are printed using all four 
colors of toner. This setting should be used when a rich black is desired. Black text 
and line art defined as C0%, M0%, Y0%, K100% are printed using black toner 
only, but may not print at the maximum toner density of the print device. 
You must also set Black Overprint to Off to disable this option.

NOTE: PostScript applications (for example, QuarkXPress) may convert elements 
defined as R0%, G0%, B0% to four-color CMYK black before sending the job to the 
Fiery X2. These elements are not affected by the Pure Black Text/Graphics option. See 
the application notes for details. Also, black text and line art defined as R0%, G0%, 
B0% in office applications (such as Microsoft Word) are converted to single-color 
black (K100%) by the Microsoft PostScript Level 2 driver for Windows NT 4.0. To 
print this single-color black at the maximum toner density of the print device, set the 
Pure Black Text/Graphics option to On.
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Rendering Style

Use this option to select a color rendering dictionary (CRD) to use for color 
conversions when you print RGB images, objects, and text. 

Photographic—Optimizes the output of photographic or bitmapped images, including 
scans and images from stock photography CDs. This setting maps out-of-gamut RGB 
colors to printable CMYK colors in a way that preserves tonal relationships (differences 
in lightness) in images rather than exact colors. Color accuracy is sacrificed slightly in 
favor of presenting color relationships in the way the human eye perceives them. This 
rendering style typically gives less saturated output when printing out-of-gamut RGB 
colors than Solid Color rendering does. 

Presentation—Optimizes the output of pure, saturated colors such as those used in 
business presentations, and treats continuous tone images (photographic images and 
scans) in the same way that Photographic rendering does. This rendering style does not 
try to match printed colors precisely to displayed colors but instead provides vibrant, 
dense colors. It is the best rendering style to use for jobs that combine presentation 
artwork and continuous tone photographs or scans. 

Solid Color—Matches RGB colors to printable CMYK equivalents wherever possible 
and maps out-of-gamut RGB colors to the closest printable colors. This rendering style 
is most useful for printing spot colors such as those found in company logos or 
corporate charts and graphics. It provides the best color accuracy for images using 
PANTONE colors. This setting is also recommended when the (Other) White Point 
option is set to anything other than Printer’s Default. This rendering style may not be 
appropriate for printing saturated RGB color blends, since artifacts such as banding 
may occur.

RGB Source

This option is used to specify a source color space for RGB data in your document. 

EFIRGB—Optimal source space for printing to the Fiery X2. This setting also provides 
consistent output across different platforms. 

sRGB (PC)—Specifies the source space of a generic Windows computer monitor.

Apple Standard—Specifies the source space of a standard Mac OS computer monitor.

Other—Allows you to specify custom RGB source settings using the (Other) Gamma, 
(Other) Phosphors, and (Other) White Point print options.



AA-11 Print Options

If you set RGB Source to Off, PostScript RGB data (such as RGB EPS images) and 
nonPostScript RGB data (such as RGB TIFF images) are converted differently by the 
Fiery X2 color management system.

• PostScript RGB data is converted using the CRD specified by the Rendering Style 
option. PostScript RGB data contains its own source color space information which 
is used as a reference point for the conversion.

• NonPostScript RGB data is converted using a general under-color-removal 
conversion method. NonPostScript RGB data does not contain source color space 
information and so cannot be converted using a CRD.

NOTE: The RGB Source setting you specify overrides any source color space profiles 
you may have specified with other color management systems. For example, if you 
specified a ColorSync System Profile on your Mac OS computer (see Getting Started), 
the RGB Source setting overrides it. In cases where you don’t want this setting to 
override another specified source color space, choose the Off setting.

Scale

The operator can specify a scaling override, but the override is applied to the scaling 
value already set in the active job. For example, if a user sends a job with a scaling value 
of 50% and the operator specifies a Scale override of 200%, the job is printed at 100% 
of the original document size, that is, 50% of 200%.

Sorter Mode

Off—Disables the sorter.

Collate—Copies of a complete job are collated and output into the top tray.

Sort—Copies of a complete job are sorted and output into one of 20 bins, arranged in 
page order.

Spot Color Matching

The Spot Color Matching option provides automatic matching of PANTONE library 
colors with their best CMYK equivalents. 

• On—The Fiery X2 uses its built-in lookup table to generate the closest CMYK 
matches of PANTONE colors your print device can produce.

• Off—The Fiery X2 uses the CMYK equivalents defined by your application to print 
PANTONE colors.
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For jobs that contain PANTONE library colors, set Spot Color Matching to On unless 
you are printing press simulations. When printing press simulations, set Spot Color 
Matching to Off and choose the appropriate CMYK Simulation setting.

The Spot Color Matching option can be used only when printing composites, not 
when printing separations. 

The PANTONE Coated Color Reference Book (described in Getting Started) prints 
differently depending on the Spot Color Matching setting. 

• On—When you print the PANTONE Coated Color Reference Book, the Fiery X2 
uses its built-in lookup table to generate the best matches of the PANTONE colors 
that your print device can produce. The PANTONE number is printed below each 
swatch. 

• Off—When you print the PANTONE Coated Color Reference Book, the Fiery X2 
prints swatches using the CMYK values recommended by Pantone (and used by 
applications that provide PANTONE color libraries). The CMYK values used to 
generate the color, as well as the PANTONE number of the color, are printed below 
each swatch. 
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This appendix lists the built-in printer fonts included with your Fiery X2.

PostScript printer fonts
Listed below are the 136 built-in PostScript printer fonts on the Fiery X2.

In addition to the fonts listed below, two Adobe Multiple Master fonts are included 
and are used for font substitution in PDF files.

NOTE: For Mac OS computers, install the corresponding screen fonts from the User 
Software CD. For instructions, see Getting Started.

Adobe Type 1 fonts
The Fiery X2 includes 117 Adobe Type 1 fonts:

• The Mac OS column lists the name as it appears on the Font menu on a Mac OS 
computer. For example, in most applications, to use “Bodoni-Bold,” choose Bodoni 
Bold from the Font menu.

• The Windows menu name is the name as it appears on the Font menu on a 
Windows computer. The style refers to the style that must be selected in the 
application to access the particular PostScript font. For example, to use “Bodoni-
Bold,” choose Bodoni from the Font menu and Bold from the Style menu.

PostScript name: Mac OS menu name: Windows menu name, style: 

AlbertusMT-Light Albertus MT Lt Albertus MT Lt 

AlbertusMT Albertus MT Albertus MT 

AlbertusMT-Italic Albertus MT It Albertus MT, Italic 

AntiqueOlive-Roman Antique Olive Roman Antique Olive Roman

AntiqueOlive-Bold Antique Olive Bold Antique Olive Roman, Bold

AntiqueOlive-Italic Antique Olive Italic Antique Olive Roman, Italic

AntiqueOlive-Compact Antique Olive Compact Antique Olive Compact

AvantGarde-Book Avant Garde AvantGarde

AvantGarde-Demi Avant Garde Demi AvantGarde, Bold

AvantGarde-BookOblique Avant Garde BookOblique AvantGarde, Italic

Appendix B: 
Font List
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AvantGarde-DemiOblique Avant Garde DemiOblique AvantGarde, Bold Italic

Bodoni Bodoni Bodoni

Bodoni-Bold Bodoni Bold Bodoni, Bold

Bodoni-Italic Bodoni Italic Bodoni, Italic

Bodoni-BoldItalic Bodoni BoldItalic Bodoni, Bold Italic

Bodoni-Poster Bodoni Poster Bodoni Poster

Bodoni-PosterCompressed Bodoni PosterCompressed Bodoni PosterCompressed 

Bookman-Light Bookman Bookman 

Bookman-Demi Bookman Demi Bookman, Bold 

Bookman-LightItalic Bookman LightItalic Bookman, Italic 

Bookman-DemiItalic Bookman DemiItalic Bookman, Bold Italic

Carta Carta Carta

Clarendon-Light Clarendon Light Clarendon Light 

Clarendon Clarendon Clarendon 

Clarendon-Bold Clarendon Bold Clarendon, Bold

CooperBlack Cooper Black Cooper Black 

CooperBlack-Italic Cooper Black Italic Cooper Black, Italic

Copperplate-ThirtyThreeBC Copperplate33bc Copperplate33bc

Copperplate-ThirtyTwoBC Copperplate32bc Copperplate32bc

Coronet Coronet Coronet

Courier Courier Courier 

Courier-Bold Courier Bold Courier, Bold 

Courier-Oblique Courier Oblique Courier, Italic 

Courier-BoldOblique Courier BoldOblique Courier, Bold Italic

Eurostile Eurostile Eurostile

Eurostile-Bold Eurostile Bold Eurostile Bold

Eurostile-ExtendedTwo Eurostile ExtendedTwo Eurostile ExtendedTwo

Eurostile-BoldExtendedTwo Eurostile BoldExtendedTwo Eurostile ExtendedTwo, Bold

GillSans GillSans GillSans 

GillSans-Bold GillSans Bold GillSans, Bold 

GillSans-Italic GillSans Italic GillSans, Italic 

GillSans-BoldItalic GillSans BoldItalic GillSans, Bold Italic 

GillSans-Light GillSans Light GillSans Light 

GillSans-LightItalic GillSans LightItalic GillSans Light, Italic

PostScript name: Mac OS menu name: Windows menu name, style: 
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GillSans-Condensed GillSans Condensed GillSans Condensed 

GillSans-BoldCondensed GillSans BoldCondensed GillSans Condensed, Bold 

GillSans-ExtraBold GillSans ExtraBold GillSans ExtraBold 

Goudy Goudy Goudy 

Goudy-Bold Goudy Bold Goudy, Bold 

Goudy-Italic Goudy Italic Goudy, Italic 

Goudy-BoldItalic Goudy BoldItalic Goudy, Bold Italic

Goudy-ExtraBold Goudy ExtraBold Goudy ExtraBold

Helvetica Helvetica Helvetica 

Helvetica-Bold Helvetica Bold Helvetica, Bold 

Helvetica-Oblique Helvetica Oblique Helvetica, Italic 

Helvetica-BoldOblique Helvetica BoldOblique Helvetica, Bold Italic

Helvetica-Narrow Helvetica Narrow Helvetica-Narrow 

Helvetica-Narrow-Bold Helvetica Narrow Bold Helvetica-Narrow, Bold 

Helvetica-Narrow-Oblique Helvetica Narrow Oblique Helvetica-Narrow, Italic 

Helvetica-Narrow-BoldOblique Helvetica Narrow BoldObl Helvetica-Narrow, Bold Italic

Helvetica-Condensed Helvetica Condensed Helvetica Condensed 

Helvetica-Condensed-Bold Helvetica CondensedBold Helvetica Condensed, Bold 

Helvetica-Condensed-Oblique Helvetica CondensedOblique Helvetica Condensed, Italic 

Helvetica-Condensed-BoldObl Helvetica CondensedBoldObl Helvetica Condensed, Bold Italic

JoannaMT Joanna MT Joanna MT 

JoannaMT-Bold Joanna MT Bd Joanna MT, Bold 

JoannaMT-Italic Joanna MT It Joanna MT, Italic

JoannaMT-BoldItalic Joanna MT Bd It Joanna MT, Bold Italic

LetterGothic Letter Gothic Letter Gothic 

LetterGothic-Bold Letter Gothic Bold Letter Gothic, Bold 

LetterGothic-Slanted Letter Gothic Slanted Letter Gothic, Italic 

LetterGothic-BoldSlanted Letter Gothic BoldSlanted Letter Gothic, Bold Italic

LubalinGraph-Book Lubalin Graph LubalinGraph 

LubalinGraph-Demi Lubalin Graph Demi LubalinGraph, Bold 

LubalinGraph-BookOblique Lubalin Graph BookOblique LubalinGraph, Italic 

LubalinGraph-DemiOblique Lubalin Graph DemiOblique LubalinGraph, Bold Italic 

Marigold Marigold Marigold

MonaLisa-Recut Mona Lisa Recut Mona Lisa Recut

PostScript name: Mac OS menu name: Windows menu name, style: 
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NewCenturySchlbk-Roman New Century Schlbk NewCenturySchlbk 

NewCenturySchlbk-Bold New Century Schlbk Bold NewCenturySchlbk, Bold 

NewCenturySchlbk-Italic New Century Schlbk Italic NewCenturySchlbk, Italic 

NewCenturySchlbk-BoldItalic New Century Schlbk BoldIt NewCenturySchlbk, Bold Italic

Optima Optima Optima 

Optima-Bold Optima Bold Optima, Bold 

Optima-Italic Optima Italic Optima, Italic 

Optima-BoldItalic Optima BoldItalic Optima, Bold Italic

Oxford Oxford Oxford

Palatino-Roman Palatino Palatino 

Palatino-Bold Palatino Bold Palatino, Bold 

Palatino-Italic Palatino Italic Palatino, Italic 

Palatino-BoldItalic Palatino BoldItalic Palatino, Bold Italic

StempelGaramond-Roman StempelGaramond Roman StempelGaramond Roman 

StempelGaramond-Bold StempelGaramond Bold StempelGaramond Roman, Bold 

StempelGaramond-Italic StempelGaramond Italic StempelGaramond Roman, Italic 

StempelGaramond-BoldItalic StempelGaramond BoldItalic StempelGaramond Roman, Bold 
Italic

Symbol Symbol Symbol

Tekton Tekton Tekton

Times-Roman Times Times

Times-Bold Times Bold Times, Bold

Times-Italic Times Italic Times, Italic

Times-BoldItalic Times BoldItalic Times, Bold Italic

Univers-Extended Univers Extended Univers Extended 

Univers-BoldExt Univers BoldExt Univers Extended, Bold 

Univers-ExtendedObl Univers ExtendedObl Univers Extended, Italic 

Univers-BoldExtObl Univers BoldExtObl Univers Extended, Bold Italic 

Univers-Light Univers 45 Light Univers 45 Light 

Univers-Bold Univers 65 Bold Univers 45 Light, Bold 

Univers-LightOblique Univers 45 LightOblique Univers 45 Light, Italic 

Univers-BoldOblique Univers 65 BoldOblique Univers 45 Light, Bold Italic 

Univers Univers 55 Univers 55 

Univers-Oblique Univers 55 Oblique Univers 55, Italic 

PostScript name: Mac OS menu name: Windows menu name, style: 
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TrueType fonts
The Fiery X2 includes 19 TrueType fonts:

Univers-CondensedBold Univers 67 CondensedBold Univers 47 CondensedLight, 
Bold 

Univers-CondensedBoldOblique Univers 67 CondensedBoldObl Univers 47 CondensedLight, 
Bold Italic 

Univers-Condensed Univers 57 Condensed Univers 57 Condensed 

Univers-CondensedOblique Univers 57 CondensedOblique Univers 57 Condensed, Italic

ZapfChancery-MediumItalic Zapf Chancery ZapfChancery

ZapfDingbats Zapf Dingbats ZapfDingbats

PostScript name: Mac OS menu name: Windows menu name, style:

Apple-Chancery Apple Chancery Apple Chancery

Arial-BoldItalicMT Arial Bold Italic Arial, Bold Italic

Arial-BoldMT Arial Bold Arial, Bold

Arial-ItalicMT Arial Italic Arial, Italic

ArialMT Arial Arial

Chicago Chicago Chicago

Geneva Geneva Geneva

HoeflerText-Black Hoefler Text Black Hoefler Text Black

HoeflerText-BlackItalic Hoefler Text Black Hoefler Text Black, Italic

HoeflerText-Italic Hoefler Text Hoefler Text, Italic

HoeflerText-Ornaments Hoefler Text Ornaments Hoefler Text Ornaments

HoeflerText-Regular Hoefler Text Hoefler Text

Monaco Monaco Monaco

New York New York New York

TimesNewRomanPS-BoldMT Times New Roman Bold Times New Roman, Bold

TimesNewRomanPS-
BoldItalicMT

Times New Roman Bold Italic Times New Roman, Bold Italic

TimesNewRomanPS-ItalicMT Times New Roman Italic Times New Roman, Italic

TimesNewRomanPSMT Times New Roman Times New Roman

Wingdings-Regular Wingdings Wingdings

PostScript name: Mac OS menu name: Windows menu name, style: 
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This appendix provides a list of error messages that may appear on the Fiery X2 
Control Panel, as well as troubleshooting tips.

Error messages
Error messages can result from problems with the print job, the Fiery X2, or the copier. 
Some of the most common error conditions are listed here.

When an error interferes with printing, you will see a message on the Fiery X2 Control 
Panel. Following are the messages (listed in alphabetical order), with the appropriate 
corrective action for each one. You can cancel the pending print job while you attend 
to the error condition. A few normal status messages are included in this list in case 
they cause concern. 

Fiery X2 message: Corrective action/additional information:

Accessory disabled The print job calls for a copier accessory (such as a sorter), which is 
either disabled or not available.

Busy (Copier) The Fiery X2 has received a print job, but the copier is busy 
copying or performing a non-printing related task. The job will 
print when the copier finishes that task.

Check power and cable There is a problem with the copier power or cable connection. 
First check to make sure that the copier is turned on. There may 
also be a problem with the cable connection between the Fiery X2 
and the copier. Make sure that the cable has not come loose. The 
Fiery X2 will resume printing when the cable is securely connected 
to both the Fiery X2 and the copier.

Copier needs attn There is an unidentified problem with the copier. See the copier 
user interface for additional messages. The copier will resume 
printing when the problem is corrected.

Copier offline Someone has selected Suspend Printing from the Functions menu 
on the Fiery X2 Control Panel. The Fiery X2 will resume printing 
when you select Resume Printing at the Control Panel.

Copier running The copier is scanning or making a copy. 

Appendix C: 
Troubleshooting



CC-2 Troubleshooting

Disk full The Fiery X2 hard disk is almost full. In this state, a new job can 
print only when the oldest printed job is deleted. This is not an 
efficient way to print, and may lead to delays and printing errors. 
You should delete any unneeded held or printed jobs, and also 
delete unneeded fonts using Fiery Downloader. As a last resort, you 
can use the Clear Server command.

Door open One of the copier doors is open. The Fiery X2 will resume printing 
when the door is closed.

Fuser web empty The copier’s fuser web is empty, and needs replenishing. Contact 
your authorized service technician.

Ld ___ in bypass The copier’s bypass tray is not loaded with the paper size or type 
specified. The Fiery X2 will resume printing when the bypass tray 
is loaded with the required paper.

Ld ___ in tray 1 The copier’s Tray 1 is not loaded with the paper size or type 
specified. The Fiery X2 will resume printing when Tray 1 is loaded 
with the required paper.

Ld ___ in tray 2 The copier’s Tray 2 is not loaded with the paper size or type 
specified. The Fiery X2 will resume printing when Tray 2 is loaded 
with the required paper.

Ld ___ in tray 3 The copier’s Tray 3 is not loaded with the paper size or type 
specified. The Fiery X2 will resume printing when Tray 3 is loaded 
with the required paper.

Ld ___ in tray 4
(5750 only)

The copier’s Tray 4 is not loaded with the paper size or type 
specified. The Fiery X2 will resume printing when Tray 4 is loaded 
with the required paper.

Ld ___ paper The copier is not loaded with the paper size specified in the 
application. The Fiery X2 will resume printing when the copier is 
loaded with the required paper. This message will also appear if you 
are printing transparency interleave and do not have the correct 
paper size loaded.

Ld ___ trans bypass The copier’s bypass tray is not loaded with the transparency size 
specified. The Fiery X2 will resume printing when the bypass tray 
is loaded with the required transparency.

Fiery X2 message: Corrective action/additional information:
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No toner The toner for one of the C, M, Y, or K colors has run out. Refer to 
the copier display to determine which toner color is empty. If more 
than one toner needs to be added, press and hold the Stop icon on 
the copier for additional information. The Fiery X2 will resume 
printing when you have replaced the necessary toner container.

Paper jam There is a paper jam in the copier. Open the copier doors and 
check the locations indicated on the copier display. The Fiery X2 
will resume printing when you have cleared the paper jam and 
closed the copier doors.

Press “Clear All” Press the Copier Clear All button on the copier.

Remove copies from 
sorter

The maximum page capacity for one of the sorter bins has been 
exceeded. The Fiery X2 will resume printing when the sorter is 
cleared.

Replace waste bottle The copier’s waste toner container is full of used toner. Replace the 
container with a new one according to the instructions in your 
copier manual. The Fiery X2 will resume printing when you have 
replaced the waste toner container.

Reset copier & server The Fiery X2 and the copier must be power cycled. First turn off 
the copier and the Fiery X2; then turn on the copier. When the 
copier is ready, turn on the Fiery X2.

Sorter limit exceeded The sorter output bin is full. The Fiery X2 will resume printing 
when the sorter output bin is cleared.

Sorter problem There is an unknown problem with the sorter unit on the copier. 
See the copier user interface for more information.

Unknown error An error occurred with the copier. See the copier user interface for 
more information.

Warming Up The copier is powering up. It will be ready for printing in a few 
minutes.

Fiery X2 message: Corrective action/additional information:
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Maintaining optimal system performance
The Fiery X2 does not require maintenance. Beyond the routine requirements of 
servicing and maintaining the copier and replenishing consumables there are a few 
things you can do to improve the overall performance of your system:

• Reduce unnecessary two-way communication.

If users notice that the server is frequently too busy to receive jobs, it may be because 
several users are running utilities that are updated often. Large numbers of remote 
users running the Fiery Downloader or the Fiery WebTools may have a significant 
effect on Fiery X2 performance.

• Schedule the printing workload by checking job ticket information before printing. 
Print jobs with the same output and paper specifications together to minimize paper 
changes. Also, print routine jobs while you prepare to print jobs with special 
instructions or special media.

• Avoid printing with the server “Disk full” warning. 

If you see this warning, delete jobs that have been held for a long time and are not 
likely to be needed. Avoid this condition by deleting old jobs on a regular basis. The 
date associated with a job is the original date it was sent.

Even when the disk is full, 128KB of disk space is reserved for printing a tabloid size 
job, but printing proceeds only when the oldest printed job is deleted from the 
Printed queue (Print area).
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Troubleshooting
In case of problems, and before you call for service, check the guidelines in this section. 
If you are unable to resolve the problem, make a note of the error condition and 
contact your authorized service/support center.

This section provides some troubleshooting guidelines should a problem arise. If you 
are unable to resolve a problem after referring to this section, contact your site 
administrator. 

General printing problems

If this happens: Try this:

You cannot select or view one 
of the queues.

• Have your system administrator enable the queue in Setup on the Fiery X2 Control 
Panel.

Printing ties up your 
computer for too long.

• Print to a queue instead of to the Direct connection.

When you print to a queue, the job is stored on the Fiery X2 until it can be processed 
and printed; when you print to the Direct connection, the job cannot be sent to the 
Fiery X2 until the previous job is finished processing, so you must wait longer to use 
your computer.

Special paper or transparency 
options are dimmed.

• Select a Paper Source that supports the media type you are using.

Message requests a paper size 
that you don’t have.

• Cancel the job and do one of the following:

If you are printing a PostScript file, ask the administrator to set the Convert Paper Sizes 
setting in PS Setup to convert the job to a paper size you do have. You can do this to 
convert between US and metric paper sizes.

If you are printing a file from an application, change the page size in the Page Setup 
dialog box.

You cannot print with 
QuarkXPress 3.32 using the 
AdobePS 8.5.1 driver on a 
Mac OS computer.

• Remove the file called Balloon Help from your QuarkXPress application folder and 
relaunch QuarkXPress.
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Fiery X2 doesn’t respond to a 
Print command.

• Has someone disconnected the copier by selecting Suspend Printing from the Functions 
menu?

If someone has selected Suspend Printing on the Fiery X2 Control Panel to interrupt 
printing (to make a color copy, for example), your print job will not resume until 
someone selects Resume Printing from the Functions menu on the Control Panel.

• Did you select the Fiery X2 as the current printer?

Before printing, you must select the Fiery X2 as the current printer from your Mac OS, 
Windows, or UNIX workstation.

• Make sure that the copier is switched on.

Someone may have turned the copier off, or the Automatic Power-Off or Power Saver 
mode function may have engaged. Even with the copier off, the Fiery X2 appears in the 
Chooser as long as the Fiery X2 itself is turned on. 

• If you are printing over an IPX (Novell) network, verify through the PCONSOLE utility 
that the job was sent to the Novell queue and that the queue is being used by the 
Fiery X2.

• Make sure that the job does not contain a PostScript error.

Use Fiery WebSpooler (or Fiery Spooler) to check the job’s status. A job containing a 
PostScript error appears in red in the Fiery WebSpooler display.

Jobs sent to the parallel port 
do not print.

• Review the procedures provided in Getting Started on how to prepare the Fiery X2 and 
your Windows 95 computer for parallel port printing.

Also see your Windows 95 documentation.

• Ask the administrator to increase the parallel “Port Timeout in Seconds” on the Fiery X2 
Control Panel.

• Ask the administrator to change the Ignore EOF Character setting on the Fiery X2 
Control Panel.

If you will be printing ASCII format PostScript only, set Ignore EOF Character to No; if 
you will be printing Binary format PostScript, set it to Yes.

• If you print using the DOS copy command, make sure to use the /b option when 
printing binary files.

• If the PostScript printer driver that you are using lets you select bidirectional 
communication, make sure that it is disabled. 

This is generally set from the Properties dialog box for the printer. 

If this happens: Try this:
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Problems with print quality 

If this happens: Try this:

Print settings for your job 
output do not match the 
settings you gave.

• Make sure that you did not override the setting for the job in another place.

For information about options and overrides, see Appendix A, “Print Options.”

You get poor printing results. • Does your application require one of Fiery X2 printer description files?

If you’re printing from an application such as Adobe Separator or PageMaker, 
MacroMedia FreeHand, or QuarkXPress, make sure that the Fiery X2 printer 
description file is installed correctly. For information about installing these files, see 
Getting Started.

• Use a different Copier Mode option.

For Fiery X2 systems, the default Copier Mode setting is Text Enhancement. Try 
changing the setting to Photo and see if the results improve.

• Make sure the system has been calibrated.

• Try printing with Compression set to Off.

In general, Compression increases processing speed without affecting print quality, so 
you should leave it on unless it affects the print quality of specific files.

Separations do not combine 
properly.

• Make sure that the file was initially created as separations.

• If you are printing separations or a DCS format file, set the Combine Separations print 
option to On. 

With Combine Separations On, all four colors will be printed on a single page; with 
Combine Separations Off, four grayscale pages will print to simulate four single-color 
plates.

The registration or colors of 
an image are not what you 
expected.

• Print a test page or make a test copy with the copier.

The problem may be with the copier. If your test page or copy show that the copier is 
working properly, correct the problem within your application software. If the test page 
or copy are wrong, your copier may need to be calibrated or adjusted in some other 
way. 

Your printed file appears too 
dark.

• Adjust the Brightness option.

You can use the Brightness option when printing from an application or from Fiery 
Downloader to lighten your image whenever you print a PostScript or Encapsulated 
PostScript (EPS) file. 
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Problems with Fiery Downloader

Color output is incorrect. • Check with the administrator about the current calibration information. 

The copier may need to be recalibrated because it has been too long since it was 
calibrated or because it is using a different target.

Color file prints in black and 
white.

• In the Print Options dialog box, make sure that Color/Grayscale or ColorSync Color 
Matching or PostScript Color Matching is selected (not Black and White).

• Make sure that the Color Mode selected for the job is CMYK and not Grayscale.

Desktop Color Separations 
(DCS) format images print 
incorrectly.

• Make sure that you selected the correct options to send separations in the application’s 
Print dialog box.

• Make sure that you have the file for every layer of separation that you are printing.

• Set the Combine Separations option to On.

This combines the high-resolution files for an image and prints them. With Combine 
Separations Off, the low-resolution master file will print.

QuickDraw fill patterns print 
as solids.

• Use the Adobe PostScript Printer driver (or the Apple LaserWriter 8.3 or later printer 
driver).

If this happens: Try this:

General problems • Make sure that you are using the latest version.

If you are updating your Fiery X2 to new system software, delete the previous versions 
of Fiery Downloader from your Mac OS or Windows computer and install the latest 
versions to insure full compatibility.

You cannot connect to the 
Fiery X2 from Fiery 
Downloader.

• Make sure that the Fiery X2 is not being calibrated.

If the Fiery X2 is being calibrated, you cannot connect to it. This insures that only one 
person is calibrating the server at any time and that print jobs do not use unexpected 
calibration.

If this happens: Try this:
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Problems with Fiery WebTools

Setup error messages
For information on Setup error messages, see the Administrator Guide.

You can’t print an EPS file 
using Fiery Downloader.

• Try printing using the “Showpage” option in the Download PostScript File dialog box.

The Showpage (after EPS files) option adds a showpage PostScript language command 
at the end of the print job. Certain applications omit this necessary PostScript language 
command when they generate EPS files. You’ll need to select the Append Showpage 
option when printing EPS files generated by these applications.

If you continue having difficulties printing an EPS file with Fiery Downloader, try 
printing the file from the application in which it was created.

• Make sure that the job does not contain a PostScript error.

Use Fiery WebSpooler to check the job’s status. A job containing a PostScript error 
appears in red in the Fiery WebSpooler display.

You have problems 
downloading a font with 
Fiery Downloader.

• Check with the administrator to make sure that the Direct connection is enabled.

The Direct connection must be used to download fonts. (Files can be downloaded via 
the Print or Hold queue.)

Extra blank page prints after a 
Fiery Downloader job.

• Turn off the “Showpage (after EPS file)” option.

This option adds a special PostScript command that will cause an extra blank page to 
print if it is not needed.

Fiery Scan main window does 
not appear after launching.

• Check to see if the TWAIN module(s) installed by Adobe Photoshop are located in the 
correct Plugins subfolder. If not, reinstall Adobe Photoshop software.

If this happens: Try this:

General problems • Clear the cache (Netscape Communicator) or history (Microsoft Internet Explorer).

If this happens: Try this:
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AutoCal error messages
Error messages can result from problems during calibration using AutoCal.

Fiery X2 message: Additional information:

Error 5 The calibration file cannot be opened.

Error 6 The calibration file was not read correctly.

Error 8 The measurement page did not scan properly, either because it is 
crooked or the data is corrupted.

Error 11 The color strips on the measurement page are inconsistent.

Error 12 The copier model being used is not supported.

Error 20 The measurement page cannot be scanned because the dots per 
inch (dpi) are incorrect.

Error 102 The grayscale strip is crooked or is positioned incorrectly.

Error 103 The grayscale strip is positioned too far to the left or to the right of 
the measurement page.

Error 104 The grayscale strip is positioned too far above the measurement 
page.

Error 111 The grayscale strip could not be found; either reposition the strip 
correctly or position it vertically.



Numerics
4-pin DIN 8-10
8-pin DIN plug 8-9
9-pin connector 8-9

A
access

levels xvii, 7-2
restricting xvii, 7-4

active jobs 7-14
Administrator password xvii, 1-6, 7-3, 7-4
Adobe Font Downloader, see Font 

Downloader
Adobe Photoshop

Fiery Scan plug-in for 5-1
troubleshooting C-9

AGA (Automatic Gradation Adjustment), see 
calibration, AGA

Alert Status screen 1-3
Apple Standard setting, RGB Source 

option A-10
AppleTalk 3-2
Apply Calibration option 8-12, 8-19
AutoCal calibration 8-6, 8-7, 8-8

B
Backup Simulations option 9-17
Back Up Targets option 9-9
banding A-10
black

four-color and one-color A-9
overprinting A-6

Black Overprint option A-2, A-6
black text A-6
black text and line art A-9
blasting A-9
blends, printing A-10

brightness, adjusting in custom curves 9-7, 
9-8

Brightness
menu 9-16
option A-1, A-2

broken LCD 1-8
buttons, Control Panel 1-2

C
CALIB.EPS file 8-19, 9-18
Calibrated RGB

file 5-1
option 5-5

calibration
adjusting brightness 9-7, 9-8
AGA (copier’s self-calibration) 8-5
applying 8-19
bypassing 9-11, A-7
checking status 8-6
checklist 8-20
COM1 and COM2 port 8-9
Comparison page 8-18, 9-18
current 8-2
custom curves 9-6
editing 9-2 to 9-9, 9-14
expert features 9-1 to 9-19
from the Control Panel 8-2, 8-6, 8-7, 

8-8
from the Fiery Print Calibrator 8-2
measurements 8-1, 8-2, 8-3
measurement values 8-14 to 8-18
measuring patches 8-15
overview 8-1, 8-2, 8-3
port 8-15
removing 9-10
resident 8-2, 9-3
scheduling 8-4
self-calibration 8-5

Index
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standard procedure 8-8 to 8-20
targets 8-1, 8-2, 8-3, 8-11
testing 8-18, 8-20, 9-9, 9-18
viewing status 8-13
See also densitometer, Fiery Print 

Calibrator
calibration, bypassing A-7
Calibration Mode window 8-12
Calibration option 1-7
calibration patch page 8-3, 8-14
CALRBG.AMS file 5-1
cancel command (UNIX) 4-3
canceling scanning 5-5
Cancel Job

from the Control Panel during 
printing 1-3

from the Control Panel during 
RIPping 1-3

Change (Administrator) Password 
option 1-7

Clear Server command 1-7
color server

cleaning 1-8
documentation xiii
display window 1-8
restarting 1-7
shutting down 1-8

CMYK Simulation Method option A-3, A-8
CMYK Simulation option 9-12, A-2, A-7
color, troubleshooting output C-8
Color Charts 1-5, 8-5
Color Conversion option in Fiery Scan 5-5
Color Mode option A-3
Color Reference pages 8-5
color rendering dictionaries, see CRDs
Color Setup option 1-7
Combine Separations option A-3, A-8
Comparison Page 8-18, 9-17, 9-18

calibration 8-3
custom 8-19, 9-18

compression C-7

Compression option A-3
Configuration page 8-6

printing from the Control Panel 1-5
Configure button

Fiery WebTools 7-4
Confirm file deletion option 7-40
Connection Type option 6-5
Control Panel 1-1 to 1-8

activity light 1-2, 1-4
buttons 1-2
calibration from 8-2
down button 1-2
Functions menu 1-5
line selection buttons 1-2
Menu button 1-2
printer settings overridden 2-11
removing calibration 8-8
status screens 1-3
up button 1-2

Control Panel map
printing from the Control Panel 1-5

copier, adjusting printed color from 8-5
Copier Mode option A-3

Text Enhancement setting C-7
Copies option A-3
CRDs (color rendering dictionaries) A-5
curves

Brightness 9-8
input/output 9-7
target 9-7, 9-8

custom Comparison page 8-19, 9-18
custom simulations 9-11, A-7, A-8
Cyan-Magenta-Yellow-Black (color model), 

see CMYK

D
DCS (Desktop Color Separations) files A-3, 

A-8
default settings, see printer default settings
Delete command 7-12, 7-19, 7-27
Delete Job Log command 7-12
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Delete Simulation option 9-17
DEMO.MEA file 8-13
densitometer

calibrating 8-21
DTP32 8-1, 8-8 to 8-10, 8-14, 8-21
for calibration 8-6
selecting port 8-15
Status T densitometer 8-4

Densitometer window 8-17
density patches 8-5
Desktop Color Separations, see DCS
DIC

press standard A-7
simulation 9-11
simulation goal A-7

Direct connection xviii, 7-16
not in Mac OS Chooser 3-1
required to download fonts 6-7, C-9

disk space used 7-9
display window 1-3
Dmax, see maximum density
DocBuilder 7-26 to 7-31

Delete command 7-27
Duplicate command 7-27
editing options 7-27
merging two files 7-29
Open Preview command 7-27
Undo command 7-27

Dot Gain
adjusting 9-16
simulating 9-7, 9-8

down button 1-2
Downloader, see Fiery Downloader
downloaders, LaserWriter 6-1
Duplex option A-5
Duplicate (page) command 7-27
Duplicate command 7-12

E
Edit Calibration

options 8-12
window 9-5

Edit Simulation
button 9-15
options 9-13

EFIRGB setting, RGB Source option A-10
EPS (Encapsulated PostScript)

color conversion of RGB EPS 
images A-11

EPS (Encapsulated PostScript) files C-9
downloading 2-1, 6-1
downloading from Mac OS 3-4
downloading from Windows 2-12

error messages C-1 to C-3
during AutoCal C-10
during Setup C-9

Euroscale
press standard A-7
simulation 9-11
simulation goal A-7

Exit command 7-12
Exit Setup option 1-7
Export command 8-17

F
Fiery Downloader

Brightness option 6-6
choosing a printer 6-3
downloading file or font 6-3 to 6-7
Download Progress bar 6-2
Hard Disk area 6-2
installing printer fonts 6-8
Mac OS 3-4
printing from 6-3
Print Status area 6-2
restriction with parallel port 2-11
RIP Status area 6-2
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Toolbar 6-2
troubleshooting C-8 to C-9
using 6-1
Windows 2-12

Fiery Print Calibrator 8-1, 8-2, A-7, A-8
advanced features 9-1 to 9-19
calibration from 8-2
Calibration Mode window 8-12
checking calibration status 8-6
displaying measurements 8-18
function buttons 8-12, 9-13
main window 8-12
overview 8-8 to 8-20
press simulations 9-13
Simulation Mode window 9-12
storing targets 8-4

Fiery Scan A-7
Fiery Spooler

changing print settings 7-43
deleting jobs 7-42
duplicating jobs 7-41
moving jobs 7-42
overriding Printer Setup 2-4, 2-8, 2-11
overriding user job settings A-1

Fiery WebSpooler 2-4, 2-8, 2-11, 7-2, A-1
accessing 7-6
Guest (view-only) privileges 7-9
Job menu 7-18
overriding user job settings A-1
Operator password 7-9
overview 7-2
status bars 7-9

Fiery WebTools 7-2 to 7-5
accessing xviii, 7-3, 7-4
Configure button 7-4
home page 7-4
Installer 7-2
passwords 7-2
problems with C-9
Status 7-2, 7-4
WebLink 7-2, 7-5
WebSetup 7-2

File menu commands 7-12
File name entry field 6-5
File port, saving files to 2-12
Files of type menu (Windows) 6-5
Font Downloader 6-1
font list

displaying 6-2, 6-9
printing 6-2, 6-9

Font List button 6-3
fonts

Adobe Type 1 6-7, 6-8, B-1
downloading and managing 6-1, 6-5, 

6-7
installing 6-8
PostScript 6-8, B-1
printer fonts 6-8
printer fonts on color server 1-5, 6-9
printing font list 1-5
screen fonts 6-8
substitution with PDF files 6-8
TrueType 6-7, B-5

Font Substitution Table 6-7
Full Simulation 9-18, A-8
Functions menu, Control Panel 1-4, 1-5

G
Gamma option A-4
gamut A-10
Guest access xvii, 7-3, 7-9

H
held jobs 7-14, 7-16
Help menu commands 7-13
Hold command 7-12, 7-19
Hold queue xviii, 7-36

I
icons

Print area 7-17
RIP area 7-16
Spool area 7-15

Info Status screen 1-4
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Installer WebTool, see Fiery WebTools
installing printer fonts 6-8

J
job

active 7-14
areas 7-10
defined xiv
deleting 7-19
deleting in Fiery Spooler 7-42
duplicating 7-41
flow diagram 7-14
held 7-14
limit 7-17, 7-18
order of display 7-14
overrides 7-21
previewing 7-27
remove raster and reRIP 7-17

job icons 7-11
Print area 7-17
RIP area 7-16
Spool area 7-15

Job Log
displaying 7-33
printing from the Control Panel 1-5
using (from Fiery Spooler) 7-44
using (from Fiery WebSpooler) 7-33
viewing printed jobs 7-11

Job Log Setup option 1-7
Job menu commands 7-12, 7-18
job overrides

Black Overprint option A-6
CMYK Simulation option A-7
Media Type option A-8
Sorter Mode option A-11

job settings, see print options
Jobs Saved in Printed Queue 7-18

L
LaserWriter printer, fonts installed on 6-8
LCD 1-1, 1-8

line selection buttons 1-2
lp command 4-2
lpq command 4-1, 4-2, 4-3
lpr command 4-1
lprm command 4-1, 4-3

M
Macintosh interface cable 8-9
Mac OS

ADB port 8-10
Paper Source menu 3-3
PostScript printer setup 3-2
printer default settings 3-3
Printer Specific Options menu 3-3
printing 3-1 to 3-4
screen fonts 6-8
tray selection 3-3

Match Copy
option 5-5
setting, CMYK Simulation option A-7
simulation 8-2, 9-11
simulation goal A-7

maximum density 9-6, 9-15
Maximum Density area 9-15
measured curve, viewing 9-6
measurements file 8-3, 8-13

creating 8-14 to 8-18
file format of 8-17
saving 8-17
view 8-12

Media Type option A-3, A-8
memory (RAM)

in use 7-9
total 7-9

Menu button 1-2
messages, see error messages
misregistration A-9

N
Network Setup option 1-7
None simulation goal A-7
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Notes fields A-4
in Job Log 7-44
Mac OS 3-3
Windows 3.1x 2-9
Windows 95 2-5

O
Off setting, RGB Source option A-11
on/off switch 1-6
Open Preview command 7-27
Operator password xvii, 7-3, 7-9
Original option in Fiery Scan 5-5
(Other) Gamma option A-4, A-10
(Other) Phosphors option A-4, A-10
Other setting, RGB Source option A-10
(Other) White Point option A-4, A-10
out-of-gamut RGB colors, printing A-10
overprinting black A-6
Override Print Settings command 7-12, 

7-20, 7-43

P
Page Order option A-4
Page Range option A-1, A-4, A-8
PANTONE 1-5
PANTONE Coated Color Reference Book

effect of Spot Color Matching 
setting A-12

paper, sizes supported xvi
Paper Size option A-4
Paper Source menu

Mac OS 3-3
Windows 3.1x 2-7
Windows 95 2-3
Windows NT 4.0 2-10

Paper Source option A-5
parallel port

printing problems C-6
printing with 2-11

passwords
Administrator 7-3
Change (Administrator) Password 

option 1-7
for calibration 8-2
Operator 7-3, 7-9

patch page 8-14, 8-15, 8-17
PDF files

downloading 6-1
font substitution 6-8

performance, optimizing C-4
permissions xvii
Phosphors option A-4
Photographic rendering style A-5, A-10
Photoshop, see Adobe Photoshop
Photoshop, transfer functions 6-6
port, densitometer 8-15
PostScript xiv, 7-11

downloading files 6-1
downloading files from Mac OS 3-4
downloading files from Windows 2-12
error 7-17
icon 7-15
printing files from UNIX 4-1
RIP xv

PostScript and nonPostScript RGB 
data A-11

PostScript printer description files, see PPDs 
PostScript printer drivers xv

Mac OS 3-1
Windows 3.1x 2-6
Windows 95 2-1

PostScript printer setup
Mac OS 3-2

PostScript RGB data and nonPostScript RGB 
data A-11

PostScript Setup option, see PS Setup option
power switch 1-6
PPDs (PostScript printer description 

files) xv, 2-1, 2-6, 3-1
defaults A-2
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prescan 5-2
presentation print jobs

rendering styles appropriate for A-10
Presentation rendering style A-5, A-10
press simulations, see simulations
press standards A-7
Preview command 7-13
previewing print jobs 7-23
Print and Hold command 7-12, 7-19
Print area 7-10

icons 7-17
Print command 7-12, 7-19

Windows 2-1
Printed queue 7-11, 7-17, 7-36
printer (job) icon 7-15
printer default settings xviii, A-1 to A-11

Mac OS 3-3
Windows 95 2-4

printer drivers, see PostScript printer drivers
printer settings, customizing 7-12
printer setup

settings 2-11
with Adobe PostScript Printer Driver for 

Windows 95 2-2 to 2-5
with Microsoft PostScript Printer Driver 

for Windows NT 4.0 2-9
Printer Setup option 1-7
Printer Specific Options menu 3-3
printing

Comparison page (calibration) 8-18
Comparison page (simulation) 9-17
Configuration page 1-5
defined xv
font list 1-5, 6-2
from Fiery Downloader 6-3
from Mac OS applications 3-1 to 3-4
information pages 1-5
list of fonts 6-9
specifying trays A-5
to local port 2-12
troubleshooting C-5 to C-9

UNIX workstations 4-1 to 4-3
Windows 3.1x 2-6
Windows 95 2-1
Windows NT 4.0 2-9
with parallel port 2-11

printing connections on the network xviii
Print Job Log command 7-12
print jobs

deleting from queue 7-12
previewing 7-23

print options A-1 to A-11
settings 2-5
specific to color server 2-4, 2-8, 2-11
Windows 3.1x 2-6 to 2-9
Windows 95 2-2 to 2-5
See also printer default settings

Print Pages command 1-5
Control Panel 1-5

Print Patch Page option 8-14, 8-15, 8-17
Print queue xviii, 7-36

not in Chooser, Mac OS 3-1
Print Status screen 1-3
Process Next command 7-12, 7-19
PS Setup option 1-7
Pure Black Text/Graphics option A-5, A-9

Q
QuarkXPress, printing problems C-5
Queue option 6-5
queues 7-10

access to xviii
Queues window

spooled jobs 7-10
Quick Simulation 9-18, A-8

R
RAM, see memory
raster

data 7-16, 7-18
icon 7-15
needed for DocBuilder 7-26
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raster files
editing 7-26
previewing 7-23
saving 7-11
saving an edited document 7-28, 7-31

rasterizing, see RIPping
Reboot Server command, from Control 

Panel 1-5
Remove Calibration option 9-10
Remove Raster command 7-12, 7-20
Rename command 7-12, 7-19
Rendering Style option A-5
resident calibration 8-2

applying 8-19
bypassing 8-2

resolutions supported xvi
restricting access to color server xvii
Resume Printing command

Control Panel 1-5
RGB images

EPS, color conversion A-11
PostScript and nonPostScript A-11

RGB Source option A-5, A-10
rich black A-9
RIP, defined xv
RIP and Hold command 7-12, 7-19
RIP area 7-10, 7-16
RIPped jobs 7-11
RIPping
RIP Status screen 1-3
Run Diagnostics command 1-5

S
safety 1-8
Save Target option 9-9
Scale option A-5, A-11
scanning

canceling 5-5
from the copier 5-1 to 5-5

Select Simulation button 9-13, 9-14
Select Target option 8-12

separations, printing A-3
Server Setup option 1-7
Server Status

option 8-6, 8-13
window 9-13

Set Default Simulation button 9-13
Sharpness option A-5
Show menu (Mac OS) 6-5
showpage after EPS files option 6-6
Simulation Mode window 9-12, 9-13
simulations A-2, A-8

applying 9-18
backing up 9-17
Comparison Page 9-17
custom 9-11, A-7, A-8
deleting 9-17
editing 9-14
Full method 9-18, A-8
overview 9-11
Quick method 9-18, A-8
removing 9-17
saving 9-16
selecting 9-14
testing 9-17, 9-18
viewing 9-14

Solaris 2 4-3
Solid Color rendering style A-5
Sorter Mode option A-11
Sorter option A-5
source file 7-26
spool, defined xiv
Spool area 7-10

job icons 7-15
spooled jobs 7-10

displayed in Fiery WebSpooler 7-11
icons 7-15

Spooler, see Fiery Spooler
Spot Color Matching option A-6, A-11
sRGB (PC) setting, RGB Source 

option A-10
starting the color server 1-6
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status bars 7-9, 7-13
Print 7-9
RIP 7-9
Spool 7-9

status screens, Control Panel 1-3
Status WebTool, see Fiery WebTools
SunOS 4 4-3
Suspend Printing command A-5

from Control Panel 1-5
SWOP-Coated simulation 9-11, A-7
SWOP press standard A-7

T
target curve, see targets
target file 7-26
targets 8-3

backing up 9-9
copier target 8-4
curves 9-4
custom 9-5 to 9-6, 9-7
Linear 8-4
measured curves 9-4
provided with the color server 8-4
removing 9-10
saving 9-9
viewing and editing 9-6
working with 9-2
See also calibration, simulations

TCP/IP printing 4-1
Test Calibration option 8-12
Test Page 8-6

printing from Control Panel 1-5
Test Simulation button 9-13, 9-18
Thumbnail A

command 7-12, 7-20
editing options 7-27
page commands 7-26
page display 7-23
window 7-26

Thumbnail B
command 7-12, 7-20
window 7-26

transfer functions 8-3
trays, printer A-5
tray selection

Mac OS 3-3
Windows 3.1x 2-7
Windows 95 2-3
Windows NT 4.0 2-10

troubleshooting C-5
color output C-8
Fiery Downloader C-8 to C-9
general printing problems C-5 to C-6
problems with print quality C-7 to C-8
See also error messages

U
undo, in editing thumbnail views 7-25, 7-30
Undo command 7-13, 7-27
UNIX

BSD (Berkeley Software Distribution) 
variant of 4-3

displaying jobs in queue with 4-2
printing from 4-1 to 4-3
removing jobs from queue with 4-3
System V 4-3

up/down button 1-2
user software xviii

V
View Channels area 9-15
View Measurement

icon 8-18
option 8-12

W
warning

display window breakage 1-8
WebLink, see Fiery WebTools
WebSetup, see Fiery WebTools
WebSpooler, see Fiery WebSpooler
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WebTools, see Fiery WebTools
White Point option A-4, A-10
Windows 3.1x

Paper Source menu 2-7
PostScript printer driver 2-6
printing with 2-6
print options 2-6 to 2-9
tray selection 2-7

Windows 95
Notes fields 2-5
Paper Source menu 2-3
PostScript printer driver 2-1
printer default settings 2-4
printing with 2-1
tray selection 2-3

Windows NT 4.0
Paper Source menu 2-10
printing with 2-9
tray selection 2-10
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